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ARDUINO PLC

1. INTRODUCTION

1.1 CONVENTIONS USED IN THIS DOCUMENT

Text Type

Description

Command, Key

Code
[Context menu]

[Context menu]

Menu>Item

Menu>Item

(See Paragraph)
(See Chapter)
Terminology

PLC IDE

Name of the command or keyboard
shortcuts key.

Source code text.
Toolbar icon and context menu voice.
Context menu voice without any icon.

For menu items hierarchy, the “>" symbol
is used. A record File>Open Project is
equivalent to “the Open Project item under
the File menu”.

Same as above including the icon shown in
the toolbar.

Link to related subject within this guide.

Important term or concept.
It refers to Arduino PLC IDE.

Arduino PLC IDE user manual

IDE
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2.1

ARDUINO PLC IDE

OVERVIEW

Arduino PLC IDE is an IEC61131-3 Integrated Development Environment supporting the
whole range of languages defined in the standard.

In order to support the user in all the activities involved in the development of an applica-
tion, PLC IDE includes:

- textual source code editors for the Instruction List (briefly, IL) and Structured Text
(briefly, ST) programming languages (see Chapter 6.);

- graphical source code editors for the Ladder Diagram (briefly, LD), Function Block Dia-
gram (briefly, FBD), and Sequential Function Chart (briefly, SFC) programming lan-
guages (see Chapter 6.);

- a compiler, which translates applications written according to the IEC standard directly
into machine code, avoiding the need for a run-time interpreter, thus making the pro-
gram execution as fast as possible (see Chapter 7);

- a communication system which allows the download of the application to the target
environment (see Chapter 8);

- a rich set of debugging tools, ranging from an easy-to-use watch window to more pow-
erful tools, which allows the sampling of fast changing data directly on the target envi-
ronment, ensuring the information is accurate and reliable (see Chapter 9).

THE WORKSPACE

The figure below shows a view of PLC IDE’s workspace, including many of its more com-
monly used components.

Arduino_1 - Arduino PLC IDE

" File Edit View Project On-line Debug Scheme Variabl Window Tools Help -8 X

*a"‘ll'l 2¢xIaLrs el mEERERTR @
Ld@¥Fs @BOF BUAEE HE 00
~$§‘§e—=¥f &

Mro as spBeedHI% @

o pr | TAE O P EEE T
Localvaiabes 3 x
= @] Arduino_1 Project Name Tipe Address Array Init value Aftribute Description Ble mER LA
:é:s L“d:e’l“'g“ 1 |mDelay TON Auto No | Value =] Locat
2 |mot cTu Auto No
% [ Local variables :
5 B Globslv 3 |mctd €™ Auto No |
0 et 4 |mTp L3 Auto No as
(W8] inpl ogicData| |
SA Tk < " >
= B Fast R BLO digitaliapu " DL digitatoutpot Library Tree 3 x
R main = Lirs 2 T
B LsdderLogic inpLogicData 38 outPulse L]
& Slow — (1 Q| — = B Project libraries ~
. )
® Background b g ||§- Operators and blocks
3 Init B Arithmetic
(PR fer e <] 3 M pisable
E— @ @ Bitshift
0002
fbDelay
inpLogicData Ut outDelayed
N a
—r :
@ s> e B« o]
4 B Terget blocks
- W Trget definitions
@ @ Torget varisbles
= gagT AICOPM
#i- gy AlDatabase
# g AlModbusRTU
% gy AlModbusTCPMaster
- ghe” [Standard
E Counters
&) Project B Res X # Edge detection .

ing 16T conpleted
g MAIN completed

Preaprocessing Standard conpleted
Freprocessiag AlDstabase coupleted
T ng & ed =
i d
EDIT MODE @ NOT CONNECTED

1. Workspace window 2. Output window 3. Source code editors 4. Watch window 5. Library tree 6. Status bar

The following paragraphs give an overview of these elements.

7. Document bar 8. Toolbars
(©.0)
PLC
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2.1.1 THE OUTPUT WINDOW

The Output window is the place where PLC IDE prints its output messages. This window
contains four tabs: Build, Find in project, Debug, and Resources.

Generatiné Dutbut file C:\Users\ﬂattiaHi\DDcuments\PrﬁDDD\Build\PrﬁDDcftéc LM
Generating output file C:Users~MattiaMiDocuments=“PrjDoc~Build~Prijloc.cod ..

Tz=ed code =ize: 34B8h 13 EBwte)
Free code space: IFCE48h { 4082 EByte)
Total code space: 400000k ( 4096 KByte)

T=zed data =pace: 1E8h 0 EBvyte)

Free data space: IFE18h ( 255 EBwte)

Total data space: 40000k ¢ 256 EBwte)

Tz=d retain data =space: Oh 0 EByte)

Free retain data space: 1000k 4 KBvte)

Total retain data space: 1000k 41 KBvte) =
0 warning=s, 0 srrors.

| W
£ 11} >

Build

The Build panel displays the output of the following activities:
- opening a project;

- compiling a project;

- downloading code to a target.

Find in project

This panel shows the result of the Find in project activity.

Debug

The Debug panel displays information about advanced debugging activities (for example,
breakpoints). Depending on the target device you are interfacing with, PLC IDE can print
on this output window every PLC run-time error (for example, division by zero), locating
the exact position where the error occurred.

Resources

The Resources panel displays messages related to the specific target device PLC IDE is
interfacing with.

2.1.2 THE STATUS BAR

The Status bar displays the state of the application at its left border, and an animated
control reporting the state of communication at its right border.

[Reacly hd )3 SOURCEOK |  CONNECTED

For further details see paragraph 8.2.1 and 8.2.2.

2.1.3 THE DOCUMENT BAR

The Document bar lists all the documents currently open for editing in PLC IDE.

3 Resources [F] Init [E] Loops ™3 PidControl ! Ladderlogic Jf PidModeSelector

0.0
PLC
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2.1.4 THE WATCH WINDOW

The Watch window is one of the many debugging tools supplied by PLC IDE. Among the
other debugging tools, it is worth mentioning the Oscilloscope, the triggers, and the live
debug mode (see Paragraph 9.2).

Watch L
[og]r EaE Y
Symbol Value Type Location
+ §§ FBPROFILEGEN - LN, @TIMED:ELEVATOR
= END_AUT... FALSE BOOL @TIMED:PIDMODESELECTOR
mm TRACESTARTACQ  FALSE BOOL glebal
+ [ TRACEP! - REAL[]
+ { FEPID - FT_PID @TIMED:PIDCONTROL
- LeF - Lo, @TIMED:PIDCONTROL
—N 0 REAL @TIMED:PIDCONTROL
—K 0.05 REAL @TIMED:PIDCONTROL
— out 0 REAL @TIMED:PIDCONTROL
- §3 FeCTD - CTD_UDINT ~ @BACKGROUND:LAD.
- CD FALSE BOOL @BACKGROUND:LAD.
=D FALSE BOOL @BACKGROUNDILAD. .
—pv 10 UDINT @BACKGROUNDILAD. .
-0 TRUE BOOL @BACKGROUND:LAD.
- 0 UDINT @BACKGROUND:LAD.
— PIDSETPOINT 0 REAL global

2.1.5 THE LIBRARY TREE

Libraries are a powerful tool for sharing objects between PLC IDE projects. You can get
detailed information about libraries in the dedicated chapter 4.8.

Inside the library tree there are a couple of elements that cannot be removed, which are
described in the following paragraphs.

2.1.5.1 OPERATORS AND STANDARD BLOCKS

This panel lists basic language elements, such as operators and functions defined by the
IEC 61131-3 standard.

HE HE
= B8 Project libraries —
5 o [
+ - Bl Arithmetic
-]~ gm| Bistable
R
S
=l gm| Bit shift
ROL
ROR
SHL
SHR
Comparison
Conversion
Logic
Selection
Standard
String
- EEF' Target
+ - Bl Target definitions
+ - Bl Target variables
+-gly;  Pid
+ gy Standard

(O 0]
PLC
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2.1.5.2 TARGET VARIABLES

This panel lists all the system variables, also called target variables, which are the inter-
face between firmware and PLC application code.

0 A
= B Project libraries
+ g!F Operators and blocks
= g Terget
+- Ml Target definitions
EER- Target variables —
- Ei@ Anzlog_Inputs
[i] sysAnaloglnputs
- Ei@ Anzlog_Outputs
[G] sysAnalogOutputs
-l E@ Digital_Inputs
sysDigitallnputs
- E@ Digital_Outputs
sysDigitalQutputs
- E@ Internal_variables
[E] sysUserDataBlock
- EB@ System_Timers
sysTirmer

+ gy Pid
+ gl Standard

2.1.5.3 TARGET DEFINITIONS

This panel lists all the system functions and function blocks available on the specific target
device.

08
= BB Project libraries
+ E!F Operators and blocks
= E!Fl Target ——
-
=l gml Structures
+[za] TypeDataTime
+- Wl Target variables [R——
+ gy Pid
+ gy Standard

2.1.6 THE WORKSPACE WINDOW

The Workspace window consists of two distinct panels, as shown in the following picture.

© .0
PLC

6 Arduino PLC IDE user manual



Project
= @ Arduino_1 Project
=l Function blocks
E Countlner
= Functions
= Global Variables
Automatic Variables
Constants
Retained variables

i

=l Programs
=P FunctionalBlockDiagram
#+-[EP Init
+-itP LadderLeogic
-I-EIP main
#- Bl Local variables
-1-EiE Global vars
|I| cnt
[[i] InpLogicData
= [ Tasks
& Fast
B main
B LadderLogic
Slow
@ FunctionalBlockDiagram
Background
Init

"B Init

=& .. &

&, Project Rescurces

ARDUINO PLC IDE

Resources o x
B Configuration
- @@ ArduincPMC
= E2 Public chjects
ES Parameters
=4 Status variables
- B& Local IO Mapping
BE Digital Inputs
B Digital Outputs
BE Analog Inputs
BE Analog Outputs
BE Programmable Digital 10
BE Termperature probes
%, R5485 SerialPort
W Ethernet
AN CAMopen CAND
- # Shared variables
& Inputs
&} Outputs
{4 Sketch

&) Project Resources

2.1.6.1 PROJECT

The Project panel contains all the elements of the project, visualized in a tree-like organi-
zation; custom folders can be added to the project tree in order to reorganize the ele-

ments accordingly to the user preferences.

Among the other elements, there’s also the task list, which represent the available tasks
and the relative assigned programs (see Paragraph 5.3).

2.1.6.2 RESOURCES

The contents of the Resources panel depends on how the target device is interfacing with
PLC IDE: it may include configuration elements, schemes, wizards, and so on.

2.1.7 THE SOURCE CODE EDITORS

The PLC IDE programming environment includes a set of editors to manage, edit, and
print source files written in any of the 5 programming languages defined by the IEC

61131-3 standard (see Chapter 6).

(O 0]
PLC
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T PidModeSelector [==]E=] LinearProfileGen [e=]=]
.~ | [oooL %
it — | |oooz (* Pre condizioni %) —
e[ ! 0003 enableOut := ensble AND nomdcs > 0.0 END nomDec > 0.0 I
) 0004 =
0005, (* Gesticne enable © fine posizicnamento *) |
0006 IF HOT cnableCut THEH £
[ 0007 postk = FALS
inpManual inpAnalogSetpoint inpAutamatic '!:‘ gggg g;é:? z gggt
7| | 'ooza actPos := targPos;
0011 actTargPos := targPos:
Manusl_sstpoint Analog_setpaint Auto_Phase_0 0012 absSpeed := 0.0:
i ; 0013 prevSpesd (= 0.0:
Autoliodenit 0013
(N] ] atfodent[P] ) 0014 actSpesd (= 0.0;
Setpoint10Posiive[N] 0015 acticc = 0.0:
| [oo1s rSpeed = 0.0:
0017 RETURN
end_Manual [] end_anaiog [] end_autoPnaseo ggig END_IF:
0020 (* Spazic da psrcorrers = relativo ssgno *)
SHT 0021 IF actTargPos >= actPos THEN
Auto_Phass_1 0022 renSpace := actTargPos - actPos;
Setpoint1 0Negative 0023 sign := 1.0;
M) 0024 ELSE
0025 renSpace (= actPos - actTargPos;
- oo2e sign := -1.0; -
P e — 8 B i 8
2 PidControl (== ]=] LadderLogic =
= foTp =
bl inpLogicData T |
I} n a
foPid E
FT_PID -
[ S | v 5w
[t set pant ar
+{noise lim|=
~|offset overflow. outPidOverflow |
~{manusL_in
| manual fbDelay
st inpLogicData ok
(000 ot_bend I n a
[ S——
W
[0 ————— T T
~imit L
= limit_H

The definition of both global and local variables is

editors

Local variables

Name Type Address Aray Init value
1 |fbDelay TOMN Auto Nao
2 |fbClu CTU_UDINT  Auto No
3 |fbCid CTD_UDINT  Auto No
4 |bTp TP Auto Nao
5 |ettp UDINT Auto No

2.1.8 THE TOOLBARS

Mtribute Description

supported by specific spreadsheet-like

0

PLC IDE allows the user to hide or show specific toolbars to fully customize the workspace.
Each operation in the environment, to realize a program (for example add a variable), can
be performed through the menus; the toolbars contain icons which work as shortcut for
the menus commands (see paragraph 3.2).

0.0
PLC
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3. USING THE ENVIRONMENT

This chapter shows you how to deal with the many UI elements PLC IDE is composed of,
in order to let you set up the IDE in the way which best suits to your specific development
process.

3.1 LAYOUT CUSTOMIZATION

The layout of PLC IDE’s workspace can be freely customized in order to suit your needs.

PLC IDE takes care to save the layout configuration on application exit, in order to persist
your preferences between different working sessions.

3.2 TOOLBARS
3.2.1 SHOWING/HIDING TOOLBARS

In details, in order to show (or hide) a toolbar, open the View>Toolbars menu and select
the desired toolbar (for example, the FBD bar).

The toolbar is then shown (hidden).

E—thiIe Edit View Project On-line Debug Scheme Variables Window Tools Help

e E 2¢Oy Py wE R BREGERESHEED B

L EF e 9@ F BlEME HE 0O F CIEE: 00 )y &
NS g FDROeD U HAAE @7 BECSS BR

Sl b o = P e
Dl d o 58 | &t Bl B bed m

Wrgr THAF |y O AP MEE EFT©

Project 4 x| Local varizbles

= ?-‘ PrjDoc Project i | MName | Type | Address | Aray Init value | Attribute
i Hinction blacks 1 |end_Analog BOOL Auta No . I
+ Functions

3.2.2 MOVING TOOLBARS

You can move a toolbar by clicking on its left border and then dragging and dropping it to
the destination.

&7 File Edit View Project On-line Debug Scheme Varizbles Window Toels  Help

Al W 2 CEAg Py wElh BENECIRER 9T H
¥ " BBBF FIEAE FEEH 00O
iZod@t: 805 b e
‘;'I'-UIC-C; --------------------- ”- -; Local variables
= @ Pyloc Project ol Name Type Address By Init value Apiibute

The toolbar shows up in the new position.

g File Edit  View Project On-line Debug  Scheme Vanables Window Tools  Help
Qo E 2CRIAN Ry Wl BHEORRETET O

S @i e SRS F NBAE HL o0l OTNEE: 80 » 4 @
Project 4 % Local variables
= E1 PrDoc Project ™ Maime Type Addrese MByray Init valus Anribifte

Function blocks N0 st Awvai B Biddn HlA T

3.3 DOCKING WINDOWS
3.3.1 SHOWING/HIDING TOOL WINDOWS

The View>Tool windows menu allows you to show (or hide) a tool window (for example,

(O 0]
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the Watch window, the Properties window, the Library window...).
The window is then shown (hidden).
Edit Project  On-line  Debug  Scheme  Variables W
[~ Toolbars rE e m D BEEEEE

* b Tool windows L Local variables

[£] Fullscreen  Ctrl+U v Project
Sl &
- Grid Watch -
- L Properties Window E
ttt Project | Ty
TN Oscilloscope )
Function blocks PLC run-time status
Functions U Library Tree
kel variahles ' Output
) ;_%IEEIE.T.% Cross Reference
asks

v Symbols browser

W | FResources

3.3.2 FLOATING TOOL WINDOWS

You can undock any window from its default location in PLC IDE and move it anywhere ,
just click on its title bar and drag it to the location you want.

Background e Zera el Acwiiog Ao
Boot
[ Init 2 et Prsse: 1
< m

< (1] >
2] Project Resources

+

(tR R <]

3 Resources - PidModeSelector ™18 PidControl

Output 4 x| Oper
I'Prel:\rn:u:essing TGT completed. L ooTTTmmmmmmmmmmm e :-l Nam
Freprocessing MAIN comnpleted.

Freprocessing Standard completed. A
Freprocesszing PID completed. @A
Preprocessing FileSysten conpleted. =
Preprocessing Alarmns conpleted. A
Freprocessing Recipes completed. A
Freprocessing Serial completed.

Freprocesszing Hodbus comnpleted. A
Freorocessing FLCConnect conoleted. la

Take back a window to its most recent docked location simply double-click the title bar of

the window.

3.3.3 DOCKING TOOL WINDOWS

0.0
PLC

PLC IDE shows you a guide diamond when you drag a window to another location to help

you easily re-dock the window.

While dragging a window move the mouse cursor on the position of the guide diamond

you want to use as new window position.
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=
[ [ [ [ i ']
=

Tool windows can be fastened to one side of a frame in PLC IDE or within a frame.

3.3.4 AUTO-HIDE TOOL WINDOWS

By the pin button on the top right corner of the window you can switch the window to
auto-hide mode or to regular docking mode.

3.4 WORKING WITH WINDOWS

PLC IDE allows to open many source code editors so that the workspace could get rather
messy.

You can easily navigate between these windows through the Document bar and the Win-
dow menu.

E_rh File Edit View Project On-line Debug Scheme Variables Toels  Help
At E 2¢CYIn L wE R g R Cascade

g Til a
h ¥ @O F B EME BE 0O . Y
Arrange lcons 7
Project 4 % Local variables . gAII
- : ose =
= m pUDOCPmJ_ECt 3 Mame R I Init value Attribute
* Funchian;blocks 1 |end_Analog BOL, e o = Transition
H Functicns 2 lactualTime uDl ¥ 2 PidModeSelector
+ Global variables =
i Prirae S PiContl # Transition
EP Init A m -
o P LadderLogic 5 LadderLogic
[+ EP Loops B B 6 Loops
+BgP PidControl = [N] Windows...  AR+W
c el PidModeSelecto -
+ @@ Parameters
it EF — EP S EF -
5 f“; Fast
B PidControl Zera st o kﬁug_smum@ Aty Prixse 0 5
@ PidModeSelector WYWME

w1 2% Slow I I I

3.4.1 THE DOCUMENT BAR

The Document bar allows to switch between all the currently open editors, simply by click-
ing on the corresponding name.

(O 0]
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Local variables

MName Type Addrezs Amray Init walue Atribute Description ~ @ |
1 |end_Analog BOOL Auto Mo i Transition result = ‘
2 |actualTime UDINT Allta No 5 f—
3 |end_Automatic BOOL Auto Mo i Transition result . &
. e r— = . re— = R ‘ |
M
[ =
[P rZeraSepan [F rpriogSen [P rpmaic
Zern_sepint Anaog st ety Presse
Aeutogegaocts | N | ettt
Pt Magpaive

Marusttiode N|
-

o Z e Aewdog o APl
et Prase 1 v

£ mn >

i
1 %3 Resources ™ PidControl [E] Init "L} LadderLogic [F]Loops Jm PidModeSelector f b X

At the right side of the Document bar, there are four buttons: the first two allow you to
browse the different open editors in case their number exceeds the document bar size;
the third shows you the currently open editors in a cascade menu; the last one allows you
to close the currently selected editor window.

3.4.2 THE WINDOW MENU

3.5

3.6

(©.C)
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The Window menu is an alternative to the Document bar: it lists all the currently open
editors and allows to switch between them.

Variables m Tools  Help

[Bralm i Cascade

Til
© o . v

Arrange lcons P
Close All £
1R 4

Ot ESOUTCES

uD! 2 Init

c BOK 3 Loops

4 PidControl

5 LadderLogic
6 PidModeSelector
Windows...  Alt+W

<

Moreover, this menu supplies a few commands to automate some basic tasks, such as
closing all windows.

FULL SCREEN MODE

In order to ease the coding of your application, you may want to switch on the full screen
mode. In full screen mode, the source code editor extends to the whole working area,
making easier the job of editing the code, notably when graphical programming languag-
es (that is, LD, FBD, and SFC) are involved.

You can switch on and off the full screen mode with the & View>Full screen .

ENVIRONMENT OPTIONS

If you click File>Options... , a multi-tab dialog box appears and lets you customize some
options of PLC IDE.
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3.6.1 GENERAL

3.6.1.1 VISUAL THEME

Colour Theme: allows you to turn PLC IDE to dark theme mode (or return to standard
mode), in order to have an environment that best suits your preferences.

3.6.1.2 SAVE OPTIONS

Max previous version to keep: if set greater than 0 indicates the maximum number of
copies of the project that must be zipped and stored in the PreviousVersions folder.

3.6.1.3 COMMUNICATION

Use last port: if enabled, the last used port will be set as the default one.

3.6.1.4 TOOLTIP

Enable tooltip on editors: if enabled, small information boxes will appear when user places
the cursor over a symbol in the editors.

3.6.1.5 OUTPUT WINDOW

You can specify the family and the size of the font used for the output window.

3.6.1.6 TOOL WINDOWS

You can specify the family and the size of the font used for the other tool windows.

Reset bars positions: the layout of the dock bars in the IDE will be resetted to default
positions and dimensions. In order to take effect PLC IDE must be restarted.

3.6.1.7 SOURCE EDITOR OPTIONS

ST-LD: auto declaration of variables: allows the creation of new variables in the moment
they’re first used in the code. In LD programs, when you name a variable block, that
name is suggested as a new variable. In ST program, upon entering a new code line, that
line is parsed to look for new variables to suggest.

Track active object in project tree: if this option is checked, when using the Go to symbol
(shift+F12) function, also the project tree will track the selected object.

Automatically restore last open editors: if this option is checked, PLC IDE will save open
editors when closing the project. When reopening the project, also the same editors will

be restored.
.
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3.6.2 GRAPHIC EDITOR

This panel lets you edit the properties of the LD, FBD, and SFC source code editors.
You can specify the family and the size of the font used for graphical editors.

You can modify also the colours of the graphical object.

You can also specify if you want to view the INOUT pins of function blocks at the top or at

the bottom of the block element.

3.6.3 TEXT EDITORS

You can specify the family, the size and the color of the font both for code and variable

editors.

You can specify the color of other environment and editors elements; for example you can

Program options

|General | Graphic Edtor | Text Editors | Language | Custom tools | Merge |

Font name Avial

Graphic object colors [[

Background network co
Obiject color

Text color
Selected text color
Error color
Comment color
Connection color
Select connection color|
Trigger color

Updatable object color
Block color

Block /0 element colors
SFC action block

SFC transition block
SFC selected transition
Live debug value color

Meore Colors...

M Fontsize |8

Grid width: | 200

Paosition of INOUT pins ffor new blocks):

change the color of the function calls

Program options x
|General | Graphic Edior | Text Editors | Language | Custom tools | Merge |
Code editor Variables editor
Font name Font name
@DengXian ~ AR BERKLEY ~
@MS Gothic AR BLANCA
@NSimSun AR BONNIE
@SimSun-E4B ARCARTER =
Consolas AR CENA
= ARCHRISTY
Courier New AR DARLING
DejaVu Sans Mano AR DECODE
DengXian AR DELANEY
Droid Sans Mono AR DESTINE
Fixedsys AR ESSENCE
Liberation Mono AR HERMANN
Lucida Console AR JULIAN
Lucida Sans Typewriter Arabic Transparent
MS Gethic
Noto Mono £ i b
Font size 1€ M Font size 9 ad

Textual editor {source and varables)

Colors | I -

Number color
Line number
Line number calumn color

Selected text color

Selection colar

Smart selection color

Smart selection highlight color
Function call text color

Options

ST: Highlight function calls

OK Annulla ?

®Top (O Bottom

OK Annulla ?

ris

;= myFunction[):

0.0
PLC
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3.6.4 LANGUAGE

You can change the language of the environment by selecting a new one from the list
shown in this panel.

After selecting the new language, press the Select button and confirm by clicking OK. This
change will be effective only the next time you start PLC IDE.

Program options X

| General | Graphic Editor | Test Editors | Language ;Custnm tools | Merge |

CHN - Chinese
Default lish

Engl
R
ITA - taliano Select the program language

You need to restart the program
for the change to take effect

Select

oK Annulla ?

3.6.5 CUSTOM TOOLS

You can add up to 16 commands to the Custom Tools menu. These commands can be
associated with any program that will run on your operating system. You can also specify
arguments for any command that you add to the Custom Tools menu. The following pro-
cedure shows you how to add a tool to the Custom Tools menu.

1) Type the full path of the executable file of the tool in the Command text box. Other-
wise, you can specify the filename by selecting it from Windows Explorer, which you
open by clicking the Browse button.

Program options X

General i‘Gmphic Editor ;Te:d Editurs.i. Language“% Custom tocls :“Merge ]

Command I
Arguments

Menu string

Add Delste Modify

OK Annulla ?

2) Inthe Arguments text box, type the arguments - if any - to be passed to the execut-
able command mentioned at step 1. They must be separated by a space.

3) Enterin Menu string the name you want to give to the tool you are adding. This is the
string that will be displayed in the Tools menu.

4) Press Add to effectively insert the new command into the suitable menu.

5) Press OK to confirm, or Cancel to quit.

For example, let us assume that you want to add Windows calculator to the Tools menu:
- Fill the fields of the dialog box as displayed.

(O 0]
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Program options X

|General I Graphic Editor | Text Editors I Language | Custom tools | Merge

Command C:AWindows\System 32\calc exe
Arguments
Menu string cald]
Add Delete Modify
OK Annulla ?

- Press Add. The name you gave to the new tool is now displayed in the list box at the
top of the panel.

Program options X

|Genem\ | Graphic Editor I Text Editors | Language ‘ Custom tools | Merge

]

Command C:\Windows\System 32\calc.exe
Arguments
Menu string cale
Add || Dekete Moy
OK Annulla ?

And in the Custom Tools>Calc menu as well.

E Custom tools L] calc

Run Modbus custom Editor [

Export as Modbus slave

Open with SoftScope

Execute network scan
[ : i : : Attribute

LT klm Tramei

3.6.6 MERGE

Here you can set the merge function behaviour (see Paragraph 4.8.3.3 for more details).

© .0
PLC
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Program options X

EGeneraI l Graphic Editar I Text Editors I Language I Custom toals | Merge |

Enable Merge

Identical name

CObjects with diferent types |Agk for action ~|

Object with same type (nat variables) |Ask for action -/

Vanables [ Ask for action |

Check address

Overlapped |Ask for action -

Copy'\Paste mapped variable | Do nething |
oK Annulla ?
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4.2

ARDUINO PLC IDE

MANAGING PROJECTS

This chapter focuses on PLC IDE projects.

A project corresponds to a PLC application and includes all the required elements to run
that application on the target device, including its source code, links to libraries, informa-
tion about the target device and so on.

The following paragraphs explain how to properly work with projects and their elements.

CREATING A NEW PROJECT

To start a new project, click «a File>New project of the PLC IDE main window.

New project x

Project
Mame |

Directory |C:Users'\MattiaMi\Documents®,

Target selection

Select the target for @ new project [vPLCi 10 -|

Cptions

[ ] case sensitive

oK Cancel

You are required to enter the name of the new project in the Name text area. The string
you enter will also be the name of the folder which will contain all the files making up the
PLC IDE project. The path name in the Directory area indicates the default location of
this folder.

Target selection allows you to specify the target device which will run the project.

Finally, you can make the project case-sensitive by activating the related option. Note
that, by default, this option is not active, in compliance with IEC 61131-3 standard: when
you choose to create a case-sensitive project, it will not be standard-compliant.

When you confirm your decision to create a new project and the whole required informa-
tion has been provided, PLC IDE completes the operation, creating the project directory
and all project files; then, the project is opened.

The list of devices, from which you can select the target for the project you are creating,
depends on the contents of PLC IDE catalog, which contains the list of available target
devices

If the desired target is missing, either you have run the wrong setup executable or you
have to run a separate setup which is responsible to update the catalog to include the
target device. In both cases, you should contact your hardware supplier for support.

UPLOADING THE PROJECT FROM THE TARGET DEVICE

Depending on the target device you are interfacing with, you may be able to upload a
working PLC IDE project from the target itself.

In order to upload the project from the target device, follow the procedure below:
1) Click the File>Import project from target: menu voice of the PLC IDE main window,

which opens the Target list dialog box.
.
PLC
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Import project from target X
Select target device:

Description
ArduinoDue
ArduinoMega25&0
AXC25

AXC25 HMI
AXC2B

mn >

Configure Connection

Cancel

2) From the shown list select the target device from which you want to upload the pro-
ject.

3) Configure Connection with correct parameters (see Paragraph 8.1 for more details).

4) You can test the connection with the target device by Verify Connection button. PLC
IDE tries to establish the connection and reports the test result.

5) If the connection is available confirm the operation by clicking on the Upload Sources
button. When the application upload completes successfully, the project is open and
ready for editing.

4.3 SAVING THE PROJECT
4.3.1 PERSISTING CHANGES TO THE PROJECT

When you make any change to the project (for example, you add a new Program Organi-
zation Unit) you are required to save the project in order to persist that change.

To save the project, you can select the corresponding item w File>Save project .

4.3.2 SAVING TO AN ALTERNATIVE LOCATION

You can also use the File>Save project As ... command to rename the project, change its
format or modify the location of where you want save the file.

PLC IDE asks you to select the new destination (which must be an empty directory), then
saves a copy of the project to that location and opens this new project file for editing.

4.3.3 BACKUP COPIES

PLC IDE includes a backup feature of the previous version of the project on which you are
working.

When you explicitly save the project, PLC IDE saves the current version (before save) of
the project in the PreviousVersions folder stored at the same location of the project folder;

You can set the upper limit of the backup files to be kept on your PC. By default this is 10,
set to 0 if you want to disable this feature (see Paragraph 3.6 for more details).

(©.C)
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If PLC IDE is not able to open a project, if it gets corrupted for example, an error message
is shown telling the user that the project cannot be anymore opened and asking if PLC IDE
should open the last saved previous version.

4.4 MANAGING EXISTING PROJECTS

4.4.1 OPENING AN EXISTING PLC IDE PROJECT

To open an existing project, click = File>Open project of PLC IDE’s main window, or in the
Welcome page (when no project is open). This causes a dialog box to appear, which lets
you load the directory containing the project and select the relative project file.

4.4.2 EDITING THE PROJECT

In order to modify an element of a project, you need first to open that element by double-
clicking its name, which you can find by browsing the tree structure of the project tab of
the Workspace bar.

By double-clicking the name of the object you want to modify, you open an editor consist-
ent with the object type: for example, when you double-click the name of a project POU,
the appropriate source code editor is shown; if you double-click the name of a global vari-
able, the variable editor is shown.

Note that PLC IDE prevents you from applying changes to elements of a project, when at
least one of the following conditions holds:

- you are in debug mode.

- It is an object of an included library (whereas you can modify an object that you im-
ported from a library).

- The project is opened in read-only mode (view project).

4.4.3 CLOSING THE PROJECT

4.5

You can terminate the working session either by explicitly closing the project or by exiting
PLC IDE. In both cases, when there are changes not yet persisted to file, PLC IDE asks
you to choose between saving and discarding them.

Logiclab X

o Save current project 7

Si Mo Annulla

To close the project, select the item File>Close project ; PLC IDE shows the Welcome page,
so that you can rapidly start a new working session.

DISTRIBUTING PROJECTS

When you need to share a project with another developer you can send him/her either a
copy of the project file(s) or a redistributable source module (RSM) generated by PLC IDE.

In the former case, the number of files you have to share depends on the format of the
project file:

- PLC single project file (.ppjs file extension): the project file itself contains the whole
information needed to run the application (assuming the receiving developer has an ap-

(O 0]
PLC

Arduino PLC IDE user manual 21



ARDUINO PLC IDE

4.6

propriate available target device) including all source code modules, so that you need
to share only the .ppjs file.

- PLC multiple project file (.ppjx or .ppj file extension): the project file contains only the
links to the source code modules composing the project, which are stored as single files
in the project directory. You need to share the whole directory.

- Full XML PLC project file (.plcprj): the project file is generated entirely in XML language.
The information contained in the project file and its behaviour are the same as .ppjs
file extension.

Alternatively, you can generate a redistributable source module (RSM) with the corre-
sponding item Project>Generate redistributable source module .

PLC IDE notifies you of the name of the RSM file and lets you choose whether to protect
the file with a password or not. If you choose to protect the file, PLC IDE asks you to insert
the password.

Generate redistributable source module x
[¥]Protect with password

PriDoc_29042020173556.rsm

Get password X
OK Cancel

Password: |

Confirm password:

oK Cancel

The advantages of the RSM file format are:

- the source code is encoded in binary format, thus it cannot be read by third parties
which do not use PLC IDE, making a transfer over the Internet more secure;

- it can be protected with a password, which will be required by PLC IDE on file opening;
- being a binary file, its size is reduced.

PROJECT OPTIONS

You can edit some significant project properties choosing Project>Options... .

4.6.1 GENERAL

(©.C)
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Here you can set some basic properties related to the project, such as its application
name and version.
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Project options x

| Buld events | Cross Reference | Runtime checks | Advanced |

General | Code generation | Buldoutput | Dowrload | Debug

Project info
Project: | IENREIS {max 10 chars)

Version: {example: 1.0}
Authr

Note:

Legacy options

[[] Use legacy LD edior

Lse customizable workspace

Main features

[[] Use object criented features
[ Muttiple files project {xplc)
Cthers

[]Custem sort of project folders

OK Annulla 7

- Use legacy LD editor: the new Ladder Diagram editor is easier to use, by helping you
in common operations working on the diagram will be faster and more efficient. Note
that, by default, this option is disabled; enabling it will allow the use of the old LD editor.

- Use customizable workspace: allows you to manage your project tree in order to reach
a more efficient workspace. Note that, by default, this option is active.

- Use object oriented feature: allows you to use object oriented programming; this fea-
ture may not be always available, it depends on the target device implementation.

- Multiple files project: allows you to save project in .xplc format.

- Custom sort of project folders: checking this option will enable Move Up and Move Down
command in the context menu of the folder, in the project tree.

4.6.2 CODE GENERATION

Here you can edit some properties about code generation.

Project options x

| Buldeverts | Cross Reference | Runtime checks | Asvanced |
General | Code generation | Buldoutput | Download | Debug |

Case sensivity (IEC default=no) (]
Check functions and function blocks extemal variables
VAR_IN_OUT by reference (IEC standard=yes) ]
Allow only integer indexes for amays O
Strict pointers check
Strict enumerations check
Enable SFC control flags {extension to IEC standard) [N
Init to zero of functions intemal variables [
Data copy size waming threshold (bytes, O=disable) 200
Enable preprocessor directives (extension to IEC standard) =
Enable Verbose waming mode |
Disable waming emission O
Disabled waming codes: 3
OK Annulla 7

- Case sensitivity: you can set the project as case-sensitive checking this option. Note

0.0

PLC

Arduino PLC IDE user manual 23



ARDUINO PLC IDE

that, by default, this option is not active.

- Check function and function block external variables: if this option is disabled, all func-
tions and function blocks can access to global variables without declaring them as ex-
ternal variables. Note that, by default, this option is enabled respecting the IEC 61131-3
standard.

- VAR_IN_OUT by reference: if checked, the variables declared as VAR_IN_OUT of a func-
tion block will be treated as reference variables, accordingly to IEC standards.

- Allow only integer indexes for arrays: if this option is checked you cannot use BYTE,
WORD or DWORD as array indexes.

- Strict pointers check: if enabled, pointer and pointed type validity check is added. The
type of a pointer variable must be the same of its pointed variable; if not, an error is
generated.

- Strict enumerations check: if enabled, enumeration assignment type validity check is
added. You can assign enum only to the same type; if not, an error is generated.

- Enable WAITING statement (extension to standard): if this option is checked the WAIT-
ING construct for the ST language is added as IEC 61131-3 extension (see Paragraph
11.7.3 for more details).

- Enable SFC control flags (extension to IEC standard): if this option is checked, HOLD
and RESET flags for SFC POU are enabled.

- Inijt to zero of function internal variables: if this option is checked, the initial value of the
internal varaibles of the functions, will be set to zero as default.

- Data copy size warning threshold (bytes, O=disable): when arrays or structures are
copied, if their dimension exceed the specified threshold, a warning is emitted in order
to inform the possible loss of performance of the PLC. If the threshold is set to 0, no
warnings are emitted.

- Enable preprocessor directives (extension to IEC standard): if this option is checked,
IFDEF feature is enabled (you can allow build of portion of code verifiyng if a certain
symbol has been defined).

- Enable verbose warning mode: if this option is checked several minor warning, related
to operation between signed and unsigned variables, are emitted; if disabled those
warnings are not emitted.

Warnings handled with this option are:
- Sign extension warnings (for example INT + UINT)
- Comparison between diffent typed variables (for example INT > UINT)
- Sign / unsigned mismatch (for example INT := UINT)
- Operation between pointer and non pointer
- Boolean operand required (comparison between boolean and contant 0/1)
- Implicit conversion from single to double precision

- Enable standard IEC type convertion rules: if this option is checked, ensure to apply
convertion rules defined into IEC standard, with consequent warning and error mes-
sages. If this option is not checked, some more flexible convertion rules are applied.
Details about standard convertion rules can be found at paragraph 7.5.

- Disable warning emission: if this option is checked warning emissions are not printed
on the output window.

- Disable warning codes: you can specify a list of warning code that will not be printed on
the output window.

4.6.3 BUILD OUTPUT

Here you can edit some significant properties of the output files generated by compiling
operation.

(©.C)
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| Buldeverts | CrossReference | Runtme checks | Advanced

Project options x
|
|

General T Code generation | Build output ‘_Downlnad_ I Debug
Downloadable target files

Create downloadable target files ]

PLC application:
Source code
Debug

Listings, reports etc.

Generate code listing file (lst)

Generate mapped variables export file {exp)

0O0d™

Generate unused elements report (unuxml}

OK Annulla ?

Downloadable target files section

Create downloadable target files: if this option is checked the compiler will generate the
binary files that can be downloaded to the target. You can specify custom filenames or
use default ones.

Please note that only valid Windows filename are accepted!

PLC application (active only if Create downloadable target files is checked): this field
specifies the name of the PLC application binary file. By default projectname.bin.

Source code (active only if Create downloadable target files is checked): this field
specifies the nhame of the Source code binary file. By default projectname._source.bin.

Debug (active only if Create downloadable target files is checked): this field specifies
the name of the Debug symbol binary file. By default projectname._debug.bin

Listing, reports, etc... section

4.6.4

Generate code listing file (.Ist): if this option is checked the compiler will generate a
listing file named as projectname.lst.

Generate mapped variables export file (.exp): if this option is checked the compiler will
generate an EXP file named as projectname.exp.

Generate unused elements report (.unu.xml):

DOWNLOAD

Here you can edit some significant properties of the download behaviour (see Paragraph
8.3.1 for more information).

Project options X
I

| Buid events J Cross Reference | Run:{_iTe_ghg_t;!_':__s_;_{\_c_lfil_'lf_:_e_g
General | Code generation | Build output | Download I Debug

Source code

Download time (On PLC application download
Protect with password

Password

Debug symbals

Download time

oK Annulla ?

(O 0]
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4.6.5 DEBUG

Here you can edit some significant properties of the debug behaviour.

Project options X

:J&;ild events | Cross Reference 7'577F{unr-tirrnercrheg<sﬁéiﬁ_d!a_n_gg_t_i 3 |

General Code generation ] Build output I Download ] Debug |
Palling period for debug functions (ms) [2(]
Mumber of displayed amay elements 20

without alert message

Polling period between more variables (ms) 0
Autosave watch list [
Enable memory dump (%MW <address> syntax) O
Watch intemal variables of function blocks O
Automatically dereference pointers and references in watch
Print debug informations O

oK Annulla ?

- Polling period for debug function (ms): set the active sampling period of the functions’s

status.

- Number of displayed array elements without alert message: specifies the maximum

number of array elements to be added in watch window without being alerted.

- Polling period between more variables (ms): set the sleep period between sampling

two variables.

- Autosave watch list: if checked (not by default) the watch list status will be saved into

a file, when the project is closed (see Paragraph 9.1.7 for more details).

- Enable memory dump: advanced debug feature, allows the user to put in watch directly

physical memory addresses (with format %MW without subindexes)

- Watch internal variables of function block: when putting a function block instance in

watch you'll see also the internal variable values; with this option disabled, only the
input and output variables of that function block will be displayed in the watch.

- Automatically dereference pointers and references in watch:if this option is checked,

when adding the pointer variable in the watch window, the pointed value will be directly
shown; if it is disabled, the watch window will show the content of the pointer which
need to be expanded to see the pointed value.

- Print debug informations: when compiling, additional information are shown in the out-

put window.

4.6.6 BUILD EVENTS

(©.C)
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Here you can specify commands that run before the build starts or after the build finishes.
You can also use a set of defined environment variables listed on the top of the window.
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Project options X

Environment variables

PRJTITLE PRIPATH PRJBASENAME PRIFULLNAME IMGNAME
TARGETDEFNAME PRJRELEASE PRIVERSION PRIAUTHOR
PRJCONN APPLPATH SIMUL

Post-build commands:
| "

Pre-download commands:

Post-download commands:

0K Annulla ?

4.6.7 CROSS REFERENCE

This window allows you to enable the cross reference.

Since using the cross reference will generate additional information, making the project a
little heavier, it has to be explicitly enabled.

This window allows you also to set the list of elements that will be searched when execut-
ing a cross reference research.

Project options X

| Download | Debug |
me checks I—Advanced |

devents | Cross Reference

Generate crossteference

Options

Trace Global Vars Trace Local Vars O
Trace Programs Trace Frunctions
Trace Function Blocks Trace Tasks | |
Trace Macros [ Trace Structs O
Trace Enums [ Trace Subrs O
Trace TypeDefs O

Trace in Programs Trace in Functions O
Trace in Functions Blocks

0K Annulla Applica 7

4.6.7.1 USING THE CROSS REFERENCE

Once the cross reference has been enabled, open the relative window selecting
View > Tool window > Cross reference ; the following window should be opened:
.
PLC
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Cross Reference X
2 @ © Name: + Context: -

Location Access Reference

In the menu labeled Name: you will see a collection of all the symbols found by the
system looking into the groups selected in the Cross reference panel. You can select a
symbol from that menu, or you can press the automatic cross reference button:

t-i

and simply select a symbol from the project tree.

Once you have selected a symbol, the cross reference window will show you all the oc-
currences of that symbol and information such as: location of the POU where it’s used,
how it is used and where it is used inside the POU.

Cross Reference x
1 @ © Name PIDCONTROL - Context: -
Location Access Reference
& PIDCONTROL RD Met: 1
& PIDCONTROL RD Met: 5
@ PIDCONTROL RD Met: 5
& PIDCONTROL RD Met: 5
"B PIDCONTROL RD Met: 5
‘I PIDMODESELECTOR/ANALOGINPUTMODE WR Rows: 3
[ PIDMODESELECTOR/MANUALMODE WR Row: 3
[ PIDMODESELECTOR/SETPOINTIONEGATIVE WR Row: 3
@ PIDMODESELECTOR/SETPOINTI0PQSITIVE WR Rows: 3

From the menu labeled Context: you can filter the result.

By double clicking one of the occurrences in the result list, the relative POU window will
be opened and the element (code line or block) where the symbol is used will be high-
lighted.

4.6.8 RUN-TIME CHECKS

(©.C)
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These options allow the user to enable specific controls made at execution time.
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Project options X

| General | Code generation | Buidoutput | Download | Debug |

Build everts Cross Reference | Runtime checks | Advanced |
Funtime check of aray bounds ]
Run+time check of pointers | None -
Runtime check of division by zero ]
Funtime check of references ]

QK Annulla Applica ?

- Run-time check of array bounds: if this option is checked some check code is added to
verify that array indexes are not out of bounds during run-time. This option can be set
depending on target device.

- Run-time check of pointers: this combo allows you to choose if and when the pointer
will be tested for their validity before their use.
Selecting NONE, the check will never be done.
Selecting ONLY IF NOT NULL, the check will verify that the pointer value is not NULL;
if it is NULL, it will return value zero but will not stop the running application. So the
PLC execution will never be interrupted due to a NULL pointer, but you’ll never get an
error notification.
Selecting FULL, the check will verify that the pointer value is not NULL and that the
pointed address is within a validity range (this last control requires the user-defined
function checkptr on target; if it is not defined, only the first control is executed). If
one of this two controls fail, the PLC execution is interrupted and an error message is
raised.

- Run-time check of division by zero: if this option is checked some check code is added
to verify that divisions by zero are not performed on arrays during run-time. This option
can be set depending on target device.

- Run-time check of interfaces: if this option is checked,allows a references validity check
within a method call. This option can be set depending on target device (Object Ori-
ented supported)

- Run-time check of references: if this option is checked, allows a references validity
check; if a reference is dereferenced to null, a runtime error is generated.

4.6.9 ADVANCED

These options allow the user to specify specific behaviors, suggested only for expert us-
ers:

(O 0]
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Project options X
!___ggl_'l_qg_l__!__gnde generation ! Build output ! Dqul_g_qgl__.!._ _I_:_]_ng-,_l_:u_u_g__.!_
Build events | Cross Reference I Run4ime checks Advanced |
LD: evaluate edges on each netwaork [L1]
Extemnal access to local vars of function blocks [1]
QK Annulla ¥

- LD evaluate edges on each network: this option allows the user to change edges
evaluation timing (high/low).
If it is NOT checked, the edges of an LD2 program are evaluated only once, at the
beginning of the program execution.
If it is checked, the edges of an LD2 program are evaluated at the beginning of every
LD network.

- External access to local vars of function blocks: if this option is NOT checked, the lo-
cal variables of a function block, are considered private and accessible only inside the
function block. (standard IEC behavior).

If this option is checked, the local variables of a function block are considered as IN/
OUT variables; so they are visible and accessible also from the caller of the function

block instance.

4.7 SELECTING THE TARGET DEVICE

You may need to port a PLC application on a target device which differs from the one you
originally wrote the code for. Follow the instructions below to adapt your PLC IDE project
to a new target device.

1) Click Project>Select target menu of the PLC IDE main window. This causes the follow-
ing dialog box to appear.

Select target X

Available Targets

ArduinoPMC 1.0

Cancel

2) Select one of the target devices listed in the combo box.
3) Click Change to confirm your choice, Cancel to abort.
4) If you confirm, PLC IDE displays a dialog asking to continue with the operation.

(©.C)
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This operation requires to save the project.
Continue the operation 7

si Mo

Press Yes to complete the conversion, No to quit.
If you press Yes, PLC IDE updates the project to work with the new target.

It also makes a backup copy of the project file(s) in a sub-directory inside the project
directory, so that you can roll-back the operation by manually (i.e., using Windows
Explorer) replacing the project file(s) with the backup copy.

4.8 WORKING WITH LIBRARIES

Libraries are a powerful tool for sharing objects between PLC IDE projects. Libraries are
usually stored in dedicated source file, whose extensionis .pI77 or .plclib.

4.8.1 THE LIBRARY MANAGER

ARDUINO PLC

Libraries:
Mame
AICOPM
AlDatabase
AlModbusR.TU

AlModbusTCPMaster
Standard

Libraries directaories:

Path

Project library list

Link:

c:program files (x86) \arduino pc tools\catalog...
c:\program files (x86)\arduino pc tools\catalog.. .
c:'program files (x86)\arduino pc tools\catalog...
c:'program files (%86 \arduino pc tools\catalog...
c:\program files (x&6)\arduino pc tools\catalog.. .

Add

Remove all

Add

Close

IDE

The library manager lists all the libraries currently included in a PLC IDE project. It also
allows you to include or remove libraries.

To access the library manager, click # Project>Library manager .

4.8.1.1 INCLUDING A LIBRARY

The following procedure shows you how to include a library in a PLC IDE project, which
results in all the library’s objects becoming available to the current project.

Including a library means that a reference to the library’s .pll file is added to the current
project, and that a local copy of the library is made. Note that you cannot edit the ele-
ments of an included library, unlike imported objects.

If you want to copy or move a project which includes one or more libraries, make sure
that references to those libraries are still valid in the new location.

1) Click = Project>Library manager , which opens the Library manager dialog box.

2) Press the upper Add button, which causes an explorer dialog box to appear, to let you
select the library you want to open.

3) When you have found the library file, open it either by double-clicking it or by press-
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ing the Open button. The name of the library and its absolute pathname are now
displayed in a new row at the bottom of the list in the Libraries box.

4) Repeatstep 1, 2, and 3 for all the libraries you wish to include.

5) When you have finished including libraries, press either OK to confirm, or Cancel to
quit.

Alternatively, if you already have one or more set of libraries you wish to include in your

project, a quicker way is to specify a folder path in the Libraries directories box. This way
all the libraries inside the specified folder will be included to the project.

1) Click # Project>Library manager , which opens the Library manager dialog box.

2) Press the lower Add button, which causes an explorer dialog box to appear, to let you
select the desired folder.

3) Add the selected folder by clicking the OK button.

4) When you have finished including libraries, press either OK to confirm, or Cancel to
quit. Pressing OK will cause all the library in the selected folders to be included in the
project

If, by error, you include a library that redefines an object or a symbol (defined inside the
project or in a previously included library), you will get a proper WARNING message but
the include operation will be completed sucesfully; the redefined symbol of the latest in-
cluded library, will be automatically excluded from build.

4.8.1.2 REMOVING A LIBRARY

(©.C)
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The following procedure shows you how to remove an included library from the current
project. Remember that removing a library does not mean erasing the library itself, but
the project’s reference to it.

1) Click ® Project>Library manager menu of the PLC IDE main window, which opens the
Library manager dialog box.

Project library list

Libraries:

Name Link Add
AICCPM ci\program fi

ADatzbase o i
AModbUsRTU

AMocbusTCPMaster  c:'\prox
Standard

Path Add

Close

Select the library you wish to remove by clicking its name once. The Remove button
is now enabled.

2) Click the Remove button, which causes the reference to the selected library to disap-
pear from the Project library list.

3) Repeat for all the libraries you wish to remove. Alternatively, if you want to remove
all the libraries, you can press the Remove all button.

4) When you have finished removing libraries, press either OK to confirm, or Cancel not
to apply changes.

Alternatively, you can remove a whole library folder; doing it will remove ALL the library
contained in that folder. To do so, select the folder in the Folder directories area; then
press the Remove button and then OK to confirm and close, making the changes effective.
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4.8.2 EXPORTING TO A LIBRARY

4.8.2.

You may export an object from the currently open project to a library, in order to make
that object available to other projects. The following procedure shows you how to export
objects to a library.

1) Look for the object you want to export by browsing the tree structure of the project
tab of the Workspace bar, then click once the name of the object.

2) Click Project>Export object to library . This causes the following dialog box to appear.

Export PLC objects to library X

File name J: \mylib. ol
Code encryption  []
Version 1.0.0

Description

OK Cancel

3) Enter the destination library by specifying the location of its file (it can be a .pl// ora
a .plclib file). You can do this by:

- typing the full pathname in the white text box;

- clicking the Browse button , in order to open an explorer dialog box which allows
you to browse your disk and the network.

4) You may optionally choose to encrypt the source code of the POU you are exporting,
in order to protect your intellectual property.

5) 1If you chose and already existing library file, you can enter a version number in the
version field in order to keep track of library changes.

6) Click OK to confirm the operation, otherwise press Cancel to quit.

If at Step 3 of this procedure you enter the name of a non-existing library file, PLC IDE
creates the file, thus establishing a new library.

1 PLL VS PLCLIB FORMAT

The .pll was the old library format used by PLC IDE; even if .pll format is still supported
by PLC IDE, we strongly recommend to use .plclib format.

The .plclib format is the new library format used by PLC IDE; it can handle all the newest
feature of PLC IDE: for example you can export blocks with images associated, or you can
export entire folder to a library in order to better organize your objects, when importing
you will import the library non just a list of objects.

4.8.2.2 UNDOING EXPORT TO A LIBRARY

4.8.3

So far, it is not possible to undo export to a library. The only possibility to remove an ob-
ject is to create another library containing all the objects of the current one, except the
one you wish to delete.

IMPORTING FROM A LIBRARY OR ANOTHER SOURCE

You can import an object from a library in order to use it in the current project. When
you import an object from a library, the local copy of the object loses its reference to the
original library and it belongs exclusively to the current project. Therefore, you can edit

(O 0]
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imported objects, unlike objects of included libraries.

There are two ways of getting a POU from a library. The following procedure shows you
how to import objects from a library.

1) Click Project>Import objects . This causes an explorer dialog box to appear, which
lets you select the library file of the library you want to open.

2) When you have found the library file, open it either by double-clicking it or by press-
ing the Open button. The dialog box of the library explorer appears in foreground.
Each tab in the dialog box contains a list of objects of a type consistent with the tab’s

title.
Object browser X
Objects filter r
Mame Type
Programs *& f caller_InitFunc Programs
Function Blocks @ f_Caller_InitFunc_LREAL Programs
[¥|Functions “[@ f_Caller_InitFunc_REAL Programs
et & f_dint Functions
[#]User types Ffint Functions
& fint Functions
Chedk al Check none ot iredl Funciors
& foreal Functions
& osint Functions
Other filters I f udint Functions
e * ok & uint Functions
&t uint Functions
Location | | & usint Functions
Library |
Vars type [t -
Vars group |

< Tl > |

Close Selectall Select none

3) Select the tab of the type of the object(s) you want to import. You can also make
simple queries on the objects in each tab by using Filters. However, note that only the
Name filter actually applies to libraries. To use it, select a tab, then enter the name
of the desired object(s), even using the * wildcard, if necessary.

4) Select the object(s) you want to import, then press the Import object button.

5) When you have finished importing objects, press indifferently OK or Cancel to close
the Library browser.

4.8.3.1 IMPORT WHOLE LIBRARY

Intead of importing single objects, you can import the whole content of a library as project
elements; to do so: select the root element of the project tree, open its context menu and
choose Import whole library.

A file browser will appear to allow you to select the library file; once you have done, you'll
find a new folder inside the project tree, with the same name of the library, and the whole
content of the library will be inside that folder.

4.8.3.2 UNDOING IMPORT FROM A LIBRARY

When you import an object in a PLC IDE project, you actually make a local copy of that
object. Therefore, you just need to delete the local object in order to undo import.

4.8.3.3 MERGE FUNCTION

(©.C)
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When you import objects in a PLC IDE project or insert a copied mapped variable, you
may encounter an overlapping address or duplicate naming warning.

By setting the corresponding environment options (see Paragraph 3.6 for more details)
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you can choose the behaviour that PLC IDE should keep when encountering those prob-
lems.

The possible actions are:

Ask | Automatic Ta!(e VLT Dq
library nothing
If different types X X X
Naming |If same type but not
. ) X X X
behaviour | variables
If both variables X X X
Address If address overlaps X X X
behaviour Cop_y/paste mapped X X
variable

Ask (default): user has to decide every time an action is required.

Automatic: a valid name or address is automatically generated by PLC IDE and assigned
to the imported object.

Take from library: the name or the address is taken from the imported object.
Do nothing: the name or the address of the objects in the project are not modified.

After importing objects, PLC IDE generates a log file in the project folder with detailed
info.

4.8.4 UPDATING EXISTING LIBRARIES

If you edit a linked library file you can refresh its content on the project without closing
PLC IDE.

1) Click # Project>Refresh all libraries .

2) If the file is correct, PLC IDE updates the linked library content and prints a success-
ful message in the output window, otherwise no changes are made on the existing
linked library.

(O 0]
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MANAGING PROJECT ELEMENTS

This chapter shows you how to deal with the elements which compose a project, namely:
Program Organization Units (briefly, POUs), tasks, derived data types, and variables.

PROGRAM ORGANIZATION UNITS

A POU is a Program Organization Unit of type Program, Function or Function block.

This paragraph shows you how to add new POUs to the project, how to edit and eventu-
ally remove them.

In paragraph 5.1 we will be using a program as example of a generic POU, but the same
can be achieved also for functions and function blocks

5.1.1 CREATING A NEW PROGRAM ORGANIZATION UNIT

In order to Add a POU select the appropriate voice of the menu
Project>New Object>New program

Please note that the item of the sub-menu may change according to the type of the POU
you want to create.

PLC IDE will show you a dialog box in where you must select the specific language for the
new POU and enter its name.

New program X
Language
(§) 1 (_JFBD (@]1:] (®)sT ()sFC

Name

Task

Assign to | - A

oK. Cancel

Confirm the operation by clicking on the OK button.

Alternatively, you can create a new POU from the context menu by selecting a folder or
the root element of the project (see Paragraph 5.7.4).

After creating a new program, an alert icon (interrogation mark) appears below the new
program icon.

+-BEP PidControl
¥ E?:P PidModeSelector

G TesProgror

+ - EE Parameters
+ [ Tasks

This alert icon indicates that the program is not yet associated to a task. Refer to para-
graph 5.3.1 to assign the program to the desired task.

(O 0]
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5.1.1.1 ASSIGNING A PROGRAM TO A TASK AT CREATION TIME

When creating a new program, PLC IDE gives you the chance to assign that program to a
task at the same time: select the task you want the program to be assigned to from the
list shown in the Task section of the New program window.

MNew program x
Language
On (_JFED @]1:] (@57 ()sFc
Name

TestProgram

Task

Assign to | -/

Fast
Background
Boot

Init

5.1.2 EDITING POUS

(©.C)
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To edit a POU, open it by double-clicking it from the project tree. The relative editor opens
and lets you modify the source code of the POU.

Changing the name of the POU:

Select a POU from the project tree then open its context menu by right-clicking on its
icon, choose Rename Program .

Duplicating a POU:

Select a POU from the project tree then choose the appropriate voice of the menu
Project>Duplicate object .

Enter the name of the new duplicated POU and confirm the operation.
Deleting POUs

Select a POU from the project tree then choose the appropriate voice of the menu
Project>Delete Object .

Confirm the operation to delete the POU.
Editing POU properties

Select a POU from the project tree then open its context menu by right-clicking on its
icon, choose Edit Program Properties .

Object properties (FUNCTION BLOCK) x
uuuuuuuuuuuu

Icon: Browse.. | | Remove

xxxxxx

nnnnnnnnnnnnnnnnnnnnnn

Exclude from buid optons

[excude

cccccc
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A window will appear allowing you to edit information such as version number, description
and, if the POU is a function or a function block, also the icon and the image.

The icon must have a maximum size of 100x100 pixels; if added, the icon will be dis-
played overlaying to the block when it is used in a graphic language (LD or FBD)

The images must have a maximum weight of 30 KB per image. You can display imported
images in the description windows by linking them with HTML syntax; check the use HTML
syntax box and then use <img src="imagename”>; to add the image to the description.

View POU properties:

Select a POU from the project tree then choose the appropriate voice of the menu
Project > View PLC object properties .

Exclude from build:

Select a POU and right-click on it to open its context menu, from there select
Exclude from build . Doing so the POU will be ignored when compiling the project, even if
the POU is used in the project.

For example: if a program as been already assigned to a task, you can avoid to compile it
by selecting “exclude from build” instead of removing the program from the task; this will
allow you to change the project behaviour without changing the project tree.

Be careful, excluding from build a POU that is required by another element will generate
an error message. For example: if you exclude from build a function which is called by a
program, when compiling the program you’ll obtain en error message.

5.1.3 SOURCE CODE ENCRYPTION/DECRYPTION

PLC IDE can encrypt POUs and protect them with a password, hiding the source code of
the POU.

Encrypting a POU:
Select a POU from the project tree then choose the [Crypt] voice of the context menu
Double enter the password and confirm the operation.

CRYPT POU X
Fassword: |
Confirm password:

OK Cancel

PLC IDE shows in the project tree a special marker icon that overlays the standard POU
icon in order to inform the user that the POU is crypted.

Decrypting a POU:

Select a POU from the project tree then choose the [Decrypt] voice of the context menu

Encrypting all POUs:

Select the root element from the project tree then choose the [Crypt all objects] voice of
the context menu.

All POUs will be encrypted with the same password.
Decrypt all POUs:

Select the root element from the project tree then choose the [Decrypt all objects] voice
of the context menu.

(O 0]
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5.2 VARIABLES

There are two classes of variables in PLC IDE: global variables and local variables.

This paragraph shows you how to add to the project, edit, and eventually remove both
global and local variables.

5.2.1 GLOBAL VARIABLES

Global variables can be seen and referenced by any module of the project.

5.2.1.1 CLASSES OF GLOBAL VARIABLES

5.2.1.2

(©.C)
PLC

Global variables are organized in special folders of the project tree called Global vars.
Those variables are classified according to their properties as:

Automatics: the compiler automatically allocates them to an appropriate location in the
target device memory.

Mapped: they have an assigned address in the target device logical addressing system,
which shall be specified by the developer.

Constants: are declared having the CONSTANT attribute; They cannot be written.

Retains: they are declared having the RETAIN attribute; Their values are stored in a
persistent memory area of the target device.

CREATING A NEW GLOBAL VARIABLE

1) Inorderto create a new global variable select a Global variables group from the project

tree then choose the appropriate voice from the menu Project>New Object>New variable
(see Paragraph 5.7.4).

2) PLC IDE will show you a dialog box where you must enter the name of the variable

(remember that some characters, such as '?’, ', '/, and so on, cannot be used: the
variable name must be a valid IEC 61131-3 identifier).

3) Specify the type of the variable either by typing it or by selecting it from the list that

PLC IDE displays when you click on the Browse button.

New variable X

Name | Type

Group Counters_and_timers - Array No
Attribute AUTO Init values
Description

oK Cancel

Object browser x
Objects fiter
Name T
BooL B
[ Function Blocks [B]evTE B:
g E
Bdoworn B
[Juser types [¥]Basic types [ioe B
[@unr 2
Checkal Check none [ichireaL 2
[1w]Lworn Basic types
[rlreaL E
Other fiters SINT B
Mo = 7 [slsmRinG B
fdluomT E
Location  [al - [uumr B
P —— [uluLmr B
Lbrary [l - s a
vars type | duorn B

Vars group |

Close

If you want to declare an array, you must specify its size.
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Size of variable X
() Scalar
(®) Array [ Matrix
Dimension 1 0..|0 size= 1
Dimension 2 0.0 size= 1
Dimension 3 0..|0 size= 1
oK Cancel

4) You may optionally assign the initial value to the variable or to the single elements
of the array.

1t ] Init values for: () x
[1.2.31

OK Cancel

If you create a new mapped variable, you are required to specify the address of the vari-
able during its definition. In order to do so, you may do one of the following actions:

- Click on the button to open the editor of the address, then enter the desired value.

Mapped variable declaration X
Name | Data type UNDEF
Group | Counters_and_tmers - Size No
Data block o Subindex cee. | BHE ]
ElE 1/ data blodk Base addr. Size Unused
Data block available for user ... %MB200.0 65536 65538
Data block avalable for user ... %MB201.0 4098 4098
RO allocation area for plugine  ¥EMB100.0 20000 20000
RW allocation area for pluging  %EMB101.0 20000 20000
Other data blocks
Description
OK Cancel
Variable address X
Address type
() Auto (@) Mapped () Unspedfied
Size Location
Bit
@ ! @ Input
Byte (8 bit)
O yte (8 bit) D Output
(O word (16 bit) O Memory
() Double word (32 hit)
Datablock  Index Bit[ | oK

[v] a
' Cancel

- Select from the list that PLC IDE shows you the memory area you want to use: the tool
automatically calculates the address of the first free memory location of that area.

5.2.1.3 EDITING A GLOBAL VARIABLE

To edit the definition of an existing global variable, open it by double-clicking it, or the
folder that it belongs to, from the project tree. The global variables editor opens and lets

you modify its definition.
.
PLC

Arduino PLC IDE user manual 41



ARDUINO PLC IDE

e Tl e L . | e ] e T
= @ PrDes P'DJ_E“ A 1 |parCtDownPreset  UDINT Auto No 100 — Counter down preset
= functionbloCs 2 |parCtUpPreset  UDINT Auto No 15 = Counter up preset
+ [FF, LowPassFilter 1
o Functions 3 |parPulseValue UDINT Auto No = Actual pulse time value
L J——— 4 |parPulseWidth UDINT Auto No 500 - Pulse width
= Automatic variables =, 5 |parTimOnDelay UDINT Auto No 1000 o Delay of the ON delay timer
= E#@ Counters_and_timers & |parTimOnVvalue UDINT Auto Mo — Actual value of the timer

parCtDownPreset

parPulseValue
Changing the name of the variable:
Select the variable you want to rename from the project tree then right-click on it and
select Rename Variable  from the context menu.
Duplicating a variable:

Select the variable you want to duplicate from the project tree then right-click on it and
choose Duplicate Variable from the context menu.

Enter the name of the new duplicated variable and confirm.

Deleting a variable:

Select the variable you want to delete from the project tree then right-click on it and
choose Delete Variable from the context menu.

Confirm the operation to delete the variable.
Refactoring a variable:

Refactoring will allow you to change the name of a global variable and consequently
adjust all of its occurrences in the project.

Select the desired variable from the project tree, then right-click on it and choose
Refactoring  from the context menu.

A window will appear allowing you to insert a new variable name and showing you all
the occurrences found for this symbol; if you change the name and press OK, all the
shown occurrences will be modified.

ir Refactoring X

Refactor to | parTimOnvalug|

Parent Object Type Mum, occ.
PidCaontral FBD program 1
Init ST program 1
Loops ST program 3

Total number of oocurrences found: 5

Refactor Cancel

5.2.2 LOCAL VARIABLES
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Local variables are declared within a POU (either program, or function, or function block),
the module itself is the only project element that can refer to and access them.

Local variables are listed in the project tree under the POU which declares them (only
when that POU is open for editing), where they are further classified according to their
class (e.g., as input or inout variables).
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= Function blocks

L] in
[r]k
- Cutput variables

|I| out
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In order to create, edit, and delete local variables, you have to open the POU for editing
and use the local variables editor. The project needs to be saved in order to update the
POU branch structure of the project tree, including the changes applied to the local vari-

ables.

= f& PiDoc Project fa Class Pin Name Type Aray Init value Atrbute Description HEl

Function blocks |
1 VAR_INPUT 0 in REAL No | ‘

o m=E =
o asslle abl 2 VAR_INPUT 1 k REAL No =4
= nput variables ‘
lel in 3 |VAR_OUTPUT 0 out REAL No

[ |
= [] Outputvariables =

[r] out A

i Functions
e Global variables
Programs
[P Init
P Ladderlogic
[EP Loops
- B@P PidControl
P PidModeSelector
+ i@ Parameters
E1Project B Resources

ot =k * { in - out ) + out;

v |

%9 Resources [&] LowPassFilter ™2 PidCantrol

Refer to the corresponding section in this manual for details (see Paragraph 6.6.1.2).

5.2.3 CREATING MULTIPLE VARIABLES

PLC IDE allows you to create multiple variables in one shot.
Open the POU for

Variables>Create multiple .

editing then choose the appropriate voice of the menu

PLC IDE will show you a dialog box where you must specify the prefix and the suffix to
name of the new variables.

1) Select the type of the variables.
2) Choose type and attribute for the variables.

3) Insert the number of the variables you want to create specifying the start index,
the end index and the step value. You can see an example of the generated variable
names at the bottom of the dialog.

Create multiple variables

MName

Prefix: Example_

Suffix: _Var]
Type

Type:

Attribute

i
Attribute: I_' -

Counter

From: 1 To: | 10 Step: | 1

Example: Example_1_Var Example_2_Var Example_3_Var

oK Cancel
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5.2.4 TEXTUAL EDITOR FOR VARIABLES

Both global and local variables can be created and edited also from a textual editor; refer
to the corresponding section in this manual for details (see Paragraph 6.6)

5.3 TASKS
5.3.1 ASSIGNING A PROGRAM TO A TASK

1) Select the task where you want to add the program from the project tree then choose
the [Add program] voice of the context menu.

2) Select the program you want to be executed by the task from the list which shows up
and confirm your choice.

i Object browser X
Objects filter r
Mame Type
v & it Programs
@ LadderLogic Programs
’E Loops Programs
@ ridcontrol Programs
@ pidModeselector Programs
Other filters
MName + OK
Location | a] -
Library IAII hd
Vars type |
Vars group |
< m >

Close

3) The program has been assigned to the task, as you can see in the project tree.

= Programs
EIP Init
P LadderLogic
EIP Loops
+-#=P PidControl
FoP PidModeSelector
+-EE Parameters
— [ Tasks
= :,'5 Fast
"B PidControl
"B PidModeSelector
2 Slow
IH Loops
:,'5 Background
"B Lladderlogic
% Boot
2% Init

B Init

Note that you can assign more than a program to a task. From the contextual menu you
can sort and, eventually, remove program assignments to tasks.
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= [ Tasks
= ‘3 Fast
* PidControl B
i
23 ,‘.; Sl Remove program Delete
B Loops Move up Ctrl+Shift+Up
=l 9 Backgrounc Move down  Ctrl+Shift+Down

B Laddercoge 1

5.3.2 TASK CONFIGURATION

Depending on the target device you are interfacing with, you may have the chance to
configure some of the PLC tasks’ settings.

Select the tasks element from the project tree then choose the [Task configuration] voice
of the context menu.

In the Task configuration window you can edit the task execution period.

B Tasks configuration x
1] Name Type Set period Period {ms) Description
Fast Cyclic No 10 Fasttask
Slow Cyclic No 20 Slow task
Background Cyclic No Background task
Boot Single No ] Boot task
Init Single Mo ) Inittask

WMo

oK Cancel

5.4 DERIVED DATA TYPES

The derived data type is a complex classification that identifies one or various data types
and is made up of primitive data types.

User has the flexibility to create those own types that have advanced properties and uses
far beyond those of the basic primitive data types.

In order to create a new data type you have to select the root element of the pro-
ject tree, then you can either open the context menu and choose the appropriate
voice from Add > New definition = , or you can choose the appropriate voice from
Project > New Object > New definition

In both cases you will have to choose from six different derived data types, which will be
described in the following paragraphs

5.4.1 TYPEDEFS

5.4.1.1 CREATING A NEW TYPEDEF

In order to create a Typedef select Typedef voice when creating a new definition.

PLC IDE will show you a dialog box where you must specify the name of the new typedef
and select the type you are defining an alias for:

(O 0]
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It New Typedef X

Mame
Type Init, Value
Array Mo v | Title
Description A

v

£ >
0K Cancel

(if you want to define an alias for an array type, you shall choose the array size).
Enter a meaningful description (optional) and confirm the operation.

5.4.1.2 EDITING A TYPEDEF

In order to edit an existing typedef you have to double-click it from the Project tree. The
associated editor opens and lets you modify its definition.

project | Name Type frsy | mvake Descrpton

= @ PriDoc Project 1 |UINTB_T USINT No Alias for usint

UINTE_T
Function blocks
Functions

5.4.1.3 OTHER ACTIONS FOR TYPEDEFS

If you open the context menu of a Typedef, by selecting it from the project tree and right-
clicking it, you will see different actions that can be done with Typedefs:

Deleting a Typedef:
In order to delete a Typedef, select it from the Project tree then choose the Delete
voice of the context menu.

Duplicating a Typedef:
In order to duplicate a Typedef, select it from the Project tree then choose the Duplicate
voice of the context menu.

A window will appear asking you a new name for the duplicated Typedef.

Refactoring a Typedef:

Refactoring will allow you to change the name of a Typedef and consequently adjust all
of its occurrences in the project.

Select the desired typedef from the project tree, then right-click on it and choose the
Refactoring  voice from the context menu.

A window will appear allowing you to insert a new name and showing you all the oc-
currences found for this symbol; if you change the name and press OK, all the shown
occurrences will be modified.

Typedef properties:

In order to edit the properties of a Typedef, select it from the Project tree then choose
Edit properties . A window will open allowing you to insert or modify information such
as version number and description.

To view the properties of a Typedef, select it form the project tree then choose

View properties .
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5.4.2 STRUCTURES

5.4.2.1 CREATING A NEW STRUCTURE

In order to create a structure select Structure voice when creating a new definition.
PLC IDE will show you a dialog box where you must specify the name of the new structure
and a meaningful description, then confirm the operation.

B Mew Structure X
MName Complex]

Title Complex Mumber

Version 1.0.0

Description

Complex Number A

OK. Cancel

5.4.2.2 EDITING A STRUCTURE

In order to edit an existing structure, open it by double-clicking it from the Project tree.
The associated editor opens and lets you modify its definition and fields.

Neme = | e Aray | ntvae
= @l PrjDoc Project A | 1 Re 0 REAL Mo
Definitions.
2 In 1 UINT No
] Comple
[ UINT2_T

5.4.2.3 OTHER ACTIONS FOR STRUCTURES

If you open the context menu of a Structure, by selecting it from the project tree and
right-clicking it, you will see different actions that can be done with Structures:

Deleting a Structure:
In order to delete a Structure, select it from the Project tree then choose the Delete
voice of the context menu.

Duplicating a Structure:
In order to duplicate a Structure, select it from the Project tree then choose the
Duplicate voice of the context menu.

A window will appear asking you a new name for the duplicated Structure.

Refactoring a Structure:

Refactoring will allow you to change the name of a Structure and consequently adjust all
of its occurrences in the project.

Select the desired Structure from the project tree, then right-click on it and choose the
Refactoring  voice from the context menu.

A window will appear allowing you to insert a new name and showing you all the oc-
currences found for this symbol; if you change the name and press OK, all the shown
occurrences will be modified.

Structure properties:
In order to edit the properties of a Structure, select it from the Project tree then choose
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Edit properties . A window will open allowing you to insert or modify information such
as version number and description.

To view the properties of a Structure, select it form the project tree then choose

View properties .

5.4.3 ENUMERATIONS

5.4.3.1 CREATING A NEW ENUMERATION

In order to create a new Enumerations select Enumeration  voice when creating a new
definition.

PLC IDE will show you a dialog box where you must specify the name of the new enumera-
tion and a meaningful description, then confirm the operation.

New Enumeration X
Mame

Title

Description

v
< >

OK Cancel

5.4.3.2 EDITING AN ENUMERATION

In order to edit an existing structure, open it by double-clicking it from the Project tree.
The associated editor opens and lets you modify its definition and the initialization values
of its elements.

Neme |tk Desorpon
= [l PriDoc Project 1 | Methane 1
Definitions 7 |Butane 4
4 [za] ComplexNumber
3 |Octane g
E2 HYDROCARBON|
UINTE_T

5.4.3.3 OTHER ACTIONS FOR ENUMERATIONS

If you open the context menu of an enumeration, by selecting it from the project tree and
right-clicking it, you will see different actions that can be done with enumerations:

Deleting an Enumeration:
In order to delete an enumeration, select it from the Project tree then choose the
Delete voice of the context menu.

Duplicating an Enumeration:
In order to duplicate an enumeration, select it from the Project tree then choose the
Duplicate voice of the context menu.

A window will appear asking you a new name for the duplicated enumeration.

Refactoring an Enumeration:

Refactoring will allow you to change the name of an enumeration and consequently ad-
just all of its occurrences in the project.

Select the desired enumeration from the project tree, then right-click on it and choose
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the Refactoring  voice from the context menu.

A window will appear allowing you to insert a new name and showing you all the oc-
currences found for this symbol; if you change the name and press OK, all the shown
occurrences will be modified.

Enumeration properties:

In order to edit the properties of an enumeration, select it from the Project tree then
choose Edit properties . A window will open allowing you to insert or modify information
such as name, title, type, version number and description.

To view the properties of an enumeration, select it form the project tree then choose
View properties .

5.4.4 SUBRANGES

5.4.4.1 CREATING A NEW SUBRANGE

In order to create a new subrange select Subrange voice when creating a new definition.

PLC IDE will show you a dialog box where you must specify the name of the new sub-
range, select its basic type and enter the minimum and the maximum values for the
subrage; optionally you can enter a meaningful description.

LIS New Subrange X
Mame WATER._TEMPERATURE
Type SINT . Title Water Temperature
Min. Value -10 Max. Yalue 100
Description Allowed water temperature| A
v
< >
oK Cancel

5.4.4.2 EDITING A SUBRANGE

In order to edit an existing subrange, open it by double-clicking it from the Project tree.
The associated editor opens and lets you modify its definition.

Hae Tee | o = Desorpin
= f&) PyDocProject 1 |WATER_TEMPERATURE SINT -10 100 Allowed water temperature
Definitions
# [7a) ComplexNumber
g HVDROCAREON
UINTE T

5.4.4.3 OTHER ACTIONS FOR SUBRANGE

If you open the context menu of a subrange, by selecting it from the project tree and

right-clicking it, you will see different actions that can be done with subranges:
.
PLC
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Deleting a Subrange:
In order to delete a subrange, select it from the Project tree then choose the Delete
voice of the context menu.

Duplicating a Subrange:
In order to duplicate a subrange, select it from the Project tree then choose the
Duplicate voice of the context menu.

A window will appear asking you a new name for the duplicated subrange.

Refactoring a Subrange:

Refactoring will allow you to change the name of a subrange and consequently adjust all
of its occurrences in the project.

Select the desired subrange from the project tree, then right-click on it and choose the
Refactoring  voice from the context menu.

A window will appear allowing you to insert a new name and showing you all the oc-
currences found for this symbol; if you change the name and press OK, all the shown
occurrences will be modified.

Subrange properties:

In order to edit the properties of a subrange, select it from the Project tree then choose
Edit properties . A window will open allowing you to insert or modify information such
as version number and description.

To view the properties of a subrange, select it form the project tree then choose

View properties .

5.4.5 MACROS

5.4.5.1 CREATING A NEW MACRO

In order to create a new macro select Macro voice when creating a new definition.

PLC IDE will show you a dialog box where you must specify the name of the new macro
and its language, only IL and ST are allowed (see chapter 11.7.1 for further details).

MNew macro X

Mame
ADD_TOLERAMCE

Language
I ® 5T
OK Cancel

5.4.5.2 EDITING A MACRO

In order to edit an existing macro, open it by double-clicking it from the Project tree. The
associated editor opens and lets you modify its definition, the parameters and its code.
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Project i Par name Description
= [ PrjDoc Project 1 |rh_tol Humidity sensor tolerance
= Definitions 2 |rh Humidity sensor value
LN /DD TOLERANCE

+- [Fa] ComplexNumber
=7 HYDROCARBOMN
UINTS_T
WATER_TEMPERATURE

+ Function blocks rh + ((rh * rh_tol) ~ 1003:]
+ Functions

5.4.5.3 OTHER ACTIONS FOR MACROS

If you open the context menu of a macro, by selecting it from the project tree and right-
clicking it, you will see different actions that can be done with macros:

Deleting a macro:
In order to delete a macro, select it from the Project tree then choose the Delete voice
of the context menu.

Duplicating a macro:
In order to duplicate a macro, select it from the Project tree then choose the  Duplicate
voice of the context menu.

A window will appear asking you a new name for the duplicated macro.

Refactoring a macro:

Refactoring will allow you to change the name of a macro and consequently adjust all of
its occurrences in the project.

Select the desired macro from the project tree, then right-click on it and choose the
Refactoring  voice from the context menu.

A window will appear allowing you to insert a new name and showing you all the oc-
currences found for this symbol; if you change the name and press OK, all the shown
occurrences will be modified.

Macro properties:

In order to edit the properties of a macro, select it from the Project tree then choose
Edit properties . A window will open allowing you to insert or modify information such
as version number and description.

To view the properties of a macro, select it form the project tree then choose

View properties .

5.4.6 INTERFACES

5.4.6.1 CREATING A NEW INTERFACE

In order to create a new interface select Interface voice when creating a new definition;
note that interfaces can be created only if Object Oriented Programming is enabled (see
paragraph 4.6.1), and that depends on target implementation.

PLC IDE will show you a dialog box where you must specify the name of the new macro
and its language, only IL and ST are allowed (see chapter 11.7.1 for further details).
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e MNew Interface X
MName |

Description

OK Cancel

5.4.6.2 EDITING AN INTRFACE

Interfaces cannot be edited, but you can add method to an interface and edit the method.
To add a new method, open the context menu of the interface, by selecting it in the Pro-
ject tree and right-clicking on it, then choose Add method prototype ; a window will appear
asking you to insert name and description of the method prototype.

The method prototype will be added to the Project tree; now double-clicking it will open
its editor, allowing you to modify the method prototype.

Class Pin Name Type Ay Description
= [ testOO Project 1 |RESULT IMyMethod BOOL Mo Method result
= Definitions 2 VAR_INPUT 0 In_1 UINT No

= +0 MY_INTERFACE

PS) My Method 3 |VAR_INPUT 1 In_2 INT Mo
o

5.4.6.3 OTHER ACTIONS FOR INTERFACES

If you open the context menu of an interface, by selecting it from the project tree and
right-clicking it, you will see different actions that can be done with interfaces; same
things can be done with the method prototypes in the same way

Deleting an interface or a method prototype:
In order to delete the element, select it from the Project tree then choose the Delete
voice of the context menu.

Duplicating an interface or a method prototype:
In order to duplicate the element, select it from the Project tree then choose the
Duplicate voice of the context menu.

A window will appear asking you a new name for the duplicated element.

Refactoring an interface or a method prototype:

Refactoring will allow you to change the name of the element and consequently adjust
all of its occurrences in the project.

Select the desired element from the project tree, then right-click on it and choose the
Refactoring  voice from the context menu.

A window will appear allowing you to insert a new name and showing you all the oc-
currences found for this symbol; if you change the name and press OK, all the shown
occurrences will be modified.

Interface and method prototype properties:

In order to edit the properties of an element, select it from the Project tree then choose
Edit properties . A window will open allowing you to insert or modify information such
as version number and description.

To view the properties of an element, select it form the project tree then choose

View properties .
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5.5 BROWSE THE PROJECT

Projects may grow huge, hence PLC IDE provides two tools to search for an object within
a project: the Object browser and the Find in project feature.

5.5.1 OBJECT BROWSER

PLC IDE provides a useful tool for browsing the objects of your project: the Object

Browser.
ki Object browser x
Objects fiter r
Name Type -
Programs I alarm_ack Functions =
Function Blocks Interfaces =7 ALARM_ACK_TYPE User Types
Functions & Alarm_GetAckType Functions
e & Alarm_GetGroup Functions
et s & alarm_GetLabel Functions
& alarm_cetLevel Functions
Chedk al Chedk none & alarm_GetTime Functions
& alarm_tswaitingForack Functions
£ ALARM_LOG_EVENT User Types
Other filters o2 ALARM_LOG_QUERY_HND User Types
e = oK o2 ALARM_LOG_QUERY_RESULT... User Types
o2l ALARM_QUERY_HND User Types
Location |,q|| -| ol ALARM_QUERY_RESULT_HND  User Types
& AlarmGroup_Getiabel Functions
Library | Al T & AlarmlogQuery_FilterByAlarm  Functions
ety |AII—V & AlarmlogQuery_FilterByGroup  Functions
ﬁ' AlarmLogQuery_Query Functions
Vars group | = | & AlarmLogQuery_Release Functions
& AlarmLogQueryResult_Current  Functions Y]
| < m >
Close Selectal Select none

This tool is context dependent, this implies that the kind of objects that can be selected
and that the available operations on the objects in the different contexts are not the same.

Object browser can be opened in these three main ways:
- Browser mode.

- Import object mode.

- Select object mode.

User interaction with Object browser is mainly the same for all the three modes and is
described in the next paragraph.

5.5.1.1 COMMON FEATURES AND USAGE OF OBJECT BROWSER

This section describes the features and the usage of the Object browser that are common
to every mode in which Object browser can be used.

Objects filter

Objects filter

Programs

Function Blocks Interfaces
Functions

Variables

User types

Check all Check none

This is the main filter of the Object browser. User can check one of the available (enabled)
object items.

In this example, Programs, Function Blocks, Functions are selected, so objects of this
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type are shown in the object list. Variables and User types objects can be selected by user
but objects of that type are not currently shown in the object list. Operators, Standard
functions, Local variables, and Basic types cannot be checked by user (because of the
context) so cannot be browsed.

User can also click Check all button to select all available objects at one time or can click
Check none button to deselect all objects at one time.

Other filters

Other filters

Mame 0K

Location | All -
Library | All -l
Vars type |.-'-\II -|

Vars group | * -|

Selected objects can be also filtered by name, symbol location, specific library and var
type.
Filters are all additive and are immediately applied after setting.

Name
Function Filters objects on the base of their name.

Set of legal values | All the strings of characters.

Type a string to display the specific object whose name
matches the string. Use the * wildcard if you want to
display all the objects whose name contains the string in

Use the Name text box. Type * if you want to disable this filter.
Press Enter when edit box is focused or click on the 0K
button near the edit box to apply the filter.

Applies to All object types.
Object browser X
Objects filter r
Name Type
Frograms Fco Function blocks
Function Blocks Interfaces ﬁ CTD_DINT Function blocks
Functions ﬁ CTD_UDINT Function blocks
[¥] variables
User types
Check all Check none
Other filters
Name ctd™ oK
Location |l |
Library !A\I -
Vars type | -
Vars group | = -|

£ m >

Close Select all Select none

Symbol location
Function Filters objects on the base of their location.
Set of legal values | All, Project, Target, Library, Aux. Sources.
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All= Disables this filter.
Project= Objects declared in the PLC IDE project.
Target= Firmware objects.
Use . . . . . -
Library= Objects contained in a library. In this case, use
simultaneously also the Library filter, described below.
Aux sources= Shows aux sources only.
Applies to All objects types.
kit Object browser ®
Objects filter T
MName Type
Programs & GetTime_us Functions
[w]Function Blocks ~ [] Interfaces [THlPLC_Status User Types
Functions I signalTask Functions
Variables lis]sysay variables
s sysDayOf\"a’eek Variables
sysHours Variables
Chedk all S etiennne ﬁ' sysLogWriteMsg Functions
sysMinutEs Variables
sysMUmh Variables
Other filters [l sysPLcstatus Variables
Name = oK EsysPluginsDatﬁRO Variables
ElsysPluginsDataRW Variables
Location |Targel‘ - sysSeconds Variables
; ! Jud| sysTimer Variables
Library | ﬁ' sysTracelog Functions
-l [b]sysUserDataBlock Variables
das s [ [B]sysUserDataBlockRetain Variables
Vars group |= = [ui]sysYear Wariables
| € " > |
Close Selectal Select none
Library
Completes the specification of a query on objects contained
Function in libraries. The value of this control is relevant only if the

Symbol location filter is set to Library.

Set of legal values |All, librarynamel, libraryname2, ...

All= Shows objects contained in whatever library.

Use LibrarynameN= Shows only the objects contained in the
library named librarynameN.
Applies to All objects types.
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i3 Object browser X
Objects filter
Name Type (&
Programs 7 alarm_adk Functions =
Function Blocks Interfaces = ALARM_ACK_TYPE User Types
Functions ﬂ' Alarm_GetAckType Functions
Variables ﬂ' Alarm_GetGroup Functions
[#]User types I alarm_Getiabel Functions
& slarm_GetLevel Functions
Chedk all i rons & Alarm_GetTime Functions
I alarm_tswaitingForack Functions
7 ALARM_LOG_EVENT User Types
Other filters o ALARM_LOG_QUERY_HND User Types
e ry = 2 ALARM_LOG_QUERY_RESLLT... User Types
of ALARM_QUERY_HND User Types
Location | Library - o2 ALARM_QUERY RESULT_HMD  User Types
| & alarmGroup_Getiabel Functions
Library Al = & AlarmLooQuery_FilterByAlarm  Functions
Al : ;
AlarmLogQuery _FilterByGrouy Functions
Vars type | Alarms a oy sy :
COPM I AlarmLogQuery_Query Functions
Vars group I AlarmLogQuery_Release Functions |
E‘Ig:lbus 7 alarmLogQueryResult_Current  Functions v
PLCConnect <] 1 %
Redpes
Standard
Close C D Select all Select none

Vars Type

Filters global variables and system variables (also known

HE as firmware variables) according to their type.

Set of legal values |All, Normal, Constant, Retain

All= Shows all the global and system variables.
Normal= Shows normal global variables only.

Use
Constant= Shows constants only.
Retain= Shows retain variables only.
Applies to Variables.
o Object browser X
Objects filter T —
Name Type 2 |
Programs I slarm_adck Functions =
Function Blocks Interfaces =7 ALARM_ACK_TYPE User Types
Functions & slarm_GetackType Functions
Variables ﬂ' Alarm_GetGroup Functions
i S & alarm_Getiabel Functions
7 alarm_cetievel Functions
Check al Check none 7 alarm_GetTime Functions
& alarm_IsWaitingForack Functions
= ALARM_LOG_EVENT User Types
Other filters o2 ALARM_LOG_QUERY_HND User Types
N = tic 42 ALARM_LOG_QUERY_RESULT... User Types
o2 ALARM_QUERY HMD User Types
Location \AII - o2 ALARM_QUERY RESULT HMD  User Types
: ‘ . & slarmGroup_Getlabel Functions
Library Al bt & alarmLogQuery_FilterByAlarm  Functions
< & alarmLogQuery_FilterByGroup  Functions
ferhes ‘:Honstant ﬂ' AlarmLogQuery_Query Functions
Vars group & AlarmLogQuery_Release Functions
Constant ﬂ' AlarmLogQueryResult_Current  Functions w
Retain < m »
Close Selectall Select none
Vars Group
Function Filters objects on the base of their group.
Set of legal values |Every group known to the project
Use Shows only variables belonging to the selected group.
Applies to Variables.
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L3 Object browser X
Objects filter r
Mame Type
[Jprograms [==] sysCOPMEmergencyEvent Variables
[“IFunction Blocks [ | Interfaces & sysCOPMEventlD Variables
[ Functions [T8l sysCOPMMasterStatus Variables
Varishlcs [SElsysCOPMNodestatus Variables
[l e @sysCOPMNodeStab.lsChanged. .. Variables
@sysCOPMPDOErrEVEnt Variables
Checkal Chicecks rines @sysCOPMResyndnfU Variables
[==] sysCOPMSDOFailEvent Variables
[F3]sysCOPMSDOSchedulingDiagno  Variables
Other filters
Name e oK
Location | Al -l
Library IAII -
Vars type |.-'-\II -l
Vars group ICANOpen_Masher M
| < it > |
Counters e e — =}
Global_status
Close fnltl?nlgravr:riables Select all Select none
Modbus:RTU_Masher
Modbus_TCP_Master
PLCConnectVariables
Plugins_data_allocation
System_Timers
Time_and_date
Heer dat blacks
Object list
MName Type
[F&]syscoOPMEmergencyEvent Variables
1 sysCOPMEventD Variables
@sysCOPMMasherStatus Variables
[F=lsyscoPMNodestatus Variables
[FalsysCOPMNodeStatusChanged. . Variables
ElsysCOPMPDOErrEVent Variables
[E=]syscoPMResyncInfo Variables
[F=]syscoOPMSDOFaiEvent Variables
ElsysCOPMSDosmedUI\ngDiagnD Variables
< [T} >

Object list shows all the filtered objects. List can be ordered in ascending or descending
way by clicking on the header of the column. So it is possible to order items by Name,
Type, or Description.

Double-clicking on an item allows the user to perform the default associated operation
(the action is the same of the OK, Import object, or Open source button actions).

When item multiselection is allowed, Select all and Select none buttons are visible.

It is possible to select all objects by clicking on Select all button. Select none deselects
all objects.

If at least one item is selected on the list operation, buttons are enabled.
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Object browser X

Objects filter

Name Type

m >

Programs
Function Blocks Interfaces [ ALARM_ACK_TYPE
Functions E 7 jAlarm_GetaddType
Variables - [Alarm_GetGroup
User types b F | Alarm_Gett abel
ErJAlarm_Getievel

Check all ek T E F | Alarm_GetTime
b= Alarm_1sWaitingFarAck

Other filters EE] ALARM LOG QUERY_ HMND
BE] 2 arm 1 0G_quUERY_RESLLT. ..
el ALARM_QUERY_HMND
Location  [al -| BEl oL rpM_QUERY_RESULT_HND
f F |AlarmGroup. GetLabel
E F | AlarmLogQuery_FilterByaAlarm
Varstype |Al <l f | AlarmLogQuery. FilterByGroup
- E - | AlarmLogQuery_Query
Vars group | CANOpen_Master -| E - [AlarmLogQuery_Release
f | AlarmLogQueryResult_Current s w
< m >

Name = | OK

Library All ~|

Close Export to library Delete objects Open source Select all Select none

Resize

Window can be resized, the cursor changes along the border of the dialog and allows the
user to resize window. When reopened, Object browser dialog takes the same size and
position of the previous usage.

5.5.1.2 USING OBJECT BROWSER AS A BROWSER

© .0
PLC

In order to use the object browser to simply look over through the element of the project
choose the appropriate voice of the menu #Project > Object Browser .

Available objects
In this mode you can list objects of these types:

Programs.
Function Blocks.

- Functions.
Variables.
User types.

These items can be checked or unchecked in Objects filter section to show or to hide the
objects of the chosen type in the list.

Other types of objects (Operators, Standard functions, Local variables, Basic types) can-
not be browsed in this context so they are unchecked and disabled).

Available operations
Allowed operations in this mode are:

Open source, default operation for double-click on an item
Opens the editor by which the selected object was created

AGXE O and displays the relevant source code.
If the object is a program, or a function, or a function
block, this button opens the relevant source code editor.
Use If the object is a variable, then this button opens the

variable editor.

Select the object whose editor you want to open, then click
on the Open source button.

Export to library
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Function Exports an object to a library.

Select the objects you want to export, then press the
Export to library button.

Use

Delete objects
Function Allows you to delete an object.

Select the object you want to delete, then press the Delete
object button.

Use

Multi selection
Multi selection is allowed for this mode, Select all and Select none buttons are visible.

5.5.1.3 USING OBJECT BROWSER FOR IMPORT

Object browser is also used to support objects importation in the project from a desired
external library.

In order to use the object browser to import external library to the project, select
Project>Import object , then an explorer dialog will be prompted to allow you to choose
the source library; once selected a library, an Object Borwser Window will appear, allowing
you to select the objects you wish to import.

i Object browser x
Objects filter
Name Type
Programs & 7_add Programs
Function Blocks Interfaces @ T_add_REAL_01 Programs
Functions @ T_add_REAL_02 Programs
Variablss "@ T_addM_UDINT Programs
User types "B T_addM_UINT Programs
@ T_addM_USINT Programs
Check al e [ T_addsubm_DINT_01 Programs
@ T_addsubM_DINT 02 Programs
"B 1_addsubM_INT Programs
Other filters [ T_addsubm_REAL Programs
Name * ok “Hl 7_sub Programs
@ 7_sub_REAL_01 Programs
Location | [ @ T_sub_REAL_02 Programs
} - @ 7_subM_UDINT Programs |
i | s o |
Nerhee | Al ] T 7_subM_UsINT Programs |
ars group |
< 1] >
Close Import objects Select all Select none

Available objects

In this mode you can list objects of these types:
- Programs.

Function blocks.

Functions.

Variables.

User types.
These items can be checked or unchecked in Objects filter section to show or to hide the

objects of the chosen type in the list.
.
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Other types of objects (Operators, Standard functions, Local variables, Basic types) can-
not be imported so they are unchecked and disabled.

Available operations

Import objects is the only operation supported in this mode. It is possible to import se-
lected objects by clicking on Import objects button or by double-clicking on one of the
objects in the list.

Multi selection

Multi selection is allowed for this mode, Select all and Select none buttons are visible.

5.5.1.4 USING OBJECT BROWSER FOR OBJECT SELECTION

Object browser dialog is useful for many operations that requires the selection of a single
PLC object. So Object browser can be used to select the program to add to a task, to se-
lect the type of a variable, to select an item to find in the project, etc..

Available objects

Available objects are strictly dependent on the context, for example in the program as-
signment to a task operation the only available objects are programs objects.

It is possible that not all available objects are selected by default.

Available operations

In this mode it is possible to select a single object by double-clicking on the list or by click-
ing on the OK button, then the dialog is automatically closed.

Multi selection

Multi selection is not allowed for this mode, Select all and Select none buttons are not
visible.

5.5.2 SEARCH WITH THE FIND IN PROJECT COMMAND

The Find in project command retrieves all the instances of a specified character string in
the project.

In order to use this functionality choose the appropriate voice of the menu
& Edit > Find in project .

PLC IDE will show you the following dialog box:

Find in project X
Find what: | [alarm_Ack] ~ Wl Find & dose
Location: | All v hod
Cancel
Object type filters
Programs [IFunctions  [¥] Macros [¥] varizbles
Function blocks Methods User Types

Find options
[v]Find in description [ I Match whole word only

Find in types [ IMatch case

Use Regular Expressions

1) In the Find what text box, type the name of the object you want to search.

Otherwise, click the Browse button to the right of the text box, and select the name
of the object from the list of all the existing items.

2) Select one of the values listed in the Location combo box, so as to specify a constraint

(©.C)
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on the location of the objects to be inspected.

Find in project X
Find what: ‘ Alarm_Adk -~ Find & dose
Location: ‘ Al - T
Al
Lt
Target
Library
) Aux. Sources
Object tyF pous list
[]Programs Functions  [v|Macros [ Variahles
Function blocks Methods User Types

Find options
||Find in deseription || Match whole word only

Find in types [Imatch case

Use Regular Expressions

3) The frame named Object type contains a set of checkboxes, each of which, if ticked,
enables research of the string among the object it refers to.

4) The frame named Find options contains a set of checkboxes, each of which, if ticked,

modify the way the research is done. For example, check Match case if you want your
research to be case-sensitive.

5) Press Find (or Find & close) to start the search, otherwise click Cancel to abandon.

The results will be printed in the Find in project tab of the Output window.
Searching for 'Alarm Ack'

syshlarm_AddBooleanFlaghlarm{LV) — ack : ALARM ACE TYPE
Alarm_Ack{0) - Alarm_Ack

2 occurrence(s) have been found.

Build Find in project Debug Resources

5.5.3 FIND SYMBOLS WITH THE SYMBOLS BROWSER WINDOW

A quick and efficient way to search for symbols in the project is the symbol browser. Go

to View > Tool windows > Symbols browser to open (or close) the corresponding docking
window.

The symbols browser allows the user to easily specify some filters (based on the object
type and the research location) and shows all the symbols that match (even partially) the
specified name, with relative information.

(O 0]
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Symbols browser

Location

Project
Project

Symbol name: iy Filters = Active filters: All
MName Type

ﬁ miyfh FUNCTIOM BLOCK

& myFunction FUNCTION

= rmyEnum EMUM

Project

5.6 WORKING WITH PLC IDE EXTENSIONS

PLC IDE’'s Workspace window may include a section whose contents completely depend
on the target device the IDE is interfacing with: the Resources panel.

If the Resources panel is visible, you can access some additional features related to the
target device (configuration elements, schemes, wizards, and so on).

- [ Configuration
- @@ ArduinoPMC

= H

ublic objects

=| Parameters
= e
- B& Local IO Mapping
E= Digital Inputs
E& Digital Outputs
B2 Analog Inputs
E& Analog Outputs

BS Programmable Digital /0

B Temperature probes
%, RS483 SerialPort
W Ethernet
AN CAMNopen CAND
= #} Shared variables
# Inputs
# Outputs
(¢ Sketch

Information about these features may be found in a separate document: refer to your

hardware supplier for details.

5.7 PROJECT CUSTOM WORKSPACE

The custom workspace functionalities allow you to organize your project tree according to
your needs, in order to obtain more efficiency in the management of the project.

All organizations units of the custom workspace are logical: creating and editing those

units will no triggers any effects on the PLC code.

(©.C)
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= @] PriDoc Project
+ Definitions
Function blocks
Functions
[EF RotateBit
Global variables
Programs
FEP Init
itP LadderLogic
P Loops
» o
+ - BEP PidControl
FoP PidModeSelector
+ - @@ Parameters
= B Tasks
= 4 Fast
*E PidControl
“E PidModeSelector
T myprog
Slow
*Il Loops
Background
*E Ladderlogic
Boot
Init

I Init

S 4

Rt S

B Project Resources

5.7.1 ENABLE THE CUSTOM WORKSPACE INTO AN EXISTING
PROJECT

To enable this feature see the Project>Options... (see Paragraph 4.6.1), once enabled the
project needs to be reloaded.

By default this features is enabled depending on targets.

5.7.2 WORKSPACES MIGRATION

Whenever this feature is switched, PLC IDE tries to reorder the workspace maintaining the
user customization by this logic:
Static (old) workspace to custom (new)

Fixed logic units (Ex. Function blocks folder) are converted into new dynamic folders with
the same names. Fixed global group units (Ex. Mapped variables) are converted into new
global dynamic groups with the same names. All global variables that do not belong to any
group will be grouped into a new group called Ungrouped global vars.

Custom (new) workspace to static (old)

All custom units will be destroyed and all POUs and global variables will be grouped into
the default fixed units (Ex. Function blocks folder and Mapped Variables).

5.7.3 CUSTOM WORKSPACE BASIC UNITS

In the new custom workspace you can work using two different main logic units:

- Folder: this is an optional logical unit that can contain POUs, folders (you can nest fold-
ers into another one) and global variables group.

- Global variables group: this logical unit can only contain global variables. In order to
create a global variable you need to have at least one global variables group defined

into your custom workspace.
(00
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)

5.7.4 CUSTOM WORKSPACE OPERATIONS

Different useful operations can be performed in order to give a better organization of your
project.

Creating a folder

In order to create a folder select the root item of the project tree or, if you want to nest
it, an existing folder then choose the [Add>New folder] voice of the context menu.

This operation adds a new customizable folder (by default named New folder) unit ready
to be renamed.

Editing folder properties - Set folder as read-only

You can edit the folder properties choosing Edit folder properties from its context menu.
Once inside the folder properties window, you can choose to mark the folder as read
only; doing so you’ll be asked to set a password. The content of the folder is now not
modifiable until someone remove the read only attribute by inserting the correct pass-
word.

Editing folder properties - Set folder as a library folder

Still from the folder properties window, you can mark the folder as a library folder
(select Enable from the Library generation options  section). Doing so you’ll be allowed
to set other informations about the library folder (like the version humber or a descrip-
tion).

If your folder is a library folder, it'll be represented with a different icon in the tree:

=

In the context menu of the folder, now, you’ll find a new voice: Generate library ; select-
ing it will create a new .plcprj library in the project folder (inside AutoGeneratedLibraries
sub folder) with the name of the library folder and all of its content.

This is an easy and efficient way to create complex libraries.

Creating a Global variables Group

In order to create a global variables group select the root item of the project tree or an ex-
isting folder then choose the [Add>New global variables group] voice of the context menu.

This operation adds a new customizable folder (by default named New_var_groupl) unit
ready to be renamed.
Rename a unit (folder or Global variables group)

In order to rename a global variables group or a folder select it than choose [Rename]
voice of the context menu.

This operations makes the name of the unit ready to be renamed.

Deleting a unit (folder or Global variables group)

In order to delete a global variables group or a folder select it than choose [Delete] voice
of the context menu.

If the units contains any child you will be prompted for three possibilities:

1) Delete all child elements too (this may impact the PLC).

2) Do not delete child elements, they will be moved upwards following the project tree.
3) Cancel the operations and do nothing.

Deleting multiple objects

(©.C)
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Delete operation can be done on multiple homogeneus objects (more than one folders,
mor than one POUs...); select the elements keeping pressed CTRL button, then press DEL.
Export objects to library

In order to export all elements of a global variables group or a folder, select it than choose
[Export objects to library] voice of the context menu.

This operation allows you to export recursively all child elements of the selected item into
a library (see 4.8.2 for more information about new library).
Export objects as PLCopen

PLC IDE allows you to export all elements of a global variables group or a folder in PLCo-
pen format. Like Export to library you can export the selected elements to an existing .xml
file or to a new .xml file (in the latter case the file will be created), the PLCopen format
will be maintained.

This operation allows you to export recursively all child elements of the selected item into
a PLCopen file.
Moving Unit

You can simply drag&drop units to a different location of the tree in order to organize
your project workspace. All children are moved if the parent item is moved, following the
original structure.

Moving variables is also possible both from project tree (single selection) and from the
variable grid (single and multiple selections) (see Paragraph 6.6 for more information
about variables editor).

Sorting folder

It is possible to manually sort the folder order to better organize the project tree (by
default folder are sorted alphabetically). To do so you have to enable the Custom sort of
project folder, in the project options; then, from the context menu of a folder, you can
choose Move Up or Move Down to move the folder.

5.7.5 WORKSPACE ELEMENTS WITH LIMITATIONS

Some elements of the workspace are fixed and not customizable. They are automatically
generated by PLC IDE and no special custom operations are allowed on.

Root Project Element

You can not move, rename or delete this element. It can contain customizable units as
children.

POUs Children Elements

These elements are generated following the structure of the POU they belong to. You can
not move, rename or delete these elements directly from the tree. For more information
about POUs (see Paragraph 5.1).

SFC Children Elements

These elements follow the aforesaid rules but especially for the SFC children nodes the
rename or delete operations are not allowed also on the POUs that belong to Actions or
Transitions elements. For more information about SFC language (see Paragraph 6.5).
Tasks Element

You can not move, rename or delete these elements. They are automatically generated by

PLC IDE. For more information about SFC language (see Paragraph 5.3).
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6. EDITING THE SOURCE CODE

PLC editors

PLC IDE includes five source code editors, which support the whole range of IEC 61131-
3 programming languages: Instruction List (IL), Structured Text (ST), Ladder Diagram
(LD), Function Block Diagram (FBD), and Sequential Function Chart (SFC).

Moreover, PLC IDE includes a grid-like editor to support the user in the definition of local
variables.

All editors, both graphical and text one, support tooltips. By enabling them (see Paragraph
), PLC IDE will show some information about symbols on which the user move the mouse.

This chapter focuses on all these editors.

6.1 INSTRUCTION LIST (IL) EDITOR

LD
ADD
ST

LD
ADD
ST

LD
ADD
ST

00 o o

e

The IL editor allows you to code and modify POUs using IL (Instruction List), one of the
IEC-compliant languages.

6.1.1 EDITING FUNCTIONS

The IL editor is endowed with functions common to most editors running on a Windows
platform, namely:

- Text selection.

- ¥ Edit>Cut .

- @ Edit>Copy .

- o Edit>Paste .

- Edit>Replace .

- Drag-and-drop of selected text.

6.1.2 REFERENCE TO PLC OBJECTS

If you need to add to your IL code a reference to an existing PLC object, you have two

options:

- You can type directly the name of the PLC object.

- You can drag it to a suitable location. For example, global variables can be taken from
the Workspace window, whereas standard operators and embedded functions can be
dragged from the Libraries window, whereas local variables can be selected from the
local variables editor.

(O 0]
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6.1.3 AUTOMATIC ERROR LOCATION

The IL editor also automatically displays the location of compiler errors. To know where a
compiler error occurred, double-click the corresponding error line in the Output bar.

6.1.4 BOOKMARKS

You can set bookmarks to mark frequently accessed lines in your source file. Once a book-
mark is set, you can use a keyboard command to move to it. You can remove a bookmark
when you no longer need it.

6.1.4.1 SETTING A BOOKMARK

Move the insertion point to the line where you want to set a bookmark, then press Ctr/+F2.
The line is marked in the margin by a light-blue circle.

O

6.1.4.2 JUMPING TO A BOOKMARK

Press F2 repeatedly, until you reach the desired line

6.1.4.3 REMOVING A BOOKMARK

Move the cursor to anywhere on the line containing the bookmark, then press Ctr/+ F2.

6.2 STRUCTURED TEXT (ST) EDITOR

v .= SIN(=).
E = x + incr|
loopsValue = 0;
for 1 := 0 to 15 dao
bit := (v + 0.9) » (0.125 = TO_REAL{i)):
if bit then
loopsValue = loopsValus or RotateBit(i):
end_if:
end_for:

The ST editor allows you to code and modify POUs using ST (i.e. Structured Text), one of
the IEC-compliant languages.

6.2.1 CREATING AND EDITING ST OBJECTS

See the Creating and Editing POUs section (see Paragraphs 5.1.1 and 5.1.2).

6.2.2 EDITING FUNCTIONS

The ST editor is endowed with functions common to most editors running on a Windows
platform, namely:

(©.C)
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Text selection.

% Edit>Cut .

- @ Edit>Copy

- o Edit>Paste .

- Edit>Replace .

Drag-and-drop of selected text.

6.2.3 REFERENCE TO PLC OBJECTS

If you need to add to your ST code a reference to an existing PLC object, you
have two options:

- You can type directly the name of the PLC object.

- You can drag it to a suitable location. For example, global variables can be taken from
the Workspace window, whereas embedded functions can be dragged from the Libraries
window, whereas local variables can be selected from the local variables editor.

6.2.4 AUTOMATIC ERROR LOCATION

The ST editor also automatically displays the location of compiler errors. To know where a
compiler error has occurred, double-click the corresponding error line in the Output bar.

6.2.5 BOOKMARKS
You can set bookmarks to mark frequently accessed lines in your source file. Once a book-
mark is set, you can use a keyboard command to move to it. You can remove a bookmark
when you no longer need it.

6.2.5.1 SETTING A BOOKMARK

Move the insertion point to the line where you want to set a bookmark, then press Ctr/+F2.
The line is marked in the margin by a light-blue circle.

@

6.2.5.2 JUMPING TO A BOOKMARK

Press F2 repeatedly, until you reach the desired line.

6.2.5.3 REMOVING A BOOKMARK

Move the cursor to anywhere on the line containing the bookmark, then press Ctr/+F2.
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6.3 LADDER DIAGRAM (LD) EDITOR
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The LD editor allows you to code and modify POUs using LD (i.e. Ladder Diagram), one of
the IEC-compliant languages.

6.3.1 CREATING A NEW LD DOCUMENT

See the Creating and Editing POUs section (see Paragraphs 5.1.1 and 5.1.2).

6.3.2 ADDING/REMOVING NETWORKS

Each POU coded in LD consists of a sequence of networks. A network is defined as a
maximal set of interconnected graphic elements. The upper and lower bounds of every
network are fixed by two straight lines, while each network is delimited on the left by a
grey raised button containing the network number.

On each LD network the right and the left power rail are represented, according to the LD
language indication.

On the new LD network a horizontal line links the two power rails. It is called the “power
link”. On this link, all the LD elements (contacts, coils and blocks) have to be placed.

You can perform the following operations on networks:

- To add a new blank network, click Scheme>Network>New , or press one of the equivalent
buttons in the Network toolbar.

- To assign a label to a selected network, give the Scheme>Network>Label . This enables
jumping to the labeled network.

- To display a background grid which helps you to align objects, click @ View>Grid .
- To add a comment, click © Scheme>Object>New>Comment

0.0
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ARDUINO PLC IDE

You can modify the usual order of execution of networks through a jump statement, which
transfers the program control to a labeled network. To assign a label to a network, double-
click the raised grey button on the left, which bears the network number.

This causes a dialog box to appear, where you can type the label you want to associate

with the selected network.

1l

o New network label 7

Network label x

oK Cancel

If you press 0K, the label is printed in the top left-hand corner of the selected network.

Label_0:

7
|

6.3.4 INSERTING CONTACTS

To insert new contacts on the network apply one of the following options:

- Select a contact, a block, a pin of block, or a connection point, that will act as the in-
sertion point. Insert the new contact choosing between the connection type (serial or
parallel) and choosing the position (before or after the currently selected object) by
using the Sheme>O0bject>New . For serial insertion, the new contact will be inserted on
the left or right side of the selected contact/block or in the middle of the selected con-
nection depending on the element selected before the insertion. For parallel insertions,
several contacts can be selected before performing the insertion; the new contact will
be inserted above or below the group of selected contacts.

ooo1

cnl =1

— j’ —
cnZ

_{

0001

=] cnl

ooo1

e B

iF

ooo1

]

- Drag a boolean variable to the desired place over an object. For example, global vari-
ables can be taken from the Workspace window, whereas local variables can be selected
from the local variables editor. Contacts inserted with drag and drop will always be in-
serted in series after the destination object.

Arduino PLC IDE user manual
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6.3.5 INSERTING COILS

To insert new coils on the network apply one of the following options:

- Click {} Scheme>Object>New>Coil . The new coil will be inserted and linked to the right
power rail. If other coils, return or jumps are already present in the network, the new
coil will be added in parallel with the previous ones.

- Drag a boolean variable on the network, over an existing output of the network (coil,
return, jump). For example, global variables can be taken from the Workspace window,
whereas local variables can be selected from the local variables editor.

6.3.6 INSERTING BLOCKS

To insert blocks on the network apply one of the following options:

- Select a contact, connection or block then click #® Scheme>Object>New>Block , which
causes a dialog box to appear listing all the objects of the project, then choose one
item from the list.

- Drag the selected object (from the Workspace window, the Libraries window or the local
variables editor) over the desired connection.

If the object has at least one BOOL input and one BOOL output pins, they will be con-
nected to the power link (and it will possible to add EN/ENO pins later with the provided
command); otherwise the EN/ENO pins will be automatically added.

Operators, functions and function blocks can only be inserted into an LD network on the
main power link, or on the power link of a branch (so they can not be inserted on the par-
allel of a contact); it is also not possible to create a contact in parallel of a block.

If a block has a BOOL input pin, it is possible to create another logical sub-network of
contacts and blocks before it; otherwise, you can connect only variables, constants or
expressions (that nevertheless can be connected to BOOL pins) to non-BOOL input pins.

6.3.7 EDITING COILS AND CONTACTS PROPERTIES

The type of a contact (normal, negated, positive, negative) or a coil (nhormal, negated,
set, reset, positive, negative) can be changed by one of the following operations:

- Double-click on the element (contact or coil).
- Select the element and then press the Enter key.
- Select the element, activate the pop-up menu, then select ®m [Properties] .

An apposite dialog box will appear. Select the desired element type from the presented
list and then press OK.

Otherwise, select the desired contact or coil, and change its type using the six provided
buttons in the LD toolbar or the six commands in the Scheme menu.

6.3.8 EDITING NETWORKS

The LD editor is endowed with functions common to most graphic applications running on
a Windows platform, namely:

- Selection of a block.
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- Selection of a set of adjacent contacts by pressing Ctr/+Left button on each contact to
select; if the selection spans across different parallel branches, more contacts will be
automatically added in the selection.

- ¥ Edit>Cut , o Edit>Copy , = Edit>Paste operations of a single block as well as of a
set of blocks.

- Drag-and-drop of the selected object or group, to move it inside or outside the current
network.

Adding, moving, deleting or copy/pasting objects will automatically recalculate the layout
of the network objects; because of this, it is not possible to manually “draw” connection
lines or freely placing objects without connecting them to the network.

6.3.9 MODIFYING PROPERTIES OF BLOCKS

- Click 1 Scheme>Increment pins , to increment the number of input pins of some opera-
tors and embedded functions.

MUX MUX
K K
o 'l'! o
1 H
2

EN/ENO pins can be removed only if the selected block has at least one BOOL input and
one BOOL output; otherwise, they will be automatically added when creating the block
and it will not be possible to remove them (the Enable EN/ENO pins command will be
disabled).

If a block has more than one BOOL output pin, it is possible to choose which pin will
bring the signal out of the block and so continue the power link: select the desired out-
put pin and click the [F Scheme>Set output line. menu command.

- Click m Scheme>Object>Instance name , to change the name of an instance of a function
block.

6.3.10 GETTING INFORMATION ON A BLOCK

You can always get information on a block that you added to an LD document, by selecting
it and then performing one of the following operations:

- click = Scheme>O0bject>0pen source , to open the source code of a block.

- Click m Scheme>O0bject properties in the menu, to see properties and input/output pins
of the selected block.

6.3.11 AUTOMATIC ERROR RETRIEVAL

The LD editor also automatically displays the location of compiler errors. To reach the
block where a compiler error occurred, double-click the corresponding error line in the

Output bar.
.
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6.3.12 INSERTING VARIABLES

To connect a variable to an input or output pin of a block apply one of the following op-
tions:

- select the pin of a block, and then click the ® Scheme>Object>New>Variable menu com-
mand; then double-click the new variable object (or press ENTER) and enter the variable
name.

- Drag the selected variable (from the Workspace window, the Libraries window or the
local variables editor) over the desired pin of a block.

6.3.13 INSERTING CONSTANTS

To connect a numeric constant to an input pin of block, select the pin and click the
B Scheme>0bject>New>Constant menu command; then double-click the new constant ob-
ject (or press ENTER) and enter the numeric constant value.

6.3.14 INSERTING EXPRESSION

To connect a complex expression to an input pin of block, select the pin and click the
® Scheme>O0bject>New>Expression menu command; then double-click the new expression
object (or press ENTER) and enter any ST expression:

(at+tb) *c
TO_INT (n)

ADR (x)

0005

ADD .
EN END {
+

6.3.15 COMMENTS

It is possible to insert two types of comments:

- networkcomments: activate the network by clicking on the header on the left orinside the
grid (butwithoutselectingany object), andthenclickthe © Scheme>0Object>New>Comment
menu command. The network comment will be displayed at the top of the network, and
if necessary will be expanded to show all the text lines of the comment.

- Object comments: they are activated with the apposite menu command in
View>Show comments for objects ; above any contact, function block or coil the descrip-
tion of the associated PLC variable (if present) will be initially shown, but with the Com-
ment command you can modify it to enter a specific object comment that will override
the PLC variable description.

(©.C)
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ooos This is a network comment,
that can span multiple lines

Comment for timer

Enable flag timer1

Comment for the coil

enablel TON out1
[} N Q { }

6.3.16 BRANCHES

The main power line can be branched to create sub-networks, that can be further branched
themselves: to add a branch, select the object after you want to create the branch and
then click the T Scheme>O0bject>New>Branch menu command.

The start of the new branch is marked as a big dot on the source line; deleting all objects
on a branch deletes the branch itself.

Selecting an object on a branch effectively selects the branch, so for example selecting a
contact on a branch and then clicking the 3 Scheme>0bject>New>Coil adds the coil on the
branch instead of adding it on the main power line.

ooos
cn cnl *
— | L {
¥
.
)
ooos
cn cni x
— | [} {
¥
I
? ?
{
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6.4

FUNCTION BLOCK DIAGRAM (FBD) EDITOR

00

pidFeedback pidOutput ABS LE
[pidSetpoint i = outPid0k
- i~ - J =
- outPidOverflow
[ePidReset
1000.0 int_band
PidKP
pidkD

The FBD editor allows you to code and modify POUs using FBD (Function Block Diagram),
one of the IEC-compliant languages.

6.4.1 CREATING A NEW FBD DOCUMENT

See the Creating and editing POUs section (see Paragraphs 5.1.1 and 5.1.2).

6.4.2 ADDING/REMOVING NETWORKS

Every POU coded in FBD consists of a sequence of networks. A network is defined as a
maximal set of interconnected graphic elements. The upper and lower bounds of every
network are fixed by two straight lines, while each network is delimited on the left by a
grey raised button containing the network number.

0006

You can perform the following operations on networks:

- To add a new blank network, click Scheme>Network>New .

- To display a background grid which helps you to align objects, click @ View>View grid
- To add a comment, click 7 Scheme>Object>New>Comment .

6.4.3 LABELING NETWORKS

0.0
PLC

You can modify the usual order of execution of networks through a jump statement, which
transfers the program control to a labeled network. To assign a label to a network, double-
click the raised grey button on the left, that bears the network number; or, after selecting
a network, choose Scheme>Network>Label .

This causes a dialog box to appear, which lets you type the label you want to associate
with the selected network.
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MNetwork label x
Mew network label
Label_o|
oK Cancel

If you press OK, the label is printed in the top left-hand corner of the selected network.

“i Label_0:

6.4.4 INSERTING AND CONNECTING BLOCKS

This paragraph shows you how to build a network.
Add a block to the blank network, by applying one of the following options:

- Click # Scheme>O0bject>New>Function Block which causes a dialog box to appear list-
ing all the objects of the project, then choose one item from the list. If the block is a
constant, a return statement, or a jump statement, you can directly press the relevant
buttons in the FBD toolbar.

- Drag the selected object to the suitable location. For example, global variables can be
taken from the Workspace window, whereas standard operators and embedded func-
tions can be dragged from the Libraries window, whereas local variables can be selected
from the local variables editor.

Repeat until you have added all the blocks that will make up the network.
Then connect blocks:

- Click «* Edit>Connection mode , or simply press the space bar of your keyboard. Click
once the source pin, then move the mouse pointer to the destination pin: the FBD editor
draws a logical wire from the former to the latter.

- If you want to connect two blocks having a one-to-one correspondence of pins, you can
enable the auto connection mode by clicking (& Scheme>Auto connect . Then take the two
blocks, drag them close to each other so as to let the corresponding pins coincide. The
FBD editor automatically draws the logical wires.

Block1

Block1
VectorByScalar

Block1

1 (1]

TR B R

If you delete a block, its connections are not removed automatically, but they become
invalid and they are redrawn red. Click Scheme>Delete invalid connection .

6.4.5 EDITING NETWORKS

The FBD editor is endowed with functions common to most graphic applications running
on a Windows platform, namely:

- Selection of a block.

- Selection of multiple elements: by pressing Shift + left button and drawing a frame
including the blocks to select, or Ctrl + left button and select one by one the elements.

- % Edit>Cut , o Edit>Copy , : Edit>Paste operations of a single block as well as of a

set of blocks.
.
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- Drag-and-drop.

6.4.6 MODIFYING PROPERTIES OF BLOCKS

- Click 1 Scheme>Increment pins , to increment the number of input pins of some opera-
tors and embedded functions.

- Click Scheme>Object>Instance name , or click @ Scheme>O0bject properties , to change the
name of an instance of a function block.

6.4.7 INSERTING AND CONNECTING SYMBOLS

PLC IDE offers two quick ways to add a variable or a constant to a pin of a block; in order
to add a variable that you have already declared, just drag it to the desired pin until you
see that the pin changes to a green square; then you can drop it and it will be automati-
cally attached:

Local variables

Mame Type Address Array Initvalue A
1 |a BOOL Auto Ma
2 |b BOOL Auto Mo
1 i 'BOOL Auto Mo

0001

Alternatively you can move the curso over the pin until it changes to the green square,
then double-click it to open a dialog; in that dialog you can enter the name o a valid vari-
able (even using the object browser) or you can directly enter a constant value.

6.4.8 GETTING INFORMATION ON A BLOCK

You can always get information on a block that you added to an FBD document, by select-
ing it and then performing one of the following operations:

- Click = Scheme>O0bject>0pen source , or double-click the block, to open its source code.

0.0
PLC

78 Arduino PLC IDE user manual



ARDUINO PLC IDE

- Click m Scheme>Object properties , to see properties and input/output pins of the se-
lected block.

6.4.9 AUTOMATIC ERROR RETRIEVAL
The FBD editor also automatically displays the location of compiler errors. To reach the

block where a compiler error occurred, double-click the corresponding error line in the
Output bar.

6.5 SEQUENTIAL FUNCTION CHART (SFC) EDITOR

The SFC editor allows you to code and modify POUs using SFC (i.e. Sequential Function
Chart), one of the IEC-compliant languages.

6.5.1 CREATING A NEW SFC DOCUMENT

See the creating and editing POUs section (see Paragraphs 5.1.1 and 5.1.2).

6.5.2 INSERTING A NEW SFC ELEMENT

- Click ©1 Scheme>Object>New>Step .

- Click ¢ Scheme>Object>New>transition .

- Click = Scheme>O0bject>New>Jump .

In either case, the mouse pointer changes to:

] for steps;

&

R?D for jumps.

for transitions;

6.5.3 CONNECTING SFC ELEMENTS

Follow this procedure to connect SFC blocks:

- Click «* Edit>Connection mode , or simply press the space bar on your keyboard. Click
once the source pin, then move the mouse pointer to the destination pin: the SFC editor
draws a logical wire from the former to the latter.

- Alternatively, you can enable the auto connection mode by clicking ¥ Scheme>Auto connect
Then take the two blocks, and drag them close to each other so as to let the respective
pins coincide, which makes the SFC editor draw automatically the logical wire.

6.5.4 ASSIGNING AN ACTION TO A STEP
This paragraph explains how to implement an action and how to assign it to a step.

6.5.4.1 CREATING AN ACTION

To create a new action: choose = Scheme>Code object>New action or select the Actions
folder in the workspace and choose = [New action] from its context menu.

In either case, PLC IDE displays a dialog box like the one shown below.

(O 0]
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6.5.4.

6.5.4.

(©.C)
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SFC code type X
Languages oK
(@]
(CJFBD
(@]}
(@) ST
(JISFC

Cancel

Name

AnaloginputMade|

Select one of the languages and type the name of the new action in the text box at the
bottom of the dialog box. Then either confirm by pressing OK, or quit by clicking Cancel.

2 WRITING THE CODE OF AN ACTION

To modify the code of and action you can double-click it on the project tree or select it and
choose Edit source from its context menu.

Note that you are not allowed to declare new local variables, as the action that you are
now editing is a component of the original SFC module, which is the POU where local vari-
ables can be declared. The scope of local variables extends to all the actions and transi-
tions making up the SFC diagram.

3 ASSIGNING AN ACTION TO A STEP

You can assign or change the action associated to a step by opening its properties win-
dow; to do so, double-click the step in the SFC editor.

Be careful, if the step has already one or two action associated, they will be shown on the
block as a white square with a specific letter written inside, if you click the letter you will
open directly the action editor, not the step properties window.

Opening the step properties window will causes the following dialog box to appear.

SetPoint10Negative E

SFC Action Properties X

Code P WI L
Code N SetPoint10Positive - BIE

[Mo code]

AnalogInputMode [
Name AL AutoModelnit

ManualMode i
Comment |  SetPoint10Negative |

Emr— :

TestModelnit §

[] end_sutoPhased

>

[] end_AutoPhasel

Aute_Phase 0

From the list shown in the Code N box, select the name of the action you want to execute
when the step is active.

From the list shown in the Code P (Pulse) box, you may optionally choose the name of
the action you want to execute each time the step becomes active (which means the ac-
tion is executed only once per step activation, regardless of the number of cycles the step
remains active).

Confirm the assignments by pressing OK.

Auto_Phasze 0
AutoModeinit[P]
SetPoint1 0Negative [N]

In the SFC editor, the actions assigned to a step are represented by white square with a
specific letter inside: action P with letter P in the top right corner; action N with letter N
in the bottom right corner.
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Double-clicking directly a white square works as a shortcut to open that action editor.

6.5.5 TRANSITIONS CONDITIONS

6.5.5.1 ASSIGN A CONSTANT/VARIABLE, AS A TRANSITION CONDITION

As stated in the relevant section of the language reference, a transition condition can be
assigned through a constant, a variable, or a piece of code. This paragraph explains how
to use the first two means, while conditional code is discussed in the next paragraph.

First of all double-click the transition you want to assign a condition to. This causes the
following dialog box to appear.

SFC Transition Properties X
Value
o oK
) True Cancel
(IFalze
(") variable
() Expression
(®) Code I end_AutoPhasel ~|

Select True if you want this transition to be constantly cleared, False if you want the PLC
program to keep executing the preceding block.

Instead, if you select Variable the transition will depend on the value of a Boolean vari-
able. Click the corresponding bullet, to make the text box to its right available, and to
specify the name of the variable.

To this purpose, you can also make use of the objects browser, that you can invoke by
pressing the button its right side.

Click OK to confirm, or Cancel to quit without applying changes.

6.5.5.2 ASSIGN A CONDITIONAL CODE TO A TRANSITION

This paragraph explains how to specify a condition through a piece of code, and how to
assign it to a transition.

Start by creating a transition code: select # Scheme>Code object>New transition code ; or
select # [New transition] from the context menu of the SFC POU in the Workspace

In either case, PLC IDE displays a dialog box similar the one shown in the following pic-
ture.

SFC code type X

Languages oK
Ol
(CJFBD
L
®ST

Cancel

Name

Note that you can use any language except SFC to code a condition. Select one of the

(O 0]
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languages and type the name of the new condition in the text box at the bottom of the
dialog box. Then either confirm by pressing OK, or quit by clicking Cancel.

Now the transition code is added to the project tree; you can open its editor by double-
clicking it, or by opening its context menu and selecting Edit source .

Note that you are not allowed to declare new local variables, as the module you are now
editing is a component of the original SFC module, which is the POU where local variables
can be declared. The scope of local variables extends to all the actions and transitions
making up the SFC diagram.

To assign the transition code to the transition element, double-click the transition element
in the SFC editor. This causes the following dialog box to appear.

SFC Transition Properties X
Value
OK

-v"
() True Cancel
() False
(") Variable
() Expression
(@) Code |end_autoPhas=0 -

[Mo code]

end_Analog l

end_Automatic

end AutoPhase0

end_AutoPhase1

end_Zero

Select Code, and then choose the name of the condition you want to assign to this transi-
tion from the list. Then confirm by pressing OK.

6.5.6 SPECIFYING THE DESTINATION OF A JUMP

To specify the destination step of a jump, double-click the jump element in the SFC edi-
tor. This causes the dialog box shown below to appear, listing the name of all the existing

steps.
SFC Jump properties X
Analog_setpoint oK
Auto_Phase_0
Auto Phase 1 e
Zerm_setpoint

Select the destination step, then either press 0K to confirm or Cancel to quit.
The name of the target step will be shown inside the jump element.

6.5.7 EDITING SFC NETWORKS

The SFC editor is endowed with functions common to most graphic applications running
on a Windows platform, namely:

- Selection of a block.

(©.C)
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- Selection of a set of blocks by pressing Ctr7 + left button.

- ¥ Edit>Cut , o Edit>Copy , = Edit>Paste operations of a single block as well as of a
set of blocks.

- Drag-and-drop.

VARIABLES EDITOR

PLC IDE includes a graphical editor for both global and local variables that supplies a user-
friendly interface for declaring and editing variables: the tool takes care of the translation
of the contents of these editors into syntactically correct IEC 61131-3 source code.

As an example, consider the contents of the Global variables editor represented in the
following figure.

Name Type Address Group Array Init value Attribute Description
1 |pidkP REAL %MD1.0 FID Mo PID proportional gain
2 |pidKl REAL %MD1.4 FID Mo PID integral time
3 |pidSetpoint REAL %MB1.8 FID Mo PID setpaoint (from -1 to +1)
4 |pidOutput REAL MD1.12 FID Mo PID output value

The corresponding source code will look like this:
VAR GLOBAL

gA : BOOL := TRUE;

gB : ARRAY[ 0..4 ] OF REAL;
gC AT %MD60.20 : REAL := 1.0;
END VAR

VAR GLOBAL CONSTANT
gb : INT := -74;
END VAR

Alternatively, PLC IDE includes also a textual editor for both global and local variables;
using this editor will allow you to declare and edit the source code of the variables.

6.6.1 OPENING A VARIABLES EDITOR
6.6.1.1 OPENING THE GLOBAL VARIABLES EDITOR

In order to open the Global variables editor, expand the Global variables folder and any
subfolder until you reach the desired Global variables group, then double-click on it.

are L D v s Descrpton
=~ &1 PrjDoc Project A 1 |parCtDownPreset  UDINT Auto ‘No 100 = Counter down preset
i é‘:‘i;:‘s‘;z;ﬁter 2 paCiUpPresel  UDINT Auto No 15 - Counter up presel
4 Fu:ctmns 3 |parPulseValue UDINT Auta MNo — Actual pulse time value
= Global variables a 4 | parPulseWidth UDINT Auto MNo 500 . Pulse width
= Automatic variables = 5 |parTimOnDelay UDINT Auto No 1000 — Delay of the ON delay timer
=-E@ Counters_and_timers & |parTimOnValue UDINT Auto No — Actual value of the timer

parCtDownPreset
parPulseValue
parPulseWidth

6.6.1.2 OPENING A LOCAL VARIABLES EDITOR

To open a local variables editor, just open the relative Program Organization Unit.

(O 0]
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= [ PrDoc Project =3 Class Pin Name Type Aray | it value Atrbute Desoription e
B Function blocks ;i i
: 1 |vaRINPUT 0 in REAL Ne ‘ |
= E —
=] ”ab‘es 2 [VAR_INPUT 1k REAL Mo .
it = 3 |vaR_ouTPUT 0 out REAL No
[« |
= Qutput variables ==
out Al "
Functions ol 0003 out = k * ( in — out } + out:
Global variables
Programs
P nit
P LadderLogic
[P Loops
% =P PidControl
2P PidModeSelector v
Y Parameters v |< >

6.6.1.3 SWITCH FROM GRAPHIC TO TEXTUAL EDITOR

For both global and local variables, when you open their graphic editor, you’ll see on the
far right border three tabs:

Local variables

Mame Type Addrezs Amay I i
X REAL Auta Mo .

B |

-
2 ly REAL Auto No ] =
3 |incr REAL Auto Mo U.U@E |
4 | UINT Auto No e
5 |bit BOOL Auto No @‘E |
6 |previnp BOOL Auto [0..63] - T
7 |pressed BOOL Auto [0.7]

8 |ccc BOOL %MB199.0 No
< {11} >

The first, selected by default, is the graphic variables editor; this editor provides a user-
friendly interface.

The second is the textual variables editor; this editor allows the user to declare and edit
variables by modifying directly the source code. The textual editor can be really useful if
you need to paste some variables declaration code, taken from another source.
Switching from the graphic editor to the textual editor, will show you the actual source
code of the defined variables:

Local variables

FROGEAM Loops FS

VAR
x : REAL:
v . EEAL;
incr : REAL := 0.01;
i : UIHNT:
bit : BOOL;
previnp - ARRAY[O. . 63] OF BOOL;
pres=ed : ARRAY[O. 7] OF BOOL; .
coco AT ®XMB199.0 . BOOL;
EHD VAR

M| E

&

< >

The third tab is the watch editor, refer to the appropriate chapter of this manual for de-
tails (see Paragraph 9.1.1.1).

6.6.2 CREATING A NEW VARIABLE

In order to create a new variable, you may click & Variables>Insert .

0.0
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Follow this procedure to edit the declaration of a variable in a variables editor (all the fol-
lowing steps are optional and you will typically skip most of them when editing a variable):

1) Edit the name of the variable by entering the new name in the corresponding cell.

Name Type Address Amay
1 TON Auto No
2 |fbCtu CTU_UDINT  Auto Mo
3 |fbCtd CTD_UDINT  Auto Mo
4 |bTp TP Auto Mo
5 |ettp UDINT Auto Mo

Init value

Attribute

Description

2) Change the variable type, either by editing the type name in the corresponding cell
or by clicking on the button in its right and select the desired type from the object

browser.
Name Type Address Aray Init value
1 |foDelay Auto No
2 |fbClu CTU_UDINT  Auto Mo
3 |fbCtd CTD_UDINT  Auto Mo
4 |bTp TP Auto Mo
5 |etip UDINT Auto Mo
T Object browser

Objects filter

["]Function Blocks

[Juser types [] Basic types
Check all Check none

Other filters

Name oK

Location [ Al |
brary a0~
Vars type |
Vars group |

Close

Name

[FsooL
[BlevTe
[diloanT
Bvoworn
[t
(Lo
[EEE
[W]Lworo
[lreaL
[si]smr
[stsTRING
JadlupmvT
[uilumnr
[uluLnT
slusmT
[wlworp

Attribute:

Type

Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types
Basic types

Description

3) Edit the address of the variable by clicking on the button in the corresponding cell
and entering the required information in the window that shows up. Note that, in the
case of global variables, this operation may change the position of the variable in the

project tree.

MName Type Address
1 |foDelay TON %MDs.0 [ ]I
2 |mctu CTU_UDINT Auto |
3 |t CTD_UDINT Auto |
4 |wTp P Auto |
5 |etip LIDINT Auto |

Variable address

[ Automatic address

Size

(JBit

() Byte (8 bit)
() word (16 bit)
(®) Double word (32 bit)

Data block
5

Index Bit[ |

i}

Location

() Input
() Output
@ Memary

OK

Cancel

4) In the case of global variables, you can assign the variable to a group. You have three

ways to do so:

- First create the group and then create the variable from inside the group.
- You can drag&drop existing variable into a new group.

Arduino PLC IDE user manual

(O 0]
PLC

85



ARDUINO PLC IDE

- Specify the group the variable belongs to when creating the variable; to do so, choose

the appropriate voice from the menu Variables > Add ; the following window will ap-
pear, allowing you to specify also the variable group.

MNew variable x
Name Type
Group | Counters_and_timers -/ Array Mo
; Counters_and _timers ;

Attribute PID Init values

Mappings
Description  Ungrouped_vars

Parameters

Ok Cancel

5) Choose whether a variable is an array or not; if it is, edit the size of the variable.

Size of variable X
Local variables |
() Scalar
MName Type Address HAray )

1 |pase UDINT Auto 10.4,0.5,0.5 [0 | || S Ameyitite

2 |increment USINT Auto No Rensn ] SR
Dimension 2 Bl 5 size = 6
Dimension 3 S 5 size = &

oK Cancel

6) Edit the initial values of the variable: click on the button in the corresponding cell and
enter the values in the window that pops up.

i3

Init values for: () X
[1.2.2]
QK Cancel
7) Assign an attribute to the variable (for example, CONSTANT or RETAIN), by selecting it
from the list which opens when you click on the corresponding cell.
Mame Type Address Array Init walue Attribute Description

1 |base UDINT Auto Mo 100 . vl
2 |increment USINT Auto Na ’ .

[CONSTANT |

8) Type a description for the variable in the corresponding cell. Note that, in the case of
global variables, this operation may change the position of the variable in the project

tree.
Mame Type Address Aay Init value Attribute Description
1 |base UDINT Auto Mo 100 . Base element |
2 |increment USINT Auto Mo 1 CONSTANT Constant increment value

9) Save the project to persist the changes you made to the declaration of the variable.

6.6.4 DELETING VARIABLES

0.0
PLC

In order to delete one or more variables, select them in the editor: you may use the CTRL
or the SHIFT keys to select multiple elements.
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Name Type Address Amay Init walue Attribute Description
1 |fDelay TON Auto No
2 |foCtu CTU_UDINT  Auto No
3 |bCid CTD_UDINT  Auto No
4 |BTp TP Auto No
5 |etip UDINT Auto Mo

Then, click = Variables>Delete .
Notice that you cannot delete the RESULT of an IEC61131-3 FUNCTION.

6.6.5 SORTING VARIABLES

You can sort the variables in the editor by clicking on the column header of the field you
want to use as the sorting criterion.

m Type Address Name Address
1 |aux INT Auto 1 |increment USINT Auto
2 |pase UDINT Auta 2 |muttiptier USINT Auto
3 'exponent_1 INT Auto 3 |aux INT Auto
4 |exponent_2 REAL Auto 4 .exponent_1 INT Auto
5 |increment USINT Auto 5 |base UDINT Auto
6 |multiplier USINT Auto 6 |exponent 2 REAL Auto

6.6.6 COPYING VARIABLES

The variables editor allows you to quickly copy and paste elements. You can either use
keyboard shortcuts or the = Edit>Copy , ¢ Edit>Paste menu.
Note: overlapping addresses problems may occur by copying mapped variables. PLC IDE can

automatically assign new free address to the new pasted variable and fix the overlap. In
order to enable this functionality please refer to paragraph 3.6 and 4.8.3.3 for further

details.

6.6.7 SETTING VARIABLES INITIAL VALUE

Using the Init value field of the variables editor, you can set a valid initial value to the
selected variable. You can directly enter the desired value within the text area (which is
the fastest way) or you can click the button in the corresponding cell and use the editor
that pops up to enter your value (this solution is useful if you are valorizing complex data
type).

Local variables

MName Type Address | Array Init value Attribute Description
1 |vart INT Auto No lE’D
2 |var2 UINT Auto Mo
3 |var3d DWORD Auto Mo =
L3 Init values for: var1 (INT) ®
|
oK Cancel

Base data types
For base data types you can just enter a valid value, which respects the range of values

(O 0]
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fot that data type.

String
When selecting the type string, you’ll see also the field array is valorized with [32]; that
is the number of character allowed inside the variables, exceeding character will be trun-
cated.

To initialize a sting, just enter the desired character within single quotes.

The string terminator character will be added automatically, so you don’t need to insert
it; also the string terminator is not counted within the specified size: that means that if
the specified size is 32, you can enter 32 chars and the terminator will be the 33th, the
string length will be 33.

The single quotes are not counted among the other characters, they are ignored.

Local variables

1 |myStr STRING Auta [32] "Hello World o
; gl
Init values for: myStr (STRING) X _‘
|'Hello World' B‘j
oK Cancel

WString

When selecting the type wstring, you'll see also the field array is valorized with [32]; that
is the number of wide character allowed inside the variables, exceeding character will be
truncated.

To initialize a wsting, just enter the desired character within double quotes.

The string terminator character will be added automatically, so you don’t need to insert
it; also the string terminator is not counted within the specified size: that means that if
the specified size is 32, you can enter 32 wide chars and the terminator will be the 33th,
the wstring length will be 66.

The double quotes are not counted among the other characters, they are ignored.

Local variables
Name Type Address Array Init value Attribute

1 |mywstr WSTRING  Auto 132 “Hello World"

M 8

Init values for: myStr (WSTRING) Pt
"Hello World"

oK Canesl

Array

Before inserting the initial values, you must specify that the desired variable is an array;
to do so, click the button inside the Array field, and use the pop up dialog to specify the
array size.
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Local variables |
%

| MName | Type \ Address | Array Init value Attribute | Description
1| myAr INT Auto No
Size of variable X

() Scalar

(®) Array | Matrix

Dimenson1 | 0 AE] size= 6

DimensonZi‘U 0 | size = 1

Dimension 3 | 0 .o Jsizm= 1

oK | Cancel

Now you can enter the initial values: for the array, write the values within square brackets
and separate each value with a comma.

| Local variables

| Name | Type |Address| Amay | Initvalue | Atribute | Description H
1 |myArr INT Auto [0.5] 012345

i Init values for: myArr (INT) x

I[0.1.2.3.4.5] ﬁ

ok | | Cancel

Multidimensional arrays (MATRIXES)
As per the array, you must first specify the matrix size; so open the array editor and enter
more than one dimension.

Local variables

I Name J Type | Address | Amay \ Init value | Atribute | Description H
1| myMatrix INT Auto 04,0506 |
Size of variable X
() scalar
(®) Array / Matrix
Dimension 1 | 0 e size = 5
Dimension 2 | 0 - 5 Jsizm= 6
Dimension 3 | 0 J .. 6 size = 7

oK Cancel

Now you can enter the initial values: for the matrix, write the values within square brack-
ets and separate each value with a comma. Write all the value inline, the indexes will be

automatically applied.

(©.0)
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Local variables Watch

| Name | Twpe | Address | Array | Initvalue | Attribute B e ERE ¢ t 4 @
1| mylatrix INT Auto [0.1,0.2,0.1 [0,1,2,3,456,7289,1011] Symbol Value e
5 = =[] MYMATRIX - INTT]

i : X
i Init values for: myMatrix (INT) — 1000] 0 INT
I[0.1.2,3,4,5,6,7,8,9,10,11] — [00.1] : INT
— [0,1.0] 2 INT
— [0,1,1] 3 INT
— [0,2,0] 4 INT
— [0,21] 5 INT
— [1,0,0] ] INT
—[1,01] 7 INT
oK Cancel — [1,1,0] 3 INT
RN g INT
— [1,20] 10 INT
— [1,21] 13 INT

Structures

Structures are user defined data types, so the first thing to do is create a structure.
Let’s suppose we have a structure like the following one:

Mame Paos. Type Address Array @
1 (w1 0 INT Auto Mo
2 |2 1 INT Auta Mo
3 |theString 2 STRING Auto [32]
4 |theArray 3 INT Auto [0.5]

The initial value of a structure is written within round brackets, each field is separated
with a comma, and you must also specify the field you are valorizing since you are not
required to valorize every field of the structure nor you're required to respect the order

of the fields.
Name Type Address Array Init value Attrit B e WERE ¢« t 4 @
1 |myStruct Struct_A Auto Mo (v1:=100v2 := 200 thestr.. D Symbel Value Type
2 |ist INT At No . < S MVSTRUCT 4 STRUCT A
et Init values for; myStruct (Struct_A) X —¥ W N
- V2 200 INT
It - THESTRING 'Hello World' STRING
w1l .= 100,
w2 = 200, -1 [] THEARRAY < INT[]
theString = 'Hello World'. ot
thedrray = [0.1.2.3.4.5] o 8 T
: — 1] 1 INT
—[2 2 INT
— 3 3 INT
— 4 INT
oK Cancel — [5] 5 INT

Array of structures

An array can be of different types, even of complex data types; to make an example, let's
suppose we have an array of structures, where the structure has these fields:

Mame Pos. Type Address Array @
1 |l ] INT Auto Mo
2 |v2 1 IMT Auto Mo
3 |theString 2 STRING Auto [32]
4 |theArray 3 INT Auto [0..5]

To initialize the array we will write the values within square brackets, each value will be
separated with a comma, and every value will be the initial value of a structure; the result
will be something like this:

0.0
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Name Tyvpe Address Array Initvalue Attribute
1 |myStruct Struct_A Auto 0.1 [0 = 101,v2 .= 201 thest,
Init values for: myStruct (Struct_A) X
[(
vl = 101,
w2 = 201,
theString := 'Hello World 1°.
thedrray := [0,1.2,3,4,5]
).
(
w1l = 102,
w2 = 202,
theString := 'Hello World 2°.
thedrray := [6,7.8.9,10,11]
11
OK Cancel

Function Block

Description

Watch

Symbol
=1 [] MYSTRUCT
S0
—-Vi
-2
THESTRING
- [1 THEARRAY
-1
—m
-1
— 13
— 1
-1
SEm
—-Vi
— V2
THESTRING

[ =

Value

101
201

'Hello World 1*

A

102
202

'Hello World 2*

-/ [1THEARRAY -

=10
—m
-2
-3
— 4
— 1[5

6
7
L3
9
1
1

ARDUINO PLC IDE

E R

Type
STRUCT_A[]
STRUCT A

INT
STRING
INTT)

INT
INT
INT
INT
INT
STRUCT A
INT
INT
STRING
INTD)
INT
INT

INT
INT
INT

A function block is initialized the same way of a structure, you can initialize all types of
variables of the function block (local vars, input vars, output vars...).

Let’s suppose we have a function block with the following fields:

Local vanables

Class
1 VAR
2 VAR
3 VAR
4 |VAR
5 |VAR_IMNPUT
6 |VAR_QUTPUT

Pin Mame Type
v INT
Ve IMNT
thestring STRING
theArray INT

0 v_in INT

0 v_out INT

Address
Auto
Auto
Auto
Auto
Auto
Auto

Mo
Mo
[32]

Mo
Mo

[0..5]

Array

Init wal

The initial value of a function block is written within round brackets, each field is sepa-
rated with a comma, and you must also specify the field you are valorizing since you are
not required to valorize every field of the function block nor you're required to respect the
order of the fields.

Local variables ‘Watch
MName Type Address Array Init value Attribute B e ERA ¢ 4 A
1 |myFB theFB Auta No (v_in:=100v1:= 1012, Symbol e Type
- 3 MYFB - THEFB
ot Init values for: myFB (theFB) X — VN 100 INT
It — V.out 101 INT
Viln .;D}DD' — Wi 101 INT
v M B
vz - 301 —wvz 201 INT
tﬁegtrlng 3 ; SHTLéDEUEré? 12 THESTRING ‘Helle Werld 1 STRING
thedrray := [0.1.2.3.4, B s
v_out .= 200 [] THEARRAY - INT[]
) — [0 0 INT
—[1] 1 INT
—[2] 2 INT
e 3 E] INT
OK Cancel —[4] 4 INT
—[5] 5 INT

(©.0)
PLC

Arduino PLC IDE user manual 91



ARDUINO PLC IDE

6.7 OBJECT ORIENTED

6.7.1 ENABLE OBJECT ORIENTED PROGRAMMING

PLC IDE allow the users to work with the object oriented programming, enhancing the
function blocks and treating them as classes; since this feature needs to be supported by
the target device implementation, it is disabled by default; in order to enable it you have
to select Project > Options > Tab general and check the Use object oriented features
checkbox.

Project options x

| Buideverts | Cross Reference | Runtime checks | Advanced |
| Genmeral | Code generation | Buidoutput | Download | Debug |

Project info

Project: ExamplePrj {max 10 chars}
Verzion: (example: 1.0)
Author:

Nate:

Legacy options
Use new LD editor

Use customizable workspace

Main features
Use object orented features

[ Muttiple files project {xplc)

OK Annulla Applica 2

Now the dialog that shows up when creating a new Function Block (as well as the Object
Properties dialog), will show addittional content:

MNew Function Block X
Language

O (OFBD O (@)sT (OJsFC

Mame

Extends

Browse

Implements

Browse

oK Cancel

(©.C)
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ir Object properties (FUNCTION BLOCK) X
Object properties
Name: fblt
Title:
Version: 1.0.0 [IrRead Only
Jeseription: [[Juse HTML syntax
A
v
£ >
Extends: Browse...
Implements: Browse...
Icon: Browse... Remowe
Images:
+
Library generation options
Exdude from build options
[ Exclude

OK Cancel

In the Extends field, you can specify another Function Block that will be treated as a father
class for the current function block; only one Function Block can be specified as a father.

The current Function Block will inherit every object of the father.
In the Implements field, you can specify one or more interfaces.

Please note that even if the Object Oriented feature is enabled, you can keep using the
function blocks as normal function blocks.

6.7.2 METHODS

6.7.2.1 CREATE NEW METHODS

If the Object Oriented feature is enabled, you can consider a Function Block as a class;
in order to create a new method: open the context menu of the Function Block by right-
clicking on it's instance in the project tree, then choose New Methods.

(O 0]
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= @] 00_Example Project ' Cl
A . clace 1 N —
= Edit source Shift+Enter

View Function block properties Alt+Enter

I
[
[ Edit Function block properties  Alt+5Shift+Enter
E[’ﬂ Copy (name) Ctrl+C
!

- Duplicate function block
E Delete function block Delete
EP g}a: Renarme function block F2
+ - [HiEy Globa 4
H. [ Tasks Refactoring

Export to library P

Crypt

Decrypt

Exclude from build

A dialog will appear asking you which language you wish to use to implement the method
body, SFC cannot be used. Once created, the new method will be shown in the project
tree:

- ] 00_Example Project
- [EE fb_class_1
- Input variables
[i] in1
[i] in2
-l Local variables
[G] lect
-l ) Methods
Ely} method 1

You can define any number of methods for the same class, but you cannot define more
methods with the same name (even if their prototype is different).

6.7.2.2 INVOKING METHODS

Methods work like functions, except that they have access to the class context (which
means, for example, the Input variables of the function block).

Methods can be invoked in a POU (for example in a program), like extensions to the Func-
tion Block instance:

=[] 00_Example Project 5 Pin Nae e R e Atibute Descrpion
¢ Eﬁfl}"jsgt " 1 VAR_INPUT 0 x INT No
7 ol 2 [RESUT methad_1 DINT No Wethod result
[ foint
[T fo_inz
5 BB Local variables
[] fb_loct
= @ Methods
5 [N method_1 -
e Input variables main - ox method_1 -ox
el moin| 001 B % -
# E Localvariables oo xgggzzﬂ il ez %E 0002 method_1 := fb inl + fb inZ + fb_locl + =,
= Bi® Globalvars i
O] ent res = myClass_1 method 1(vl):
W[ Tasks

0.0
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Methods can be called from other methods of the same class, to do so use the this. speci-
fier:

= [E] 00_Example Project Class Pin Name Type

- fhocass 1 1 |RESULT method_2 DINT
- Input variables

[G] fb_in
[i] fbin2
- E Local variables

[G] b_loct
-l ) Methods

+-Z]M method_1 | |

&=l method_2| method 2 = this . method_1(123);

Methods can be called also from inside the relative Function Block body, but the Function
Block body cannot be called from inside a method.

6.7.2.3 INHERITED METHODS

If in the Extends field, when creating a new Function Block, or inside it's Object properties
window, you specify the name of another Function Block, the current one will inherit all
of it's methods.

Inherited methods are always considered as virtual methods, which means that if the
children Function Block implements a method with the same protorype of a method im-
plemented by the father, no error is raised, as the children method will override the father
method.

If you wish to explicitly call the father method, you can do it by using the super. specifier:

= [l OO0_Example Project Class Pin Name Type

2B fodess 1 1 |RESULT method_1 DINT
i ImIplL'tf;ai';bles 2 |VAR_INPUT 0 x INT
[i] fo_in2
- B Local variables
[i] fb_loc
= ) Methods
=-EH methed_1
+ Input variables method_ 1 = super method_1(=):
EIM method_2
--[EF fb_class_2
= ) Methods
ER Al method_1

You can also call the father Function Block body, instead of a specific method, using
super(); alone.

You can see if a Function Block extends another function block, by looking at its prop-
erty window.

6.7.2.4 METHODS POLIMORPHYSM

PLC IDE can handle polimorphysm with classes, to do so you’ll have to use the reference
data type (see paragraph 11.1.2.1).

Create a variable of type reference to the father class; now valorize it usign the reference
of a child class; now you can use the reference variable to call a method (or to access the
class properties), PLC IDE will be able to recognize which is the correct method to call.

(O 0]
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- @1 00_Example Project

Name Type Address
T FE CITSUt iabl 1 |myClass_1 fb_class_1 Auto
+ nput variables
+- HH Lopcalvariables 2 v INT Auto
= Q) Methods 3 res DINT Auto
+-EM method_1 4 |fRef fb_class_1* Auto
EIM method_2 5 'myClass_2 fo_class_2 Alto
+-[ER fb_class_2
- EP main

+- B8 Local variables
+Hi® Global_vars

- [ Tasks
myClas= 1.fb inl := 10;
myZla=zs 1.fb_in2 = 10:
res = myClass_1 method 1(wl):;

fRef := REF{mvClass 1):
res = fRef” method 1({wl):

In this example, fRef~.method_1() will call method_1 of fb_Class_2 even if fRef is a refer-
ence to fb_Class_1.

6.7.3 INTERFACES

6.7.3.1 CREATE NEW INTERFACES

In order to create a new interface, after having enabled the Object Oriented program-
ming, select Project > New object > New definition > Interface . A dialog will be shown ask-
ing you to specify the name of the interface and (optionally) a description.

s New Interface X
Mame |
Description
~
W
< >
QK Cancel

After creation, the interface will appear as a new element in the project tree.
- g2l 00_Example Project

EF, fb_class_1

EIf fb_class 2

-

EIP main

HiE® Global_vars

+ [ Tasks

+

Now you can add a method prototype: from the interface context menu, select Add meth-
od prototype; a dialog will appear asking you to insert the name of the method and (op-

(©.C)
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tionally) a description.
s

Interface intf_1

New Method Prototype

Mame method 100

Description

Cancel

ARDUINO PLC IDE

After creation, the method prototype will appear in the project tree as a subelement of

the interface element.

- @] 00_Example Project

F, fb_class_1
F fb_class_2

= =@ intf_1

@

EIP main

+ B Global_vars

+ [ Tasks

By double clicking on the method prototype element, a new editor will be opened in the
editor window, allowing you specify the method prototype (which means the required

input variables).

An interface can extend another interface (only one), in a father-child hierarchy; doing so,
the children interface will inherit all the method prototypes of the father interface.

To extend an interface select Edit properties from the interface context menu, a new di-
alog will be shown allowing you to modify several properties, included the extend field.

= ] 00_Example Project
Ef fb_class_1
Ef fb_class 2
S
+ () method_100
- +0 intf 2
+ - ) method_200
+ ) method_201
EIP main
& Global_vars
1 Tasks

+

+

s Object properties (INTERFACE)
MName intf_1
Title
Version 1.0.0
Description
<
Extends intf_2|

OK

Cancel

x

|:| Use HTML syntax

Browse
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You can see if an interface extends another interface by looking at its property window.

6.7.3.2 IMPLEMENTING INTERFACES

The methods prototype of an interface can be implemented by a function block.

Upon creation of the function block, or editing its properties, you can specify one or more
interfaces in the Implements field; the interface and its methods will appear in the project
tree as subelements of the Function Block that implements them.
= [l 00_Example Project
EF, fb_class_1
A ib_class 2
+ ) Methods
- sh Interfaces
=] +@ intf_1
+ .=.’:J method_100
+--a7ly method_200
+ .=.’:J. method_201

= =@ intf_1
+- ) method_100
= +0 intf_2
+ - ) method_200
+ - ) method_201
EIP main
B Global_vars
0 Tasks

¥

¥

In the example of the above picture, fb_class_2 implements intf_1; and intf_1 extends
intf_2.

In order to implement a method prototype of an interface, you need to create a method
which has the same prototype (name and input variables) of the method prototype you
wish to implement. Compiling a project with method prototypes not correctly implement-
ed, will raise errors.

To implement a method prototype you can create a new method (see paragraph 6.7.2.1)
which has the same prototype of the method you wish to implement, or you can right-click
on the method prototype and select Implement method; this way a new method will be
created, already with the correct prototype.

Method prototypes can have different icons, with different meaning:

@

method prototype correctly implemented.

D there is a method with the same name but different prototype from the one you wish
to implement.

&

" no method has been found with the same name of the method prototype you wish to
implement.

% the previous icons can also have a blue arrow on their right side, that means the
method prototype is inherited from a different interface

6.7.3.3 INTERFACES POLIMORPHYSM

(©.C)
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valorize it usign the instance of a class that implements the method prototypes of that
interface; now you can use the interface variable to call methods, PLC IDE will be able
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to recognize which is the correct method to call, even if there may be more classes that
implement the same interface.

Also, using the query interface operator IMOVE ( ?= ), you can use a variable to an inter-
face to valorize a varaible to a second interface which is extended by the first one; PLC
IDE will be able to analyze the object behind the source interface, and will use the correct
method to valorize the destination interface variable.

= g1 O0_Example Project

Name Type Address
[k fb_class 1 1 |myClass_1 fo_class_1 Auto
= Ef fb_class2 2 |1 INT Auto
+ - Q) Metheds
S & Interfaces 3 |res DINT Auto
S o intf 1 4 i1 intf_1 Auto
+ @_methgd_mg 5 |myClass_2 fo_class_2 Auto
+- [l method_200 & |i2 intf_2 Auto
- (gl method 201
-I-[EF, fb_class_2
S g Interfaces
=] «0 intf_1
+- ) method_100
+ Esi. method_200
+ Eﬂ. method_201 11 := myClass 2;
#oe0 intf ] res = il method_201(vl):
+- +0 intf_2
B alad main iz 7= i1:
+ - B Local variables res ;= i2.methad_201{vl);
+-Ei@ Global_vars
# - [ Tasks

In the baove example: the interface intf_1 extends the interface intf_2; the interface
intf_1 is implemented by both fb_class_1 and fb_class_2.

i1, variable of type intf_1, is valorized using myClass_2, an instance of fb_class_2, which
is a Function Block that implements intf_1; now calling il.method_201 will correctly call
method_201 of fb_class_2.

i2, variable of type intf_2, which is an interface extended by intf_1, is valorized with il
using the IMOVE operator; thanks to this operator there’s no error even if il and i2 are
not of the same type (because PLC IDE understand that il extends i2) and i2 is valor-
ized with a reference to the instance of myClass_2; so if around your project you call
i2.method201, you will be calling method_201 of fb_class_2.

6.7.4 OBJECT ORIENTED IN GRAPHIC LANGUAGES

In graphic languages, in case the object oriented programming is enabled, PLC IDE will
prompt a dialog to ask the user which element he wish to select in case of ambiguity.

For example: if you have a function block with methods and you drag it into an FBD pro-
gram source editor, PLC IDE will ask you if you want to call the body of the function block
or a specific method.

(O 0]
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Local variables

Mame | Type | Address | Amray | it walue | Attribute |
1 |my_Class_2 fo_class_2  Auto Ma
Method invocation X
Choose function blodk method to call: —_—

0001

fbo_class_2.method_1

fb_dass_2.method_100

fb_dass_2.method_2 [fb_dass_1]

fb_dass_2.method_200
fbo_dass_2.method_201

(8]4 | | Cancel
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7. COMPILING

Compilation consists of taking the PLC source code and automatically translating it into
binary code, which can be executed by the processor on the target device.

7.1 COMPILING THE PROJECT

Before starting actual compilation, make sure that at least one program has been as-
signed to a task.

= [ Tasks

= % Fast
" PidControl
"B PidModeSelector
Slow
"B Loops
Background
"B LadderLogic
Boot
Init

B Init

1
A3

LR L

When this pre-condition does not hold, compilation aborts with a meaningful error mes-
sage.

Qutput 4 x

error P2068: Ho task defined for the application

0 warnings. 1 errors.

Build Find in project Debug Resocurces

In order to start compilation, click & Project>Compile .

Note that PLC IDE automatically saves all changes to the project before starting the com-
pilation.

7.1.1 IMAGE FILE LOADING

Before performing the actual compilation, the compiler needs to load the image file (. imgx
file), which contains the memory map of the target device. If the target is connected
when compilation is started, the compiler retrieve the image file directly from the tar-
get. Otherwise, it loads the local copy of the image file from the working folder. If the
target device is disconnected and there is no local copy of the image file, compilation
cannot be carried out: you are then required to connect to a working target device or
to refresh your working folder, loading the image file from the installed catalog (select
Project > Refresh current target ).

Output I x

C:wU=ers~MattiaMi~Docunents viviviwiviv. imgx — srror I0001:
Invalid memory image file.
Flea=e upload memnory image from the target

Build Find in project Debug Resources

(O 0]
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7.2 COMPILER OUTPUT

If the previous step was accomplished, the compiler performs the actual compilation,
then prints a report in the Output window. The last string of the report has the following
format:

m warnings, n errors

It tells the user the outcome of compilation.

Condition Description
Compiler error(s). The PLC code contains one or more serious errors,
n>0 which cannot be worked around by the compiler; the binary output

file is not generated, the project cannot be downloaded.

Emission of warning(s). The PLC code contains one or more minor
errors, which the compiler automatically spotted and worked around.
However, you are informed that the PLC program may act in a
different way from what you expected: you are encouraged to get rid

m>0 of these warnings by editing and re-compiling the application until no
warning messages are emitted.
Even if you do not correct the warnings, the binary output file is
generated and you can download the project.
PLC code entirely correct, compilation accomplished. You should
n=m=0 always work with 0 warnings, 0 errors.

The binary output file is generated and you can download the project.

7.2.1 COMPILER ERRORS

When your application contains one or more errors, some useful information is printed in
the Output window for each of those errors.

Output 4 x
Freprocessing variables .. completed. A
Preprocessing POUs .. completed.

Preprocessing user defined data .. completed.

Code generation ..
Preproces=sing EmbeddedElenent= conpleted.
aborted.

INIT(3) — error S51303: TUseless expression
INIT(3) — error A44097: MHYVAR 1 =: Object not found

0 warning=, 2 errors.

Build Find in project Debug Resources

As you can see, the information includes:

- the name of the Program Organization Unit affected by the error;

- the number of the source code line which procured the error;

- whether it is a fatal error (error) or one that the compiler could work around (warn-
ing);

- the error code;

- the error description.

Refer to the appropriate section for the compiler error reference.

If you double-click the error message in the Output bar, PLC IDE opens the source code
and highlights the line containing the error.

You can then fix the problem and re-compile.

(©.C)
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7.3 COMMAND-LINE COMPILER

PLC IDE’s compiler can be used independently from the IDE: in PLC IDE’s directory, you
can find an executable file, named LLC.exe, which is a command-line compiler that can
be invoked (for example, in a batch file) with a number of options.

In order to get information about the syntax and the options of this command-line tool,
just launch the executable without parameters.
B3 Prompt dei comandi - O X
compiler options

Compiler options:

[:I ro
ympiled will

iable track file.

ble track file.

updat

on file.

: simulator
LOADP C
U[:file[,pwd]] ; e e an d in file paramete)

file for

thile downloa

7.4 EXCLUSION FROM COMPILATION

There are several way to exclude a POU, a symbol or a portion of code from the compila-
tion.

7.4.1 EXCLUDE FROM BUILD

The Exclude from build options allows you to explicitly avoid compilation of specific ele-
ments; you can exclude every kind of POU, such as programs, functions, function blocks
, global varaibles groups and folder.

To set/unset this option, you can open the context menu of the desired element and
choose Exclude from build option; the aspect of the element inside the project tree will

change to notify it is excluded from any compilation.
.
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N .- v Project

= E1 RaspPl_PlcSample Project '

- irizas == -l @] RaspPI_PlcSample Project
4 unctions 1 .
I+ Global variables =2 + Function blocks
= P .
' ;'39:::5 ’7- + Functions
g Locd=rLooi gl s + Global variables
=P Loops it source ift+Enter
[ #=P PidControl View Program properties Alt+Enter - Pfl:lgrams
E‘dp PidhodeSe Edit Program properties  Alt+Shift+Enter P Init
w B Tasks [ Copy (name) Ctrl+C
Duplicate program
Delete program Delete P LEIEIFlS
Rename program FZ ¥ ..[=F| pid':':lrltrl:ll
Export to library )
EEP PidModeSelector
Crypt
Decrypt + ﬂ Tasks

Alternatively, you can achive the same result from the Object properties window of the se-
lected object. Choose Edit object properties from the context menu of the desired object
(shortcut is Alt + Shift + Enter) and select the Exclude option.

ir Object properties (PROGRAM) X
Object properties
Name: [ LadderLogid|

Title:
Version: (100 [Cread only

Description: [(use HTML syt

]

< >
Icon; Browse... Remave

Images:

Library generation options

Exclude from build options

[ |Exdude Exclude IF NOT DEF:

Ok Cancel

From the properties window you can also specify a condition (global symbol existance) to
determine if the POU should be compiled or not.

Remember that the exclusion is recursive, so if you choose to exclude from compilation a
folder or a global variables group, all the sub-elements will be excluded too.

To remark this, the context menu voice will also change into Exclude all contents from
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build.

= [@1 RaspPl_PlcSample Project
+ Function blocks
+ Functions
+ Global variables = E Rasp'l.:‘l PlcSample Prp_iect
= w e / ;
=P Ir Add » : f
P L Rename F2 + unctiens
EPL Delete Delete [+ Global variables
+-mgh P Edit Folder properties = 6 F !
=P P
Crypt objects m:'
+- (] Tasks
Decrypt objects a:'
Export objects to library m:'
Export objects as PLCopen * a:'
Import chjects m:'
Generate library + ﬂ Tasks
Mowve Up Ctrl+Up
Move Down Ctrl+Down

Exclude all contents from build

7.4.2 AUTOMATIC EXCLUSION FROM BUILD

PLC IDE allows you to include a large number of libraries, but it may happen that a library
redefines a symbol previously included with another library, or simply already defined
inside the project.

In this case, the latest library inclusion, it is not aborted; it is completed raising a proper
warning message and automatically excluding the redefined element from the latest in-
cluded library.

Library Tree 4 ox

BE o
= B Project libraries
+ EEF Operators and blocks
g Torget
Bils Alarms
g, CORPM
B FileSystem
g, Modbus
B myFirstLibrary
EIF myFunction_A
EIF myFunction_B
-l-gilg~ mySecondLibrary
0r
EIF myFunction_C
g, PID
gz PLCConnect
fi;  Recipes
B Serial
gi;  Standard

[ e e 2 e AR S

o

Output

Preprocessing COFHM completed.

Preprocessing nyFirstlibrary completed.

Preprocessing nySecondlibrary completed.

warning P2086: mySecondlibrary: myFunction_ B =» Ubject i= already defined in the project and will be unloaded

1 warnings, 0 errors.

(©.0)
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7.4.3 EXCLUDING A PORTION OF CODE WITH IFDEF STATEMENT

PLC IDE allows you to exclude from the compilation only a specific portion of code and
checking if a certain symbol is defined, using the IFDEF feature.

IFDEF feature is always working for LD and FBD editor and for POU properties window;
but it needs to be explicitly enabled to be used into ST editor.

You can enable it by selecting Project -> options... -> Code generation tab and then check-
ing the Enable preprocessor directives checkbox.

Project options X

Case sensivity (IEC default=no)
Check functions and function blocks extemal variables
YAR_IN_OUT by reference {IEC standard=yes)

Allow only integer indexes for amays

Strict pointers check

I I I O Y R

Strict enumerations check

Enable SFC control flags (extension to |1EC standand)

O O

Imit to zero of functions intemal varables
Diata copy size waming threshold bytes, (=disable) 200
Enable preprocessor directives (extension to |EC standard)

Digable waming emission ]

Digabled waming codes:

QK Annulla 7

This feature will exclude from compilation the selected code only if a specified symbol has
not been defined; the symbol to be specified can be any symbol or POU (program, frun-
tion, function block, global variable...) but it must be GLOBALLY VISIBLE.

0.0
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7.4.3.1 USING IFDEF IN ST LANGUAGES

Inside an ST program, you can disable a portion of code including it inside the IFDEF
syntax.

{ IFLDEF : checkSymbol }

loopsWalus = 0;
for 1 := 0 to 15 do
Bit := (v + 0.9} = (0.125 % TO_REAL{1i)):

if bit then
loopsValus = loopsValus or REotateBiti{i):
end_if:
end_for:

i EHLDIF }

7.4.3.2 USING IFDEF IN LD LANGUAGES

Inside an LD program, you can put under IFDEF condition every single network, but not
just a portion of a network.

Open the network properties window, and insert the specific symbol to be checked.

DILD digital input DOL1 digtal output

fbDelay
inpLogicData TON outDelayed
|| Ly
11
S o
parTimOnDelay pT e parTimOnValue
‘ DiILO digital inp foCtu DOL2Z digital output
DILO digital input - Network properties X | DoL1 digial output
inpLogicData T Label: | cutDelayed
I N RS
*= Disabled: []
| .
New network — » 1 : Disable IF NOT DEF: | checkSymbol
parTimOnDelay
.
OK. Cancel
ooz TN o
CiILD digital input foCty DOL2 digital outp
0002 e o
{IFDEF} DILO digital input foDelay DOL1 digital output
inpLogicData TON outDelayed
{ | n a )
Ry g
parTimOnDelay T ET| parTimOnValug
n A t no al nutn
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7.4.3.3 USING IFDEF IN FBD LANGUAGES

Like LD language, also with FBD you can put under IFDEF condition every single network,
but not just a portion of a network.

Open the network properties window, and insert the specific symbol to be checked.

LowPassFilter
pidOutput in out | pidFeedback
[00s ] K

0003 |

oooz

wlatio Network properties x
Label:
New network  »
i Disabled:
LowPassFilter
i : checkSymbol
i out P Disable IF NOT DEF: eckSymbol
X
O Cancel

003 |

oooz
LELERS System response simulation using a low pass fiter

on the cutput

LowPassFilter
pidCutput in out]| pidFeedback
[o0s ] k

o003 |

7.4.3.4 IFDEF SUPPORTED FORMAT

The condition of a valid IFDEF syntax can be more complex thag just a globally visible
symbol; here’s some example of valid IFDEF syntax:

- {IFDEF: symbol_1}

- {IFDEF: symbol_1 AND symbol_2}

- {IFDEF: symbol_1 OR symbol_2%}

- {IFDEF: symbol_1 AND (symbol_2 OR symbol3)}
- {IFDEF: symbol_1 AND NOT symbol_2}

- {IFDEF: symbol_1 OR NOT symbol_2}

Be aware that currently, due to an implementation limit, the negation of an expression is
not supported; that means that the following syntax is NOT supported:

- {IFDEF: symbol_1 AND NOT (symbol_2 AND symbol_3}
The NOT statement must be used with a symbol, not with an expression.

© .0
PLC

108 Arduino PLC IDE user manual



ARDUINO PLC IDE

7.5 STANDARD IEC CONVERTION RULES

As described in chapter 4.6.2, by checking “Enable standard IEC type convertion rules” in
project/Options/Code generation tab, PLC IDE allows you to choose if use IEC standard
convertion rules or more permissive rules.

Using standard IEC convertion rules, PLC IDE will raise error/warning messagges if the
operation is not explicitly allowed by the standard.

7.5.1 TABLE OF STANDARD CONVERTION RULES

The following table shows cast rules between source type (rows) and destination type
(column) according to IEC 61131-3 standard.

The behaviour of some convertions are left implementer specific by the standard; the fol-
lowing table already include them, representing the final behave of PLC IDE.

I = Implicit cast done

E = Explicit cast required

= = Types are identical, no further actions needed

- = No cast allowed, convertion forbidden by the standard

SOURCE DESTINATION

r>mor
r>mpQ
- 2Z-r
-Z+~0
-2+
-2Z2+-W0
-Z=~rC
-2Z2=-0C
HZHC
-Z2~W0C
OXOSr
OXMO0OS0O
OmOS
m=<w
roow

LREAL
REAL
LINT
DINT
INT
SINT
ULINT
UDINT
UINT
USINT
LWORD
DWORD
WORD
BYTE
BOOL
LTIME
TIME
LDT

DT
LDATE
DATE - -
LTOD - - - - - - - -

|
m

mi|m

mimj|m

mim|m|m

mimj|mj|m|m

mim|mjm|m|m

mim|mjm|m|m|m

mimim|m|m{m|m|m

mimim|m|mjm|m|m|m

mimim|m|mim|m|m|m|m

mimimim|mim|m|m|m|m}|=

mimimimimim|m|m|mMm|Mm|=—|=—

mimim|im|m{m|m|m|M|Mm|Mm/|~—|+=—

mimim|im|mim|m|m{m|m|m|mj|m|m

mimim|—=|—=|—=|M|~—|— ]|~ |M|—~ |~~~
mjimjm|—=|—=|M|M|—~|—=|M|M|—=|=|Mm|Mm

mi|m

mimimim|m|{m|{mM|M|M|— || |M]|]|—]|—
mimimimmim|mMm|mM|M|—=|—=|M|M|—|—
mimimim|mimimm|m|=|m|m]|m|+=
mimimim|mimjm|m|m|m|{mj|{m|m
mimim|m|m|{m|M|Mm|M|~|—|—~
mimimim|m|m|Mm|Mm|Mm|=|=—
mimim|m|mjim|m|m|m|+—
mim|mim|m{m|mj|m|m
mim|m|m|—|—|—]|-
mimim|Mm|—=|— |

mimim|m|+—|—

mim|mj|m]|+—
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SOURCE

DESTINATION

r>maor

r>m2Zx

—“ZHr

—4Z~O

-2 -
-Z2-0
HZHrCc
-2Z2=-0C
HZH~C
-Z2=0NnC

OXMOSr

UXNOS0O

OmOS

m=-<w

roow

TOD

WSTRING

m

m
m
m
m
m
m

m

m

m

STRING

mi|m

mi|m

mi|m

mi|m

SOURCE

DESTINATION

m3--r

mIm--

-0r

-1 O
m=>»0r
m=1>»0
OOo-Hr

OO+

LREAL

REAL

LINT

DINT

INT

SINT

ULINT

UDINT

UINT

USINT

LWORD

DWORD

WORD

BYTE

BOOL

mimimim|mim|m|m|{m|m|m|m|m

mimimimmim|m|m|m|m|mj|m|m

mimimimmim|m|m|m|m|m|m|m
1
1
1

mim|m[m{m|m|m|m|m|m|m|m|m|m|m|@Z2~a-40nS

mimmm|m|mmm|m|m|m|m|{m|m|m| @2 =~30-0

LTIME

mimimimmim|m|m{m|{m|{m|m|m|m

TIME

LDT

DT

mi|m

LDATE

mjimj|m

DATE

LTOD

TOD

WSTRING

STRING
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7.5.2 DIRECT ASSIGNEMENT AND OPERATIONS

In case of direct assignement between varaibles (or typed constat), PLC IDE will apply the
required convertion rules; if the types are different and no implicit convertion is allowed,
PLC IDE will raise an error message.

In case of arithmetic or logic operations, between differently typed operand, the standard
requires that they must be converted to the same type, before the operation take place,
accordingly to the convertion table.

In case of operation between variables with different sign, PLC IDE automatically makes
an explicit convertion (if explicit cast between them is allowed) to the singed counterpart
of the unsigned type; then it makes the implicit cast on the smaller type, to make the two
types identical.

For example: USINT + DINT will be resolved as follow

- First USINT will be casted to SINT (the signed counterpart of USINT), which should be
an explicit cast.

- Then SINT is casted to DINT, which is an implicit cast.
- Now that both variables are of type DINT, the operation can take place.

(O 0]
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LAUNCHING THE APPLICATION

In order to download and debug the application, you have to establish a connection with
the target device. This chapter focuses on the operations required to connect to the tar-
get and to download the application, while the wide range of PLC IDE’s debugging tools
deserves a separate chapter (see Chapter 9).

SETTING UP THE COMMUNICATION

In order to establish the connection with the target device, make sure the physical link is
up (all the cables are plugged in, the network is properly configured, and so on).

Follow this procedure to set up and establish the connection to the target device:

1) Click On-line>Set up communication... menu of the PLC IDE main window. This causes
the following dialog box to appear.

DevicelinkManager Config 12.1.0.1 X
Selected protocol : GDB

Protocols Active i
| T FileLink
| ¥ coB Active
| W Kfm
=m
| %~ ModbusTCP
L3 nene.,

Activate
Description

Maodbus Protocol

OK Cancel

The elements in the list of communication protocols you can select from depend on
the setup executable(s) you have run on your PC (refer to your hardware provider if
a protocol you expect to appear in the list is missing).

2) Choose the appropriate protocol and make it the active protocol by clicking on the
activate button.

 DevicelinkManager Config 12.1.0.1 X

Selected protocol @ Modbus

Protocols Active £
H FileLink

Rl =
T kfm

F Modbus Active

™ ModbusTeP
S neno.. o -

Properties Activate
Description
Modbus Protocal
oK Cancel
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3) Now, by clicking on the Properties button, you can fill in all the protocol-specif-
ic settings (for example, the target address and baudrate or the communication
timeout - that is how long PLC IDE must wait for an answer from the target before
displaying a communication error message).

DevicelinkManager Config 12.1.0.1 X
Selected protocol ¢ Modbus

Pratocols B ebinae. Al

= FileLink Modbus Config 12.1.0.1 X
?GDB Communication
Kfm
Port -
W Modbus Camz
W ModbusTCP Baudrate -l
3 nena., =
Frame settings N.8.1 =
!
Descriptiol
Modbus Protocol
Pratocal
(@) Modbus Address |1
oK (C) Modbus ASCHl  Timeout | 1000
() Jbus

[ Enable remaote communication

Server name

] Enable modem communication

Dial number

oK Cancel

4) Apply the changes you made to the communication settings by pressing the OK but-
ton; otherwise, if you press the Cancel button, all changes will be undone.

Now you can establish a communication by clicking ¥ On-line>Connect menu.

8.1.1 SAVING THE LAST USED COMMUNICATION PORT

Given the fact that many modern PCs have only one COM port, you will usually use the
same port when connecting to target devices using a serial protocol; PLC IDE allows you
to save the last used COM port and configuration, in order to override the project setting
procedure. This feature proves especially useful when you share projects with other de-
velopers, which may use a different COM port to connect to the target device.

In order to save your COM port settings, enable the Use last port option in File>Options...
menu.

Program options X

i General ;-Graphic Editor !-Te::t Editors-i Language E-Custom tools !_Merge.!

Visual Theme
Color theme: Standard |
Save options Communication
Max previous versions to keep: {10 Use last port
& tooltip on editors
Output window Tool windows
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8.2 ON-LINE STATUS

At the bottom-right of PLC IDE window, next to the right border of the Status Bar, there
are other two boxes: the first is the application status, the second is the connection sta-
tus.

v
>

4 * | Operators and blocks 4 x
~  Name Type Group Description i
o.ocod . complete ABS Function Arithmetic Absolute value Computes the abs... -
Lacos Function Arithmetic Arc cosine Computes the principa...
[+]ADD Operator Arithrnetic Arithmetic addition
[7]aDR Operator Standard Address of
[E]anD Operator Logic Logical/bitwise AND
= L AsiN Function Arithrmetic Arc sine Computes the principal a...
¥ [=£] ATan Function Arithrmetic Arc tangent Computes the princi...

LlaTan | 2 Aritb oo cbic P R + Fnitls

Operator and standard blocks  Target variables
NETLAE  SOURCEOK | CONNECTED

8.2.1 APPLICATION STATUS

The application status box gives information about the status of the application currently
executing on the target device; such information are available only when you’re con-
nected with the target device.

The application can have on of the following status:
- No code: no application is executing on the target device.

NO CODE

- Diff. code: the application currently executing on the target device is not the same as
the one currently open in the IDE; moreover, no debug information consistent with the
running application is available: thus, the values shown in the watch window or in the
oscilloscope are not reliable and the debug mode cannot be activated.

DIFF. CODE

- Diff. code, Symbols OK: the application currently executing on the target device is
not the same as the one currently open in the IDE; however, some debug information
consistent with the running application is available (for example, because that applica-
tion has been previously downloaded to the target device from the same PC): the values
shown in the watch window or in the oscilloscope are reliable, but the debug mode still
cannot be activated.

DIFF. CODE (SYM)

- Source OK: the application currently executing on the target device is the same as the
one currently open in the IDE: the debug mode can be activated.

SOURCE DK

8.2.2 CONNECTION STATUS

The communication status gives you information about the status of the actual communi-
cation with the target device.

If you have not yet attempted to connect to the target, the status of communication is

(O 0]
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set to Not connected.

NOT CONNECTED
When you try to connect to the target device, the state of communication becomes one
of the following:

- Error: the communication cannot be established. You should check both the physical
link and the communication settings.

ERROR

- Connected: the communication has been correctly established.

COMNECTED

8.3 DOWNLOADING THE APPLICATION

A compiled PLC application must be downloaded to the target device in order to have
the processor execute it. This paragraph shows you how to send a PLC code to a target
device. Note that PLC IDE can download the code to the target device only if the latter is
connected to the PC where PLC IDE is running. See the related section for details.

To download the application, click = On-line>Download code .

PLC IDE checks whether the project has unsaved changes. If this is the case, it automati-
cally starts the compilation of the application. The binary code is eventually sent to the
target device, which then undergoes automatic reset at the end of transmission. Now the
code you sent is actually executed by the processor on the target device.

8.3.1 CONTROLLING SOURCE CODE DOWNLOAD

Whether the source code of the application is downloaded along with the binary code or
not, depends on the target device you are interfacing with: some devices host the appli-
cation source code in their storage, in order to allow the developer to upload the project
in a later moment.

If this is the case, you can control some aspects of the source code download process, as
explained in the following paragraphs.

8.3.1.1 PROTECTING THE SOURCE CODE WITH A PASSWORD

You may want to protect the source code downloaded to the target device with a pass-
word, so that PLC IDE will not open the uploaded project unless the correct password is
entered.

Click the Project>0Options... menu and set the password.

Project options =

| Build events | Cross Reference | R_q[]_—(ir_'n_e,ch,e:;{(;igiaqygl:lg_e_t_i___!
Gereral | Code generation | Build output | Download [ Debug |

Source code

Download time (On PLC application download j
Protect with password

Password

Debug symbols

Download time

OK Annulla 2

You may opt to disable the password, instead.
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8.3.1.2 SOURCE CODE AND DEBUG SYMBOLS DOWNLOAD TIME

8.4

8.5

As stated before, PLC IDE allows you to download also the source code on the target de-
vice; this way you can retrieve the source code in a later time having the certainty to work
with the exact project that is running on the target device.

The availability of this feature depends on the device implementation.

PLC IDE allows you to choose when the download of the source code must be done; from
the menu Project > Options > Download you can choose one of the following voices:

Project options X

| Buldeverts | Cross Reference | Funmechecks | Advanced |
General ]—Cndegenaratinn Build output | Download ‘ Debug

Source code

Download time [ Never -

: . On PLC application download |
Protechwih password. | ofors Gcornpection |
Password Never
Debug symbols
Download time

OK Annulla 2

- On PLC application download: the Source code will be downloaded to the target to-
gether with PLC application.

- Before disconnection: the Source code will be downloaded before target disconnection.
- Never: the Source code will be never downloaded to the target.

As well as the Source code, also the Debug symbols download time can be set using the
following select menu with the same options.

Project options X

‘Viﬂruwlde\tenrts : érugﬁefereqce r Hun{\mgghﬁ;f TAdvanceaﬁ‘
| General | Codegeneration | Buldoutput | Download | Debug |

Source code

Dowrload time [on PLC application download -
Protect with password

Password

Debug symbols

Download time | Mever |

On PLC application download 1
Before disconnection |
Never

OK Annulla ?

SIMULATION

Depending on the target device you are interfacing with, you may be able to simulate the
execution of the PLC application with PLC IDE’s integrated simulation environment: PLC
IDE.

In order to start the simulation, just click # Debug>Simulation mode .
Refer to PLC IDE’s manual to gain information on how to control the simulation.

CONTROL THE PLC EXECUTION

The PLC application execution can be controlled using the related functions in the project

bar or by the command presents in the On-line menu.
.
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8.5.1 HALT

You can stop the PLC execution by clicking = On-line>Halt

8.5.2 COLD RESTART

The PLC application execution will be restarted and both retain and non-retain variables
will be resetted.

You can cold restart the PLC execution by clicking ® On-line>Cold restart .

8.5.3 WARM RESTART

The PLC application execution will be restarted and only non-retain variables will be reset-
ted.

You can warm restart the PLC execution by clicking ® On-line>Warm restart .

8.5.4 HOT RESTART

The PLC application execution will be restarted and no variables will be resetted.
You can hot restart the PLC execution by clicking ® On-line>Hot restart .

8.5.5 REBOOT TARGET

You can reboot the target by clicking # On-line>Reboot target .
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DEBUGGING

PLC IDE provides several debugging tools, which help the developer to check whether the
application behaves as expected or not.

All these debugging tools basically allow the developer to watch the value of selected vari-
ables while the PLC application is running.

PLC IDE debugging tools can be gathered in two classes:

- Asynchronous debuggers. They read the values of the variables selected by the devel-
oper with successive queries issued to the target device. Both the manager of the de-
bugging tool (that runs on the PC) and, potentially, the task which is responsible to an-
swer those queries (on the target device) run independently from the PLC application.
Thus, there is no guarantee about the values of two distinct variables being sampled in
the same moment, with respect to the PLC application execution (one or more cycles
may have occurred); for the same reason, the evolution of the value of a single variable
is not reliable, especially when it changes fast.

- Synchronous debuggers. They require the definition of a trigger in the PLC code. They
refresh simultaneously all the variables they have been assigned every time the proces-
sor reaches the trigger, as no further instruction can be executed until the value of all
the variables is refreshed. As a result, synchronous debuggers obviate the limitations
affecting asynchronous ones.

This chapter shows you how to debug your application using both asynchronous and syn-
chronous tools.

WATCH WINDOW

The Watch window allows you to monitor the current values of a set of variables. Being
an asynchronous tool, the Watch window does not guarantee synchronization of values.
Therefore, when reading the values of the variables in the Watch window, be aware of
the possibility that they may refer to different execution cycles of the corresponding task.

The Watch window contains an item for each variable that you added to it. The informa-
tion shown in the Watch window includes the name of the variable, its value, its type, and
its location in the PLC application.

E B % AR ¢« t v g

Symbol Value Type Location Desi ™
- 67.439 REAL @SLOW:LOOPS
w -0.993 REAL @SLOW:LOOPS
— INCR 0.010 REAL @ELOW:LOOPS
—_ ] UINT @SLOW:LOOPS
mm BIT TRUE BOOL @SLOW:LOOPS -
- [] PRESSED - BOOL[] @SLOW:LOOPS -
[0] FALSE BOOL @ELOW:LOOPS
[1] FALSE BOOL @SLOW:LOOPS
[2] FALSE BOOL @SLOW:LOOPS
[3] FALSE BOOL @SLOW:LOOPS
[4] FALSE BOOL @ELOW:LOOPS
[5] FALSE BOOL @SLOW:LOOPS
[61 FALSE BOOL @SLOW:LOOPS v
< ] b3
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9.1.1 OPENING AND CLOSING THE WATCH WINDOW

To open, close the Watch window, click & View>Tool windows>Watch .

Closing the Watch window means simply hiding it, not resetting it. As a matter of fact, if
you close the Watch window and then open it again, you will see that it still contains all
the variables you added to it.

9.1.1.1 WATCH VARIABLES EDITOR

A particular implementation of the watch window is available from the variables editor
(both global and local); on the right side of the variables editor you’ll see three tabs:

Local variables

Mame Type Address Aray Init value Aftr @
1 |x REAL Auto Mo ..
2 |y REAL Auto Ma .
3 |incr REAL Auto Mo 0.01
4 | UINT Auto Mo
5 |bit BOOL Auto Mo
& |previnp BOOL Auto [0.63]
7 ipressed BOOL Auto [0.7]
< m >

The third one, when pressed, will turn the variables editor into a watch window, where
all the variables of the editor are already added to the list and their values are shown:

Local variables

Symbol Value Type Location ~ HH
- 4783.287 REAL @SLOW:LOOPS
v 0.930 REAL @SLOW:LOOPS
— INCR 0.010 REAL @SLOW:LOOPS _
— 1 8 UINT @SLOW:LOOPS = ar
mm BIT TRUE BOOL @SLOW:LOOPS
+| [] PREVINP - BOOL[] @SLOW:LOOPS
-/ [] PRESSED - BOOLI] @SLOW:LOOPS
[0 FALSE BOOL @SLOW:LOOPS
[1] FALSE BQOL @SLOW:LOOPS
[2] FALSE BOOL @SLOW:LOOPS
[3] FALSE BOOL @SLOW:LOOPS 7
< 1] »

No other variables can be added to this list and the variables in this list cannot be re-
moved.

9.1.2 ADDING ITEMS TO THE WATCH WINDOW

To watch a variable, you need to add it to the watch list.

Note that, unlike trigger windows and the Graphic trigger window, you can add to the
Watch window all the variables of the project, regardless of where they were declared.

0.0
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9.1.2.1 ADDING A VARIABLE FROM A TEXTUAL SOURCE CODE EDITOR

Follow this procedure to add a variable to the Watch window from a textual (that is, IL
or ST) source code editor: select a variable, by double-clicking on it, and then drag it into
the watch window.

"y B % DA ¢ t v T
EA ilﬁ(ﬂén Symbal Value Type Location Des A
=| ax 180.347 REAL @SLOWLOOPS
loopstalue = 0 v -0.954 REAL @SLOWLOOPS
for 1 := 0 to 15 do — INCR 0.010 REAL @SLOW:LOOPS
Bit = (¥ + 0.9) » {0.125 = TO_REAL(i}}. _ . Nt PSLOWLOCPS
it bit then R . e -—IT TRUE BOOL @SLOWLOOPS .
angfoorsYatus = loopsValue or BotateBit(l oy ppessep - BOOL(] @SLOW:LOOPS
end_for, 0] FALSE BOOL @SLOWLOOPS
m FALSE BOOL BSLOWLOOPS
(% uses pid to nove value up and down *) 12 FALSE BOOL @SLOWLOOPS
loops¥alus = 0 '
poopstialue 0 b 12 FALSE BOOL @SLOWLOOPS
bit := (pidFeedhack + 10.0) > (1.25 = TO_RE 14] FALSE BOOL @SLOWLOOPS
< = 5 5] FALSE BOOL @SLOWLOOPS
181 FALSE BOOL @SLOWLOOPS d
Loops I bvX|< 1] >

The same procedure applies to all the variables you wish to inspect.

9.1.2.2 ADDING A VARIABLE FROM A GRAPHICAL SOURCE CODE EDITOR

Follow this procedure to add a variable to the Watch window from a graphical (that s, LD,
FBD, or SFC) source code editor:

1) Click =2 Edit>Watch mode .

2) Click on the block representing the variable you wish to be shown in the Watch win-
dow.

=] Resources 1 Elevator B fod1 -

Local variables

Name Type Address Array Initvalue Attribute
1 |start1 BOOL Auto No
2 |start2 BOOL Auto Mo
3 |ready BOOL Auto Mo
4 |run BOOL Auto No
5 |x BOOL Auto Ne

0001

run

A dialog box appears listing all the currently existing instances of debug windows, and
asking you which one is to receive the object you have just clicked on.

Debug windows list X

Symbol to add:
inpLogicData

Debug windows

Osdlloscope
oK Cancel

In order to display the variable in the Watch window, select Watch, then press OK.
The variable name, value, and location are now displayed in a new row of the Watch win-
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dow.

E H % B &« t v @

Symbol Value Type Location Desi ™
-~ 67.439 REAL @SLOW:LOOPS
' -0.993 REAL @5LOW:LOOPS
— INCR 0.010 REAL @5LOW:LOOPS
—_ 8 UINT @5LOW:LOOPS

mm BIT TRUE BOOL @SLOW:LOOPS -

- [ PRESSED - BOOLI] @5LOW:LOOPS -
[0] FALSE BOOL @5LOW:LOOPS

[1] FALSE BOOL @SLOW:LOOPS

The same procedure applies to all the variables you wish to inspect.

Once you have added to the Watch window all the variables you want to observe, you
should click » Edit>Insert/Move mode : the mouse cursor turns to its original shape.

9.1.2.3 ADDING A VARIABLE FROM A VARIABLES EDITOR

In order to add a variable to the Watch window, you can select the corresponding record
in the variables editor and then either drag-and-drop it in the Watch window

Local variables Watch
Name - Type  Address _ Amay Init value Atibut ~ | FFH B e DER ¢ 4 @
REAL Aute Mo - _|__|| Symbol Value Type Location
fEns S 0 - i - 136.451 REAL @SLOWLOOPS
REAL Auto Mo 0.01 k
UINT Auto Mo >
| BOOL Auto Mo w
< i >
or press the F8 key.
Localvaliabies . .Watch
Name Type Address Aray Init value Bgtribut ~ @‘ ‘B o W R Bl t v &
ik | _REN— Auto No - Symbol Value Type Location
2 : LT Hp : ) -x 241933 REAL @SLOW:LOOPS
Sama REAL Aty Mo L __4 vy -0.021 REAL @SLOW:LOOPS
4 i UINT Auto Mo .
5 |bit BOOL Auto No . v e‘j
< 1] > [

9.1.2.4 ADDING A VARIABLE FROM THE PROJECT TREE

In order to add a variable to the Watch window, you can select it in the project tree and
then either drag-and-drop it in the Watch window

Watch
P LadderLogic ~ B e IIENE ¢ t 4 A
-I-EP Loops
- B Local variables
bit . 358123 REAL @SLOW:LOOPS
[ui] i
0] incr k
pressed ]
previnp
X

Of

#=p PidControl

Symbol Value Type Location

or press the F8 key.
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et ’x
P LadderLegic ~ B e TEEE ¢« t 4 &
- [ZP Loops
- Bl Local variables
bit - 409.087 REAL @SLOW:LOOPS

[ui] i L 0.621 REAL @SLOW:LOOPS
[r] iner

pressed

previnp

] x

@

Symbal Value Type Location De

9.1.2.5 ADDING A VARIABLE FROM THE WATCH WINDOW TOOLBAR

You can also click on the appropriate item of the Watch window inner toolbar, in order to
add a variable to it.

Watch oo

@msﬂ«ee@

You shall type (or select by browsing the project symbols) the name of the variable and
its location (where it has been declared).

Add item to watch window X
Symbol name ¥ Browse Address

Location Loops Browse

oK Cancel

9.1.3 REMOVING A VARIABLE

If you want a variable not to be displayed any more in the Watch window, select it by
clicking on its name once, then press the Del key.

If you want to remove all item from the Watch window, select the following icon:

Watch Lox

£+amm++ &

9.1.4 REFRESHMENT OF VALUES
9.1.4.1 NORMAL OPERATION

The watch window manager reads periodically from memory the value of the variables.

However, this action is carried out asynchronously, so it may happen that a higher-priority
task modifies the value of some of the variables while they are being read. Thus, at the
end of a refreshment process, the values displayed in the window may refer to different
execution states of the PLC code.

9.1.4.2 TARGET DISCONNECTED

If the target device is disconnected, the Value column contains three dots.

(O 0]
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Watch

B %o WERE ¢ 1t L @

Symbol Value Type Location
X REAL @SLOW:LOOPS
Y REAL @SLOW:LOOPS

9.1.4.3 OBJECT NOT FOUND

If the PLC code changes and PLC IDE cannot retrieve the memory location of an object in
the Watch window, then the Value column contains three dots.

Watch
B e WIERE ¢ 1 4 a
Symbal Value Type Location
- 20,049 REAL @SLOW:LOOPS
¥ REAL @SLOW:LOOPS

PLC IDE does not allow you to add to the Watch window a symbol which has not been al-
located, any attempt will be ignored.

9.1.5 CHANGING THE FORMAT OF DATA

When you add a variable to the Watch window, PLC IDE automatically recognizes its type
(unsigned integer, signed integer, floating point, hexadecimal...), and displays its value
consistently. Also, if the variable is floating point, PLC IDE assigns it a default number of

decimal figures.

However, you may need the variable to be printed in a different format.

To impose another format than the one assigned by PLC IDE, press the Format value but-
ton in the toolbar.

Watch

O XEEEEEEL

Symbol Value Type Lecation De
-~ 146.216 REAL @SLOW:LOOPS

Choose the format and confirm your choice.

Value format X Value format X
Format Farmat
oK oK
Cancel Cancel
(®) Float (_IFloat
() Hexadecimal (®) Hexadecimal
= g

Float format Float format

Number of decimal 3 Number of decimal

0.0
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B e BERE ¢ ¢t g
Symbol Value Type Lecation De
- 16#438AEA42  REAL @SLOW:LOOPS

9.1.6 WORKING WITH WATCH LISTS

You can store to file the set of all the items in the Watch window, in order to easily restore
the status of this debugging tools in a successive working session.

Follow this procedure to save a watch list:
1) Click on the corresponding item in the Watch window toolbar.

o B« 1t 4 &
Symbol Value Type Location De
-y 482,694 REAL @SLOW:LOOPRS

2) Enter the file name and choose its destination in the file system.

L3 Watch list file X
€ . 4 » QuestoPC » Desktop » WatchLists v | B O Cercain WatchLists
Orgenizza v Nuova cartella A ]

@ OneDrive  # A Nome Ultima modifica Tipo Dimensione
[ Desktop *
[5] Documenti  #

& Download  # =
-

MNessun elementa corrisponde ai criteri di ricerca,

&=| Immagini

.| Book

,  Immagini comu
Manuale

PrjDoc
@ OneDrive

[ Questo PC
[ Desktop

=] Nrimmant

Nome file: -

Salva come: |Watch list extended file(*wlsx) -

v

A Nascondi cartelle Salva Annulla

When loading a watch list from file, you have two options: you can load the items from
file and append them to the items currently shown in the watch window; or you can auto-
matically clear the watch window and display only the items loaded from file. Either way,
follow this procedure and choose the desired option:

1) Click on the corresponding icon in the Watch window toolbar. The one labeled Load
(no appends) watch list will remove all currently displayed elements and show only
the ones loaded from file; the icon labeled Load watch list will append them instead.

Symbol Value Type Location De
-~ K 814,793 REAL @SLOW:LOOPS

2) Browse the file system and select the watch list file.
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Watch list file x

T » Questo PC » Desktop WatchLists v [J] Cerca in WatchLists

Organizza v Nuova cartella B2~ [ 0
PriDec Gl Mome Ultima modifica Tipo L
@ OneDrive | theWatch.wlsk 12/05/2020 11:23 File WLSX

[ Questo PC
Desktop
= Decumenti
4 Download
= Immagini
D Musica
§ Oggetti 3D
B video
‘Za Windows7_0S5 (C:)
- MIGLIO M (E)
= Work (L)

- MIGLIO M (E) v o< [} >

MNome file: ‘tha\’\"at:h.w\sx - |WatchI\sta(tendadﬂ\e(*‘w\sxj -

Apri - Annulla

The set of symbols in the watch list is added to the Watch window.

9.1.7 AUTOSAVE WATCH LIST

9.2

(©.C)
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By selecting the associated option in the project options dialog (see Paragraph 4.6.5 for
more info) the watch list will be automatically saved on the project closing.

The saved watch list will be automatically loaded (with no append option) on the first con-
nection to target when the project will be re-opened.

OSCILLOSCOPE

The Oscilloscope allows you to plot the evolution of the values of a set of variables. Be-
ing an asynchronous tool, the Oscilloscope cannot guarantee synchronization of samples.

Opening the Oscilloscope causes a new window to appear next to the right-hand border
of the PLC IDE frame. This is the interface for accessing the debugging functions that the
Oscilloscope makes available. The Oscilloscope consists of three elements, as shown in
the following picture.

HHMEBE @ AH BREAT = n b WG &

Track Um Min value Max value

The toolbar allows you to better control the Oscilloscope. A detailed description of the
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function of each control is given later in this chapter.
The Chart area includes several items:
- Plot: area containing the curve of the variables.

- Vertical cursors: cursors identifying two distinct vertical lines. The values of each vari-
able at the intersection with these lines are reported in the corresponding columns.

- Scroll bar: if the scale of the x-axis is too large to display all the samples in the Plot
area, the scroll bar allows you to slide back and forth along the horizontal axis.

The lower section of the Oscilloscope is a table consisting of a row for each variable.

9.2.1 OPENING AND CLOSING THE OSCILLOSCOPE

To open, close the Oscilloscope, click ® View>Tool windows>Oscilloscope .

Closing the Oscilloscope means simply hiding it, not resetting it. As a matter of fact, if you
open again the Oscilloscope after closing it, you will see that plotting of the curve of all
the variables you added to it starts again.

9.2.2 ADDING ITEMS TO THE OSCILLOSCOPE

9.2.2.

In order to plot the evolution of the value of a variable, you need to add it to the Oscil-
loscope.

Note that unlike trigger windows and the Graphic trigger window, you can add to the Os-
cilloscope all the variables of the project, regardless of where they were declared.

1 ADDING A VARIABLE FROM A TEXTUAL SOURCE CODE EDITOR

Follow this procedure to add a variable to the Oscilloscope from a textual (that is, IL or
ST) source code editor: select a variable by double-clicking on it, and then drag it into the
Oscilloscope window.

loopsWalus := 0:
for i = 0 terlh da
bit = (y + 0.9) » (0.125 = TO_REAL(i)):

if bit then
loopsValus := loopsValus or RotateBit(i):
end_if:
end_for:

(* uzesz pid to move walus up and down =)
loopsWalus := 0:
for i := 0 to 15 do
bit = (pidFeedback + 10.0) > (1.25 = TO_REAL(i)}):

if bit then e
m >

The same procedure applies to all the variables you wish to inspect.

9.2.2.2 ADDING A VARIABLE FROM A GRAPHICAL SOURCE CODE EDITOR

Follow this procedure to add a variable to the Oscilloscope from a graphical (that is, LD,
FBD, or SFC) source code editor:

1) Click 2 Edit>Watch mode .
2) Click on the block representing the variable you wish to be shown in the Oscilloscope.

@FAST:PIDCOMTROL PL..
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3) Adialog box appears listing all the currently existing instances of debug windows, and
asking you which one is to receive the object you have just clicked on.

Debug windows list X
Symbal to add:
¥
Debug windows
Watch
Osdlloscope
oK Cancel

Select Oscilloscope, the press OK. The name of the variable is now displayed in the
Track column.

The same procedure applies to all the variables you wish to inspect.

Once you have added to the Oscilloscope all the variables you want to observe, you should
click » Edit>Insert/Move mode : the mouse cursor turns to its original shape.

9.2.2.3 ADDING A VARIABLE FROM A VARIABLES EDITOR

In order to add a variable to the Oscilloscope, you can select the corresponding record in
the variables editor and then either drag-and-drop it in the Oscilloscope

Local variables Oscilloscope

Type | Address | Aray | Init walue | Atribute | ~ & m E @ L_J % % |:| & |ELD L]

1] : Auto Mo

2 ly REAL Auta Nao = B I LU R
3 iner REAL Auto No 0.01 | '
4 i UINT Auto MNa ) an

5 |bit BOOL Auto No i v|

£ m >

or press the F10 key and choose Oscilloscope from the list of debug windows which pops
up.

Debug windows list X
Symbaol to add:
Y
Debug windows
Watch

Osdlloscope
oK Cancel

9.2.2.4 ADDING A VARIABLE FROM THE PROJECT TREE

In order to add a variable to the Oscilloscope, you can select it in the project tree and then
either drag-and-drop it in the Oscilloscope

0.0
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EP Init
=P Ladderlogic
+- H Local variables
=-[ZP Loops
- B Local variables
bit
[ i
1] iner
pressed
previnp
] x
Lr] Track Um M

®=P PidControl
E—igp PidModeSelector
gltP nnn
- @® Parameters

or press the F10 key and choose Oscilloscope from the list of debug windows which pops

up.
Debug windows list X
Symbol to add:
¥
Debug windows
Watch

oK Cancel

9.2.3 REMOVING A VARIABLE

If you want to remove a variable from the Oscilloscope, select it by clicking on its name
once, then press the Del key.

9.2.4 VARIABLES SAMPLING
9.2.4.1 NORMAL OPERATION

The Oscilloscope manager periodically reads from memory the value of the variables.

However, this action is carried out asynchronously, that is it may happen that a higher-
priority task modifies the value of some of the variables while they are being read. Thus,
at the end of a sampling process, data associated with the same value of the x-axis may
actually refer to different execution states of the PLC code.

9.2.4.2 TARGET DISCONNECTED

If the target device is disconnected, the curves of the dragged-in variables get frozen,
until communication is restored.

9.2.5 CONTROLLING DATA ACQUISITION AND DISPLAY

The Oscilloscope includes a toolbar with several commands, which can be used to control
the acquisition process and the way data are displayed. This paragraph focuses on these
commands.

Note that all the commands in the toolbar are disabled if no variable has been added to
the Oscilloscope.

(O 0]
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9.2.5.1 STARTING AND STOPPING DATA ACQUISITION

When you add a variable to the Oscilloscope, data acquisition begins immediately.
However, you can suspend the acquisition by clicking on Pause acquisition.

Oscilloscope L

HHEHEER 8 a8 |RE n WG =

The curve freezes (while the process of data acquisition is still running in background),
until you click on Restart acquisition.

Oscilloscope 4 x
HEHEERE a8 RRAD = O &

In order to stop the acquisition you may click on Stop acquisition.

Oszcilloscope L ox
DEHEE 38H ||e. » B REP &

In this case, when you click on Restart acquisition, the evolution of the value of the vari-
able is plotted from scratch.

9.2.5.2 SETTING THE SCALE OF THE AXES

0.0
PLC

When you open the Oscilloscope, PLC IDE applies a default scale to the axes. However, if
you want to set a different scale, you can do that by opening the graph properties clicking
on the corresponding icon in the toolbar:

HHME @ SH BREAD = W d 5150 &

The graph settings window will open, allowing you to change both the vertical and the
horizontal axis.

The horizontal scale is the same for every track.

The vertical scale can be different for every variable, you can specify the desired scale in
the edit box labeled Value/div.

Syncronous oscilloscope settings X
Show grid Horizontal scale | 3.9 samples div
Show time bar Buffer size 100 samples  {max. 65535)

Show tracks list Condition

Tracks list
Mame Unit Valuefdiv Offset Hide
L4 0.0455135 0.813941 D
X 0.12085 6243.52 L]
QK Cancel
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9.2.5.3 CHANGE THE ZOOM

In the Oscilloscope toolbar you can also find icons for zoom in and out, and also to force
the Oscilloscope to display all the sample.

These options are axis-related, so you can zoom in, zoom out and show all samples for
the horizontal axis alone:

Oscilloscope 4 x
EIELD] v EDER

as well as you can zoom in, zoom out and show all samples for the vertical axis alone:

Oscilloscope 4 x

HEE & E_L- 1 EINGEE

You can also quickly force the oscilloscope to display all samples for both horizontal and
vertical axis (which means show all values) with a specific icon:

Oscilloscope 4 x

BEHRERaE @aam « «fF WO =

9.2.5.4 VERTICAL SPLIT

When you are watching the evolution of two or more variables, you may want to split
the respective tracks. For this purpose, click on the Vertical split item in the Oscilloscope
toolbar.

To separate traces you can also manually move them; to do so grab the corresponding
coloured flag on the left of the chart and drag it to the desired location.

Oscillescope

EEEE L 8E REALD = ok "W B M=
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9.2.5.5 VIEWING SAMPLES

If you click on the Show samples item in the Oscilloscope toolbar, the tool highlights the
single values detected during data acquisition.

B

Oscilloscope
E@@ E_lE||E.LD:|... 1 Eii :ﬂi:"

96145

You can click on the same item again, in order to go back to the default view mode.

9.2.5.6 TAKING MEASURES

The Oscilloscope includes two measure bars, which can be exploited to take some meas-
ures on the chart; in order to show and hide them, click on the Show measure bars item
in the Oscilloscope toolbar.

Oscilloscope

ME 88K RRG]

If you want to measure a time interval between two events, you just have to move one
bar to the point in the graph that corresponds to the first event and the other to the point
that corresponds to the second one.

] B B e BE[E] =l WG

g

The time interval between the two bars is shown in the top left corner of the chart.

You can use a measure bar also to read the value of all the variables in the Oscilloscope
at a particular moment: move the bar to the point in the graph which corresponds to the
instant you want to observe.

In the table below the chart, you can now read the values of all the variables at that par-
ticular moment.

(©.C)
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In addition to the vertical bar, by enabling the measure bars, you will also find two hori-
zontal bars on the right of the grid. They work the same way of the vertical bars, but they
take values on the vertical axis.

Like the vertical bars, also the horizontal bars have their values displayed for every vari-
able in the table below the chart.

£ Curs Vred

9.2.5.7 OSCILLOSCOPE SETTINGS

You can further customize the appearance of the Oscilloscope by clicking on the Graph
properties item in the toolbar.

BHEE @8- BRAE = fu d G150 &

In the window that pops up you can choose whether to display or not the Background
grid, the Time slide bar, and the Track list.

9.2.5.8 CHANGING THE POLLING RATE

PLC IDE periodically sends queries to the target device, in order to read the data to be
plotted in the Oscilloscope.

The polling rate can be configured by modifying the Sample polling rate voice in the Oscil-
loscope settings window.

Note that the actual rate depends on the performance of the target device, in particular
on the performance of its communication task.

(O 0]
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Oscilloscope settings X
Show grid Sample polling rate | 20 ms Real rate
Show time bar Horizontal scale 5000 ms/div 21.73
Show tracks list Buffer size 40000 samples
Tracks list

[TET 1 lmit tmh v deding [ao =Ry Uid=

9.2.6 SAVING, RESTORING AND PRINTING THE GRAPH

PLC IDE allows you to persist the acquisition either by saving the data to a file or by print-
ing a view of the data plotted in the Oscilloscope.

9.2.6.1 SAVING DATA TO A FILE

You can save the samples acquired by the Oscilloscope to a file, in order to further analyze
the data with other tools.

1) You may want to stop acquisition before saving data to a file.
2) Click on the Save tracks data into file in the Oscilloscope toolbar.

QOscilloscope

HHEHEE & a8 & -& T

3) Choose between the available output file format: osc is a simple plain-text file, con-
taining time and value of each sample; OSCX is an XML file, that includes more
complete information, which can be further analyzed with another tool, provided
separately from PLC IDE.

4) Choose a file name and a destination directory, then confirm the operation.

9.2.6.2 RESTORING DATA INTO THE GRAPH (CURRENTLY NOT IMPLEMENTED)

The oscilloscope allows you to restore data previously saved on file; you have two option
to do so: Load and append graph data or Load (no append) graph data.

Oscilloscope

B B4 B B B EAMH BEERT = [u @

In both cases you'll have to select the OSC (or OSCX) file to load; then if you've choose
to load and append, the data taken from the file will be added to the list of those al-
ready inside the oscilloscope; if you've choose to load without append, the variables list
of the oscilloscope will be cleared before adding the data taken from the file.

9.2.6.3 PRINTING THE GRAPH

Follow this procedure to print a view of the data plotted in the Oscilloscope:
1) Either suspend or stop the acquisition.

2) Only the elements included in the view will be printed, so move the time slide bar
and adjust the zoom, in order to include in the view the elements you want to print.

3) Click on the Print graph item.

Oscilloscope

DEEM® aas _aRm [ @ w0 s )
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EDIT AND DEBUG MODE

While both the Watch window and the Oscilloscope do not make use of the source code,
all the other debuggers do: when debug mode is on, changes to the source code are in-
hibited and debug tools become active.

PLC IDE automatically enables debug mode when at least one of the following conditions
are met:

- at least one breakpoint is correctly set.
- At least one trigger (graphic or textual) is correctly set.
- Live debug mode is on.

When all the conditions above are not met, the debug mode automatically switches off
and PLC IDE enters in edit mode.

The status bar shows whether the debug mode is active or not.

1 AT»]3l SOURCEOK | CONNECTED

Note that you cannot enter the debug mode if the connection status differs from Con-
nected.

LIVE DEBUG

PLC IDE can display meaningful animation of the current and changing state of execution
over time of a Program Organization Unit (POU) coded in any IEC 61131-3 programming
language.

To switch on and off the live debug mode, you may click *# Debug>Live debug mode .

9.4.1 SFC ANIMATION

As explained in the relevant section of the language reference, an SFC POU is structured
in a set of steps, each of which is either active or inactive at any given moment. Once
started up, this SFC-specific debugging tool animates the SFC documents by highlighting
the active steps.

. . . . Animation ON in hold
Animation OFF Animation ON
status
Init nt Init
TRUE é TRUE
s1 ‘ s3 ‘ a1 ‘ s2 ‘
21[P] 21[P] 21[P] 24[P]
Az[N] Az[N] 2z[N] 2z[N]
eﬁ Scrivival eﬁ CtriDown eﬁ Scrivival eﬁ CtriDown
s2 ‘ E ‘ 52 ‘ 54 ‘
21[P] A2[N] 21[P] 22[N]
T T T T
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In the left column, a portion of an SFC network is shown, diagram animation being off.

In the middle column the same portion of network is displayed when the live debug mode
is active. The picture in the middle column shows that steps s1 and s3 are currently ac-
tive, whereas 1nit, $2, and s4 are inactive.

In the right column the same portion of network is displayed with steps s1 and s3 that are
currently active but in hold status.

This may occur in SFC blocks when they are children of a parent in inactive status.

Note that the SFC animation manager tests periodically the state of all steps, the user not
being allowed to edit the sampling period. Therefore, it may happen that a step remains
active for a slot of time too short to be displayed.

The fact that a step is never highlighted does not imply that its action is not executed, it
may simply mean that the sampling rate is too slow to detect the execution.

9.4.1.1 DEBUGGING ACTIONS AND CONDITIONS

As explained in the SFC language reference, an action can be assigned to a step, and
a transition can be associated with a transition code (condition). Actions and transition
codes can be coded in any of the IEC 61131-3 languages (except SFC for transition code).
General-purpose debugging tools can be used within each action/condition, as if it was a
stand-alone POU.

9.4.2 LD ANIMATION

In live debug mode, PLC IDE displays the values of all the visible variables directly in the
graphical source code editor.

Cezd oCtd

CTD_UDINT

inpLogicData outCountDown
15l

1P o
inpLogicReset 321~
f————{w | = @
PV

100[parCtDownPreset

aoCtDownValie

o

Note that the LD animation manager tests periodically the state of all the elements. It
may happen that an element remains true for a slot of time too short to be displayed
on the video. The fact that an element is never highlighted does not imply that its value
never becomes true (the sampling rate may be too slow).

9.4.3 FBD ANIMATION

In live debug mode, PLC IDE displays the values of all the visible variables directly in the
graphical source code editor.

PID regulator
oPid PID regulation is OK if target is inside threshold
RO o e
-10.7082 [pidFeedback > factual ¥ m LE
-10[pidSelpoint > {=et point diff < FALSE
— noise: lim [~ 02
« offset overflow FALSE
= manual_in
| manual
False[mpPiRessl »>———rst
int_band
0.1 ™
! o G
= limit_L
o limit_H

Note that the LD animation manager tests periodically the state of all the elements. It
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may happen that an element remains true for a slot of time too short to be displayed
on the video. The fact that an element is never highlighted does not imply that its value
never becomes true (the sampling rate may be too slow).

9.4.4 IL AND ST ANIMATION

The live debug mode also applies to textual source code editors (the ones for IL and ST).
The values of a variable is directly displayed in a green box just at the right of the vari-
able.

¥y -0 481671 = SIN(x 162327 3
= 462 327 == 462327 + incr 0.0l

loopsV¥alue 16#005F = 0
for i 2 =0 to 15 do
bit FALSE := (v —0.481671 + 0.9) » (0.125 = TO _REAL(di 8 13

if bit FALSE then
loopsValus 16#005F = loopsValues 16#005F or RotateBit(i g T
end_if:
end_for;

(* uzesz pid to move walue up and down *)
loopsValue 16#005F = 0
for i 2 = 0 to 15 do
bit FALSE := (pidFeedback  -2.66368 + 10.0) » (1.25 = TO REAL(i 8 1)

if bit FALSE then

9.5 TRIGGERS
9.5.1 TRIGGER WINDOW

The Trigger window tool allows you to watch the value of a set of variables and to have
them updated synchronously in a special pop-up window.

9.5.1.1 PRE-CONDITIONS TO OPEN A TRIGGER WINDOW

No need for special compilation

PLC IDE debugging tools operate at run-time. Thus, unlike other programming languages
such as C++, the compiler does not need to be told whether or not to support trigger
windows: given a PLC code, the compiler’s output is unique, and there is no distinction
between debug and release version.

Memory availability

A trigger window takes a segment in the application code sector, having a well-defined
length. Obviously, in order to start up a trigger window, it is necessary that a sufficient
amount of memory is available, otherwise an error message appears.

Incompatibility with graphic trigger windows

A graphic trigger window takes the whole free space of the application code sector. There-
fore, once such a debugging tool has been started, it is not possible to add any trigger
window, and an error message appears if you attempt to start a new window. Once the
graphic trigger window is eventually closed, trigger windows are enabled again.

Note that all the trigger windows existing before the starting of a graphic trigger window
keep working normally. You are simply not allowed to add new ones.

9.5.1.2 SET AND REMOVE TRIGGERS

From the Debug menu you can select the appropriate voice for work with triggers.
Triggers can be palced only if a valid connection is established and the PLC is currently

executing.
(O 0]
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From the Debug menu you can choose the following voices:
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Icon in
Command debug Description
toolbar

In order to actually start a trigger window, select
the point of the PLC code where to insert the
Add/Remove text o relative trigger and then press this button or use
trigger the shortcut pressing F9.

Do the same to remove the trigger.

This button operates exactly as the above Set/
Remove trigger, except for that it opens a graphic
trigger window. It can be used likewise also to
remove a graphic trigger window. Shortcut key:
pressing Shift + F9.

Pressing this key causes all the existing trigger
windows and the graphic trigger window to be
Remove all triggers - removed simultaneously. Shortcut key: pressing
Ctrl+Shift+F9 is equivalent to clicking on this
button.

This key opens a dialog listing all the existing
trigger windows. Shortcut key: pressing Ctr/+I is
equivalent to clicking on this button.

Add/Remove 1
graphic trigger

[hé

Trigger list

Trigger list X

Type  Module Line Open

T COUNTER 4
T PIDCONTROL A1

Remove

Remove all

OK

Each record refers to a trigger window, either graphic or textual. The following table ex-
plains the meaning of each field.

Field Description
T: trigger window.
Type I :
G: graphic trigger window.
Name of the program, function, or function block where
Module the trigger is placed. If the module is a function block, this

field contains its name, not the name of its instance where
you actually put the trigger.

For the textual languages (IL, ST) indicates the line in
Line which the trigger is placed. For the other languages the
value is always -1.

0.0
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9.5.1.3 TRIGGER WINDOW INTERFACE

Setting a trigger causes a pop-up window to appear, which is called Interface window:
this is the interface to access the debugging functions that the trigger window makes
available. It consists of three elements, as shown below.

Trigger n® 1 at COUNTERZ4 B
o - oo TN
Condition
Trigger
Symbal Value Type Location
L 4 1] >

Caption bar

The Caption bar of the pop-up window shows information on the location of the trigger
which causes the refresh of the Variables window, when reached by the processor.

The text in the Caption bar has the following format:

Trigger n° X at ModuleName#Location

where
X Trigger identifier.
Name of the program, function, or function block where
ModuleName i
the trigger was placed.

(O 0]
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Exact location of the trigger, within module ModuleName.
If ModuleName is in IL, Location has the following format:
N1

Otherwise, if ModuleName is in FBD, it becomes:
N2$BT:BID

where:

N1

Location

instruction line number

network number
block type (operand, function, function block, etc.)
BID = block identifier

N2
BT

Controls section

This dialog box allows the user to better control the refresh of the trigger window to get
more information on the code under scope. A detailed description of the function of each
control is given in the Trigger window controls section (see Paragraph ).

All controls are not accessible until at least one variable is dragged into the debug window.

The Variables section

This lower section of the Debug window is a table consisting of a row for each variable
that you dragged in. Each row has four fields: the name of the variable, its value, its type,
and its location (@task:ModuleName) read from memory during the last refresh.

Trigger n° 2 at LOOPS#3 % |
2 - o 250
Condition
(@) None
Trigger [ IFor
() After
Symbol Value Type Location
b 0.205 REAL @SLOW:LO
b 132.883 REAL @SLOW:LO
— LOOPSVALUE 16#3FFF WORD @SLOW:LO
BIT FALSE BOOL @SLOW:LO
< 1] >

9.5.1.4 TRIGGER WINDOW: DRAG AND DROP INFORMATION

To watch a variable, you need to copy it to the lower section of the Debug window.

This section is a table consisting of a row for each variable you dragged in. You can drag
into the trigger window only variables local to the module where you placed the relative
trigger, or global variables, or parameters. You cannot drag variables declared in another
program, or function, or function block.

9.5.1.5 REFRESH OF THE VALUES

(©.C)
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Let us consider the following example.
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L o
ST a Trigger n° 0 at COUNTER#6 B
0 D 2 - Crt: 763
- ST a
Condition
o 3 =,
ST ‘8 (@) Mone
Trigger  (_IFor
(") After
Symbol Value Type Location
—_A 1 UINT @FAST:COL
L4 1] >

The value of variables is refreshed every time the window manager is triggered, that is
every time the processor executes the instruction marked by the green arrowhead. How-
ever, you can set controls in order to have variables refreshed only when triggers satisfy
the more limiting conditions you define.

Note that the value of the variables in column Symbol is read from memory just before
the marked instruction (in this case: the instruction at line 5) and immediately after the
previous instruction (the one at line 4) has been performed.

Thus, in the above example the second ST statement has not been executed yet when the
new value of a is read from memory and displayed in the trigger window. Thus the result
of the second ST a is 1.

9.5.1.6 TRIGGER WINDOW CONTROLS

This paragraph deals with the trigger window controls, which allows you to better super-
vise the working of this debugging tool, to get more information on the code under scope.

Trigger window controls act in a well-defined way on the behaviour of the window, re-
gardless for the type of the module (either IL or FBD) where the related trigger has been

inserted.
All controls are not accessible until at least one variable is dragged into the Variables
window.
Window controls are made accessible to users through the grey top half of the debug
window.

Button Command Description

This control is used to start a triggering session.
If system is triggering you can click this button to
force stop. Otherwise session automatically stops
when conditions are reached. At this point you
can press this button to start another triggering
session.

|
o Start/Stop

(O 0]
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Button Command Description

This control is used to execute a single step
trigger. It is enabled only when there is no active

I Single step triggering session and None is selected. Specified
execution condition is considered. After the single step
trigger is done, triggering session automatically
stops.

Trigger counter

Crht: 4647

This read-only control counts how many times the debug window manager has been trig-
gered, since the window was installed.

The window manager automatically resets this counter every time a new triggering ses-
sion is started.
Trigger state

This read-only control shows the user the state of the Debug window. It can assume the
following values.

Heady The trigger has not occurred during the current task execution.

Triggered The trigger has occurred during the current task execution.

System is not triggering. Triggering has not been started yet
or it has been stopped by user or an halt condition has been
reached.

Communication with target interrupted, the state of the trigger
window cannot be determined.

User-defined condition

Condition

If you define a condition by using this control, the values in the Debug window are re-
freshed every time the window manager is triggered and the user-defined condition is
true.

After you have entered a condition, the control displays its simplified expression.

Condition A GT 100
Counters
(®) None
Trigger  (JFor
() After

These controls allow the user to define conditions on the trigger counter.
The trigger window can be in one of the following three states.
- None: no counter has been started up, thus no condition has been specified upon the

0.0
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trigger.

- For: assuming that you gave the counter limit the value N, the window manager adds
1 to the current value of the counter and refreshes the value of its variables, each time
the debug window is triggered. However, when the counter equals N, the window stops
refreshing the values, and it changes to the Stop state.

- After: assuming that you gave the counter limit the value N, the window manager re-
sets the counter and adds I to its current value each time it is triggered. The window
remains in the Ready state and does not update the value of its variables until the
counter reaches N.

9.5.2 DEBUGGING WITH TRIGGER WINDOWS

9.5.2.1 INTRODUCTION
The trigger window tool allows the user to select a set of variables and to have their val-
ues displayed and updated synchronously in a pop-up window. Unlike the Watch window,
trigger windows refresh simultaneously all the variables they contain, every time they are

triggered.

9.5.2.2 OPENING A TRIGGER WINDOW FROM AN IL MODULE

Let us assume that you have an IL module, also containing the following instructions.

LD
ADD
5T

oo

LD
ADD
ST

0oan

LD
ADD
ST

e

Let us also assume that you want to know the value of b, d, and k, just before
the ST k instruction is executed. To do so, move the cursor to line 12, then click
© Debug>Add/Remove text trigger .

A green arrowhead appears next to the line number, and the related trigger window pops

up.
LD Trigger n° 0 at COUNTER#12 x|
ADD b riggern” 0 a
ST = o - o T
IV = s
ADD d Condition
ST
DD k Trigger
ADD 1 o
[ 5T: 'k
Symbol Value Type Location
£ 1] >

(O 0]
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Not all the IL instructions support triggers. For example, it is not possible to place a trig-
ger at the beginning of a line containing a Jup statement.

9.5.2.3 ADDING A VARIABLE TO A TRIGGER WINDOW FROM AN IL MODULE

In order to watch the value of a variable, you need to add it to the trigger window. To this
purpose, select a variable by double-clicking it, and then drag it into the Variables win-
dow, that is the lower white box in the pop-up window. The variable’s name now appears

in the Symbol column.

1D
ADD
5T

1D
ADD
5T

1D
ADD

& 112 ST

0o /a0 i e

e S

g’j i Cnt; 514
Condition
@l Maone
Trigger [ JFor £
() After
Symbal Value Type Location
>—¢ 0 INT @FAST:COL
< 1] >

The same procedure applies to all the variables you wish to inspect.

9.5.2.4 OPENING A TRIGGER WINDOW FROM AN FBD MODULE

Let us assume that you have an FBD module, also containing the following instructions.

-
[

L

ADD

+
A

ADD

ADD

0.0
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Let us also assume that you want to know the values of ¢, D, and K, just before the last
instruction is executed.

Provided that you can never place a trigger in a block representing a variable such as

K]

you must select the first available block preceding the selected variable. In the example
of the above figure, you must move the cursor to network 8, and click the ApD block.

You can click © Debug>Add/Remove text trigger .

Else, you can also insert trigger on the whole line; this means you'll hit the trigger just
before the first instruction of that line is executed. To do so, select the row by clicking the
gray button on the left (the one with the row number inside) and add the trigger.

In both cases, the color of the selected block turns to green, a white circle with a number
inside appears in the middle of the block, and the related trigger window pops up.

Trigger n® 0 at PIDCONTROL#8S n
2 - o
008
EE- Condition

Trigger

N,

0007 Symbol Value Type Location

ADD

When preprocessing FBD source code, the compiler translates it into IL instructions. The
instruction in the selected network will be expanded to:

LD k
ADD 1
ST k

When you add a trigger to an FBD block, you actually place the trigger on the first state-
ment of its IL equivalent code.

9.5.2.5 ADDING A VARIABLE TO A TRIGGER WINDOW FROM AN FBD MODULE

In order to watch the value of a variable, you need to add it to the trigger window. Let
us assume that you want to inspect the value of variable k of the FBD code in the figure
below.

To this purpose, click & Edit>Watch mode .

(O 0]
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The cursor will become as follows.

A

Now you can click the block representing the variable you wish to be shown in the trigger

window.

Now select the element you wish to inspect, in our example let’'s suppose the variable K.

K >~

A dialog box appears listing all the currently existing instances of debug windows, and

asking you which one is to receive the object you have just clicked.

Debug windows list

Symbol to add;
k

Debug windows
Watch
Dsdilloscope

Trigger n® 0 at PIDCONTROL #8§

K Cancel

In order to display the variable k in the trigger window, select its reference in the Debug
windows column, then press 0K. The name of the variable is now printed in the Symbol

column.
L 1 a2l
Trigger n* 0 at PIDCONTROL#8S n
0007 Condition
P
A
Trigger
Symbaol Value Type Location
N
= Fa S 10178 INT @FAST:PIDC
L
| —
< n >

The same procedure applies to all the variables you wish to inspect.

Once you have added to the Graphic watch window all the variables you want to observe,
you can click » Edit>Insert/Move mode , so as to let the cursor take back its original shape.

0.0
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9.5.2.6 OPENING A TRIGGER WINDOW FROM AN LD MODULE

Let us assume that you have an LD module containing the following instructions:

0001 fbTp

inpLogicData

[ | N L. 2

s S

000z fhDelay

TON

inpLogicData I
|} IN (s

[ parTimOnDelay FT ET parTimOnialue |

You can place a trigger directly on a block, a contact, a coil or the entire row.

Let us assume that you want to know the value of some variables every time the pro-
cessor reaches network number 1. First select the network number 1 by clicking on
the grey area on its left, the one containing the network number. Now you can click
© Debug>Add/Remove text trigger .

In both cases, the grey raised button containing the network number turns to green, and
a white circle with the number of the trigger inside appears in the middle of the button,
while the related trigger window pops up.

fbTp

Trigger n® 0 at LADDERLOGIC#1§ B
w
o - oro
inplLogicData
{ | N . @
1T g - 2
o . Condition
B
Trigger
0002 fbDelay Symbaol Value Type Location
TOMN
inpLogicData G
|} IN Q
o B

Unlike the other languages supported by PLC IDE, LD does not allow you to insert a trigger
into a single contact or coil, as it lets you select only an entire network. Thus the variables
in the trigger window will be refreshed every time the processor reaches the beginning of
the selected network.

(O 0]
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9.5.2.7 ADDING A VARIABLE TO A TRIGGER WINDOW FROM AN LD MODULE

In order to watch the value of a variable, you need to add it to the trigger window. Let
us assume that you want to inspect the value of variable b in the LD code represented in
the figure below.

To this purpose, click & Edit>Watch mode .
The cursor will become as follows.

A

Now you can click the item representing the variable you wish to be shown in the trigger
window.

A dialog box appears listing all the currently existing instances of debug windows, and
asking you which one is to receive the object you have just clicked.

ftTp

e
o - mo T
inpLogicData
| | .
° i NP Condition
F Debug windows list X
[

Symbol to add: Trigger
Debug windows ‘

parPuIseWiﬂm

Symbol Value Type Location
Watch

Oscilloscope

Trigger n® 0 at LADDERLOGIC#1$

parTimOnDelay iR ‘

inpLogicData
1|
1T

OK Cancel ‘

a0 |

In order to display variable parPulseWidth in the trigger window, select its reference in the
Debug window column, then press OK.

The name of the variable is nhow printed in the Symbo/ column.

fbTp
Trigger n® 0 at LADDERLOGICZ1S H
B - cr 135
inplogicData
e [ Condition [=
'
I Trigger
0002 fbDelay Symbol Value Type Location
> — PARPULSEWIDTH 0 UDINT [@BACKGRC
inpLogicData
| -
€< 1} >

The same procedure applies to all the variables you wish to inspect.

Once you have added to the Graphic watch window all the variables you want to observe,
you can click » Edit>Insert/Move mode , so as to restore the original shape of the cursor.

9.5.2.8 OPENING A TRIGGER WINDOW FROM AN ST MODULE

0.0
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Let us assume that you have an ST module containing the following instructions.
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v o= SIN(=):
E 1= K + inl:r;l
loopsValus = 0;

for i := 0 to 15 do
bit = {wv + 0.9 > (0.125 = TO REEAT(i)):

if bit then
loop=Value = loopsValue or FEotateBit({i):
end_if:
end_for:

Let us assume that you want to know the value of x and y, just before the for cycle is
executed. To do so, move the cursor to line 6 and click ® Debug>Add/Remove text trigger .

A green arrowhead appears next to the line number, and the related trigger window pops

up.
y = SIN(x): Trigger n* 0 at LOOPS26 B2
¥ = ® + incr:
o oo T
E loopsValue := 0;
- for i := 0 to 15 do Condition
bit := (v 4+ 0.9) » (0.125 * TO_REAL(i)):
if bit then ;
loop=sWalue := loop=Value or RotateBit(i): Trigger
end_if:
end for;
Symbaol Value Type Location
< 1] >

Not all the ST instructions support triggers. For example, it is not possible to place a trig-
ger on a line containing a terminator such as END IF, END FOR, END WHILE, etc..

9.5.2.9 ADDING A VARIABLE TO A TRIGGER WINDOW FROM AN ST MODULE

In order to watch the value of a variable, you need to add it to the trigger window. To this
purpose, select a variable, by double clicking it, and then drag it into the Variables win-
dow, that is the lower white box in the pop-up window. The variable name now appears
in the Symbol column.

_E:= SIN(=):
R = ¥ 4+ 1lhcr;
- Crt: 11152
0ooe loopsValue := 0: "
[ 3 ; for i := 0 to 15 do Condition
bit = {y + 0.9} > (0.125 = TO _REAL(i)}:
(®) None
if bit then . :
loop=Value := loopsValue or RotateBit(i); Trigger () For
end if: B
end_ for: LA
Symbol Value Type Location
> vy 0.544 REAL @SLOW:LO
-y 1893.815 REAL @SLOW:LO
< 1] >

The same procedure applies to all the variables you wish to inspect.

9.5.2.10 REMOVING A VARIABLE FROM THE TRIGGER WINDOW

If you want a variable not to be displayed any more in the trigger window, select it by

clicking its name once, then press the Del key.
.
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9.5.2.11 CLOSING A TRIGGER WINDOW AND REMOVING A TRIGGER

This page deals with what you can do when you finish a debug session with a trigger win-
dow. You can choose between the following options.

- Closing the trigger window.

- Removing the trigger.

- Removing all the triggers.

Notice that the actions listed above produce very different results.

Closing the trigger window

If you close a trigger window you're just hiding its interface window, the trigger is still ac-
tive. You will still see the green arrowhead (or the network highlighted).

The fact that the trigger is active, means it is still working, if you reopen the interface you
won't find it at the same status it was when you closed it; for example the counter may
have raised.

You can reopen the interface window, to resume working with the same trigger, by open-

ing the Trigger list window, select the record referred to that trigger, and click the Open
button.

Trigger list x
Type  Module Line
T LADDERLOGIC -1 R
emove
T LOOPS [
Remave all
OK

The interface window appears with value of variables and trigger counter updated, as if it
had not been closed.

Removing a trigger

If you choose this option, you completely remove the code both of the window manager
and of its trigger. To this purpose, just open the Trigger list window, select the record
referred to the trigger window you want to eliminate, and click the Remove button.

Trigger list X
Type  Module Line Open
T LADDERLOGIC -1 R
emove
T LOOPS [
Remave all
QK

Alternatively, you can move the cursor to the line (if the module is in IL or ST), or
click the block (if the module is in FBD or LD) where you placed the trigger. Now press
Debug>Add/Remove trigger

Removing all the triggers

If you wish, you can remove all the existing triggers at once, regardless for which records
are selected, by clicking on the Remove all button from the Trigger list window.
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Trigger list X

Type  Module Line Open
T LADDERLOGIC -1 S

T  LOOPS 6 :
Remove all

oK

Alternatively you can select Debug>Remove all triggers

9.6 GRAPHIC TRIGGERS
9.6.1 GRAPHIC TRIGGER WINDOW

The graphic trigger window tool allows you to select a set of variables and to have them
sampled synchronously and to have their curve displayed in a special pop-up window.

Sampling of the dragged-in variables occurs every time the processor reaches the position
(i.e. the instruction - if IL, ST - or the block - if FBD, LD) where you placed the trigger.

9.6.1.1 PRE-CONDITIONS TO OPEN A GRAPHIC TRIGGER WINDOW

No need for special compilation

All the PLC IDE debugging tools operate at run-time. Thus, unlike other programming
languages such as C++, the compiler does not need to be told whether or not to support
trigger windows: given a PLC code, the compiler’s output is unique, and there is no dis-
tinction between debug and release version.

Memory availability

A graphic trigger window takes all the free memory space in the application code sector.
Obviously, in order to start up a trigger window, it is necessary that a sufficient amount
of memory is available, otherwise an error message appears.

9.6.1.2 GRAPHIC TRIGGER WINDOW INTERFACE

Setting a graphic trigger causes a pop-up window to appear, which is called Interface
window. This is the main interface for accessing the debugging functions that the graphic
trigger window makes available. It consists of several elements, as shown below.

(O 0]
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LOOF'S#@
] o~ T = 9 Cht: 0

-A000

Track Um Min value Mazx value Cur value Value/Div  Description

@

1. Caption bar 2. Controls bar 3. Chart area 4. Variables window

The caption bar

The Caption bar at the top of the pop-up window shows information on the location of the
trigger which causes the variables listed in the Variables window to be sampled.

The text in the caption has the following format:

ModuleName#Location

Where

Name of program, function, or function block where the trigger was

ModuleName
placed.

Exact location of the trigger, within module ModuleName.
If ModuleName isin IL, ST, Location has the format:
N1

Otherwise, if ModuleName is in FBD, LD, it becomes:
Location N2S$BT:BID

N1 = instruction line number
N2 = network number
BT = block type (operand, function, function block, etc.)

BID = block identifier

The Controls bar

This dialog box allows you to better control the working of the graphic trigger window. A
detailed description of the function of each control is given in the Graphic trigger window
controls section (see Paragraph 9.6.1.5).

(©.C)
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The Chart area
The Chart area includes six items:
1) Plot: area containing the actual plot of the curve of the dragged-in variables.

2) Samples to acquire: number of samples to be collected by the graphic trigger window
manager.

3) Horizontal cursor: cursor identifying a horizontal line. The value of each variable at
the intersection with this line is reported in the column horz cursor.

4) Blue cursor: cursor identifying a vertical line. The value of each variable at the inter-
section with this line is reported in the column /eft cursor.

5) Red cursor: same as blue cursor.

6) Scroll bar: if the scale of the x-axis is too large to display all the samples in the Plot
area, the scroll bar allows you to slide back and forth along the horizontal axis.

The Variables window

This lower section of the Debug window is a table consisting of a row for each variable
that you have dragged in. Every row has several fields, which are described in detail in
the Drag and drop information section.

9.6.1.3 GRAPHIC TRIGGER WINDOW: DRAG AND DROP INFORMATION

To watch a variable, you need to copy it to the lower section of the Debug window.

This lower section of the Debug window is a table consisting of a row for each variable
that you dragged in. Each row has several fields, as shown in the picture below.

Track Um Min value Max value Cur value Value/Div ¥ blue curs Vred curs  Hred cursor  Hblue cursor  Description

0.663679 0 T 0.04 0.665679 0.993436

4782.24 3 4782.24 47832

Field Description
Track Name of the variable.
Um Unit of measurement.

Min value Minimum value in the record set.
Max value Maximum value in the record set.
Cur value Current value of the variable.

How many engineering units are represented by a unit
v/div of the y-axis (i.e. the space between two ticks on the
vertical axis).

Value of the variable at the intersection with the line
identified by the vertical blue cursor.

Value of the variable at the intersection with the line
identified by the vertical red cursor.

Value of the variable at the intersection with the line
identified by the horizontal red cursor.

Value of the variable at the intersection with the line
identified by the horizontal red cursor.

Information about the variable in watch, like its parent
POU and the execution task

V Blue cursor

V Red cursor

H Red cursor

H Blue cursor

Description

Note that you can drag into the graphic trigger window only variables local to the module
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where you placed the relative trigger, or global variables, or parameters. You cannot drag
variables declared in another program, or function, or function block.

9.6.1.4 SAMPLING OF VARIABLES

Let us consider the following example.

The value of the variables is sampled every time the window manager is triggered, that is
every time the processor executes the instruction marked by the green arrowhead. How-
ever, you can set controls in order to have variables sampled when triggers also satisfy
further limiting conditions that you define.

The value of the variables in the column Track is read from memory just before the
marked instruction and immediately after the previous instruction.

9.6.1.5 GRAPHIC TRIGGER WINDOW CONTROLS

(©.C)
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This paragraph deals with controls of the Graphic trigger window. Controls allow you to
specify in detail when PLC IDE is supposed to sample the variables added to the Variables
window.

Graphic trigger window controls act in a well-defined way on the behaviour of the window,
regardless for the type of the module (IL, ST, FBD or LD) where the related trigger has
been inserted.

Window controls are made accessible to users through the Controls bar of the debug
window.

G HREE AAFE RIAE = o » W 5758 @ Cnk 1004100 m

Button Command Description

When you push this button down, you let
acquisition start. Now, if acquisition is running
Start graphic trace and you release this button, you stop the sample
collection process, and you reset all the data you
have acquired so far.

The two cursors (red cursor, blue cursor) may be
Enable/Disable seen and moved along their axis as long as this
cursors button is pressed. Release this button if you want
to hide simultaneously all the cursors.

This control is used to put in evidence the exact
Show samples point in which the variables are triggered at each
sample.

When pressed, this control splits the y-axis into
as many segments as the dragged-in variables,
so that the diagram of each variable is drawn in a
separate band.

It is used to fill in the graph window all the values
Show all values sampled for the selected variables in the current
record set.

Zooming in is an operation that makes the curves
in the Chart area appear larger on the screen,

so that greater detail may be viewed. Zooming
out is an operation that makes the curves appear
smaller on the screen, so that it may be viewed
in its entirety. Horizontal zoom acts only on the
horizontal axis.

Split tracks

| k|G

Horizontal Zoom In
and Zoom Out

1A 12
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Button Command Description

This control is used to horizontally center record
set samples. So first sample will be placed on the
left margin, and last will be placed on the right
margin of the graphic window.

E Horizontal show all

Vertical Zoom In and

|EL Zoom Out Vertical Zoom acts only on the vertical axis.

This control is used to vertically center record set

samples. So max value sample will be placed near
top margin and low value sample will be placed on
the bottom margin of the graphic window.

|I| Vertical show all

[ | Stop acquisition Not implemented.
1] Pause acquisition Not implemented.
[ Restart acquisition Not implemented.

Pushing this button causes a tabs dialog box

to appear, which allows you to set general user

Graphic trigger options affecting the action of the graphic trigger
window properties window. Since the options you can set are quite

numerous, they are dealt with in a section apart.

Click here to access this section.

Save chart Press this button to save the chart.

Load data (no
append)

¢l

Not implemented.

Load data and
append

P

Not implemented.

Push this button to print both the Chart area and
the Variables window.

&

Print chart

Trigger counter

Crt: 10741000

This read-only control displays two numbers with the following format: x/v.

X indicates how many times the debug window manager has been triggered, since the
graphic trigger was installed.

Y represents the number of samples the graphic window has to collect before stopping
data acquisition and drawing the curves.

Trigger state

This read-only control shows you the state of the Debug window. It can assume the fol-

lowing values.
(©.0)
PLC

Arduino PLC IDE user manual 155



ARDUINO PLC IDE

No sample(s) taken, as the trigger has not occurred during the

Ready current task execution.

Sample(s) collected, as the trigger has occurred during the

Triggered current task execution.

The trigger counter indicates that a number of samples
has been collected satisfying the user request or memory
constraints, thus the acquisition process is stopped.

Communication with target interrupted, the state of the trigger
window cannot be determined.

9.6.1.6 GRAPHIC TRIGGER WINDOW OPTIONS

In order to open the options tab, you must click the Properties button in the Controls bar.
When you do this, the following dialog box appears.

Control

Syncronous oscilloscope settings
Horizontal scale | 9.9
Buffer size
Condition

Tracks list

Valuefdiv

Show grid samples/div

Show time bar 100 samples  (max. 65535)

Show tracks list

MName Unit Offset Hide

0.0465135
0.12085

0.813941
-6243.52

OK Cancel

Control

Description

Show grid

Tick this control to display a grid in the Chart area
background.

Show time bar

The scroll bar at the bottom of the Chart area is
available as long as this box is checked.

Show tracks

The Variables window is shown as long as this box
is checked, otherwise the Chart area extends to the

list bottom of the graphic trigger window.
Values
Control Description
Hoglcz;revtal Number of samples per unit of the x-axis. By unit of the
s x-axis the space is meant between two vertical lines of
e the background grid.
.
PLC
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Control

Description

Buffer size

Number of samples to acquire. When you open the
option tab, after having dragged-in all the variables you
want to watch, you can read a default number in this
field, representing the maximum number of samples you
can collect for each variable. You can therefore type a
number which is less or equal to the default one.

Tracks

This tab allows you to define some graphic properties of the plot of each variable. To select
a variable, click its name in the Track list column.

Control Description
. Unit of measurement, printed in the table of the
Unit ; .
Variables window.
A value per unit of the y-axis. By unit of the y-axis is
Value/div meant the space between two horizontal lines of the
background grid.
Hide Check this flag to hide selected track on the graph.

Push Apply to make your changes effective, or push OK to apply your changes and to

close the options tab.

User-defined condition

If you define a condition by using this control, the sampling process does not start until
that condition is satisfied. Note that, unlike trigger windows, once data acquisition begins,
samples are taken every time the window manager is triggered, regardless of the user
condition being still true or not.

After you enter a condition, the control displays its simplified expression.

Condition A GT 100

9.6.2 DEBUGGING WITH THE GRAPHIC TRIGGER WINDOW

The graphic trigger window tool allows you to select a set of variables and to have them
sampled synchronously and their curve displayed in a special pop-up window.

9.6.2.1 OPENING THE GRAPHIC TRIGGER WINDOW FROM AN IL MODULE

Let us assume that you have an IL module, also containing the following instructions.

LD
ADD
5T

oo

LD
ATD
5T

0an

LD
ADD
5T

e

(O 0]
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Let us also assume that you want to know the value of a, ¢, and k, just be-
fore the ST k instruction is executed. To do so, move the cursor to line 12 and click
& Debug>Add/Remove graphic trigger

A green arrowhead appears next to the line number, and the graphic trigger window pops

up.

A | e |
m oo oo

COUNTER12 4
6 HHEBE aaH RERE « o » W e ceosss [T

€

] Counter Loops |

Track Um Min value Max value Curvalue Value/Div  Description

Not all the IL instructions support triggers. For example, it is not possible to place a trig-
ger at the beginning of a line containing a Jvp statement.

9.6.2.2 ADDING A VARIABLE TO THE GRAPHIC TRIGGER WINDOW FROM AN IL
MODULE

In order to get the diagram of a variable plotted, you need to add it to the graphic trigger
window. To this purpose, select a variable, by double clicking it, and then drag it into the
Variables window. The variable now appears in the Track column.

S-S T Y

E =T T <

LD
ADD
5T

Lo
ADD
5T

LD
ADD
ST

0o/0 oo

=R

L AL r F -

COUMTER#12 X

] | | n [

5000

E Counter [F]Leops [E Track Um Min value Max value Cur value Value/Div  Description

The same procedure applies to all the variables you wish to inspect.

Once the first variable is dropped into a graphic trace, the Graphic properties window is
automatically shown and allows the user to setup sampling and visualization properties.

(©.C)
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9.6.2.3 OPENING THE GRAPHIC TRIGGER WINDOW FORM AN FBD MODULE

Let us assume that you have an FBD module, also containing the following instructions.

—

ADD
+ 2]

B>

= -
ADD
+

[

o >
ADD
+

"

Let us also assume that you want to know the values of a, ¢, and k, just before the 1last
instruction is executed.

Provided that you can never place a trigger in a block representing a variable such as

(K]

you must select the first available block preceding the selected variable. In the example
of the above figure, you must move the cursor to network 8, and click the ApD block.

Now click & Debug>Add/Remove graphic trigger

Else, you can also insert trigger on the whole line; this means you’ll hit the trigger just
before the first instruction of that line is executed. To do so, select the row by clicking the
gray button on the left (the one with the row number inside) and add the trigger.

In both cases the colour of the selected block will turn to green, a white circle with the
trigger ID number inside will appear in the middle of the block, and the related trigger
interface window will pop up.

8 8 H

= PIDCONTROL#2S X
_DD
L o [NHEEASH BRRAE = v » | EBEOR & o | stop

0008

Track Um Min value Max value Cur value Value/Div  Description

< L _

El Counter [E]Loops [] Init ™ PidControl *T} Ladderlogic J € ] b
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When preprocessing the FBD source code, compiler translates it into IL instructions. The
ADD instruction in network 8 is expanded to:

LD k
ADD 1
ST k

When you add a trigger to an FBD block, you actually place the trigger before the first
statement of its IL equivalent code.

9.6.2.4 ADDING A VARIABLE TO THE GRAPHIC TRIGGER WINDOW FROM AN FBD

0.0
PLC

MODULE

In order to watch the diagram of a variable, you need to add it to the trigger window. Let
us assume that you want to see the plot of the variable k of the FBD code in the figure
below.

To this purpose, click & Edit>Watch mode .
The cursor will become as follows.

A

Now you can click the block representing the variable you wish to be shown in the graphic
trigger window.

In the example we are considering, click the button block.

K >~

A dialog box appears listing all the currently existing instances of debug windows, and
asking you which one is to receive the object you have just clicked.

Debug windows list X

Symbol to add:
k

Debug windows
Watch
Oscilloscope

oK Cancel

In order to plot the curve of variable k, select Graphic Trace in the Debug windows col-
umn, then press OK. The name of the variable is now printed in the Track column.
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LY ]S e R . - —— — - . S 7
2 L LS PIDCONTROL#85 x

T . ;oo Qs RAD s 0 @ RO S crowss T

|

[

|

[

Track Um Min value Max value Cur value Value/Div  Description

-1.80e+308 1 @FAST:PIDCONTH

< i >

The same procedure applies to all the variables you wish to inspect.

Once you have added to the Graphic watch window all the variables you want to observe,
you can click » Edit>Insert/Move mode , in order to restore the original cursor.

Once the first variable is dropped into a graphic trace, the Graphic properties window is
automatically shown and allows the user to setup sampling and visualization properties.

9.6.2.5 OPENING THE GRAPHIC TRIGGER WINDOW FROM AN LD MODULE

Let us assume that you have an LD module, also containing the following instructions.

o001

fbTp
T m M o
TP
npLogicData
|| N L. e
|| -
parpuean S porP s ane

| parTimOnDelay FT ET parTimOnValue |

You can place a graphic trigger directly on a block, a contact, a coil or the entire row.

Let us assume that you want to know the value of some variables every time the pro-
cessor reaches network number 1. First select the network number 1 by clicking on
the grey area on its left, the one containing the network number. Now you can click
@ Debug>Add/Remove graphic trigger

(O 0]
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In both cases, the grey raised button containing the network number turns to green, and
a white circle with the number of the trigger inside appears in the middle of the button,
while the related trigger interface window pops up.
WHE QO B OTIEE @0 by
S & EAl RS R R

Local variables

LADDERLOGIC=#13 x

G DHEEH &S H REE =« ok | B EEOE & Cnt 0 | Stop |

Track Um Min value Max value Curvalue Value/Div  Description

0003 BCtu
CTU_UDINT

npLogicData < i >
2 .

T 1 16U Ta mma

Note that unlike the other languages supported by PLC IDE, LD does not allow you to in-
sert a trigger before a single contact or coil, as it lets you select only an entire network.
Thus the variables in the Graphic trigger window will be sampled every time the processor
reaches the beginning of the selected network.

9.6.2.6 ADDING A VARIABLE TO THE GRAPHIC TRIGGER FROM AN LD MODULE

In order to watch the diagram of a variable, you need to add it to the Graphic trigger
window. Let us assume that you want to see the plot of the variable b in the LD code
represented in the figure below.

To this purpose, click & Edit>Watch mode .
The cursor will become as follows.

A

Now you can click the item representing the variable you wish to be shown in the Graphic
trigger window.

A dialog box appears listing all the currently existing instances of debug windows, and
asking you which one is to receive the object you have just clicked.

(©.C)
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Debug windows list X

Symbal to add:
k

Debug windows
Watch
Oscilloscope

QK Cancel

In order to plot the curve of variable b, select Graphic trace in the Debug windows col-
umn, then press OK. The name of the variable is now printed in the Track column.

fTp

inpLogicData
| |

1T
o parPulseWidth

.

The same procedure applies to all the variables you wish to inspect.

Once you have added to the Graphic watch window all the variables you want to observe,
you can click » Edit>Insert/Move mode , so as to restore the original shape of the cursor.

Once the first variable is dropped into a graphic trace, the Graphic properties window is
automatically shown and allows the user to setup sampling and visualization properties.

9.6.2.7 OPENING THE GRAPHIC TRIGGER WINDOW FROM AN ST MODULE

Let us assume that you have an ST module, also containing the following instructions.

v = SIH{x);
¥ = ® + incr;|
loop=WValue = 0;
for 1 = 0 to 15 do
bit = (v + 0.9) » (0.125 = TO_REEAL{i));
if bit then
loopsWValue = loopsValue or RotateBit({i):
end_1if:
end_for:

Let us also assume that you want to know the value of x and y, just before the for cycle is

(O 0]
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executed. Todo so, move the cursorto line 6 and click & Debug>Add/Remove graphic trigger
; @ green arrowhead appears next to the line number, and the Graphic trigger window

pops up.
pOHAY & LOOPS#6 X
Local variables : == "k il Cnt: 0 m
Name Type
1 Ix REAL Al
<
v = SINi{=):
2 = X + ilncr;
loop=Value = 0;
=) for 1 = 0 to 15 do
bit = (v + 0.9
if bit then
loop=V¥alue
end 1f:
end_ for;

B000

Track Um Min value Max value Curvalue Value/Div  Description

< 1} >

(% n=e= mid to mowre e e e

Not all the ST instructions support triggers. For example, it is not possible to place a trig-
ger on a line containing a terminator such as END IF, END FOR, END WHILE, etc.

9.6.2.8 ADDING A VARIABLE TO THE GRAPHIC TRIGGER WINDOW FROM AN ST
MODULE

In order to get the diagram of a variable plotted, you need to add it to the Graphic trigger
window. To this purpose, select a variable, by double clicking it, and then drag it into the
Variables window, that is the lower white box in the pop-up window. The variable now
appears in the Track column.

The same procedure applies to all the variables you wish to inspect.

Once the first variable is dropped into a graphic trace, the Graphic properties window is
automatically shown and allows the user to setup sampling and visualization properties.

(©.C)
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H -4 % @ =

Local variables

e L e
[ty e | Fd

Name Type

1 Ix 'REAL Al
<

p—

X 3

= SIN(=):

= ® + incr:
loopsValue := 0:
for i := 0 to 15 do
bit := {w + 0.9

if bit then
loopsValue
end_if:
end_ for:

-

¥ nooes mad Fea marral

LOOPS#6

G HHEE RA8E BRAT = v » Cnt: /65535

E RSO &

Syncronous oscilloscope settings

[¥]  Horizontal scale | 500
[¥]  Buffer size
[¥]  Condition

Show grid samples/div

Show time bar 65535 samples  (max. 65535)

Show tracks list

Tracks list

Value div Offset Hide

1

Track

Cancel

< m >

9.6.2.9 REMOVING A VARIABLE FROM THE GRAPHIC TRIGGER WINDOW

If you want to remove a

variable from the Graphic trigger window, select it by clicking its

name once, then press the Del key.

9.6.2.10 CLOSING THE GRAPHIC TRIGGER WINDOW AND REMOVING THE TRIGGER

At the end of a debug session with the graphic trigger window you can choose between

the following options:

- Closing the Graphic trigger window.

- Removing the trigger.

- Removing all the triggers.

Closing the graphic trigger window
If you close a graphic trigger window you’re just hiding its interface window, the trigger is

still active. You will still

see the green arrowhead (or the network highlighted).

You can reopen the interface window, to resume working with the same graphic trigger,
by opening the Trigger list window, select the record referred to that trigger, and click

the Open button.

Removing the trigger

Trigger list X
Type  Module Line
G LOOPS [
Remowve
Remove all
oK

If you choose this option, you’ll completely remove the code both of the window manager

and of its trigger. To do

so: open the Trigger list window, select the record (having type

0.0
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G) and click the Remove button.

Trigger list X
Type  Module Line Open
G LOOPS [
Remove J
Remaove all
QK

Alternatively, you can move the cursor to the line (if the module is in IL or ST), or
click the block (if the module is in FBD or LD) where you placed the trigger. Now select
& Debug>Add/Remove graphic trigger

Removing all the triggers

This way you'll remove all the existing triggers at once, regardless for which records are
selected. To do so: open the Trigger list window and click on the Remove all button.

Trigger list X
Type  Module Line Open
G LOOPS [

Remove all

OK

9.7 BREAKPOINTS
9.7.1 THE BREAKPOINT TOOL

The Breakpoint tool allows you to halt the program execution when it reaches a certain
location. When a breakpoint is hit you can take all the time you want to watch other vari-
ables values or check every condition you need t verify before resuming the program ex-
ecution; with breakpoints you also have the option of executing only the next instruction,
running your program step by step.

Breakpoints cannot be used with SFC modules.

9.7.1.1 PRE-CONDITIONS TO SET A BREAKPOINT

No need for special compilation
PLC IDE debugging tools operate at run-time. Thus, unlike other programming languages

such as C++, the compiler does not need to be told whether or not to support break-
points: given a PLC code, the compiler’s output is unique, and there is no distinction

between debug and release version.

Memory availability

0.0
PLC
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A breakpoint takes a segment in the application code sector, having a well-defined

length. Obviously, in order to set a breakpoint, it is necessary that a sufficient amount of
memory is available, otherwise an error message appears.

Incompatibility with graphic trigger windows

A graphic trigger window takes the whole free space of the application code sector. There-
fore, once such a debugging tool has been started, it is not possible to add any break-
point, and an error message appears if you attempt to set one. Once the

graphic trigger window is eventually closed, breakpoints are enabled again.
Note that all the breakpoints existing before the starting of a graphic trigger window will
keep working normally. You are simply not allowed to add new ones.

9.7.2 SET AND REMOVE A BREAKPOINT

From the Debug menu you can select the appropriate voice for work with breakpoints.
Breakpoints can be palced only if a valid connection is established and the PLC is currently
executing.

From the Debug menu you can choose the following voices:

Icon in
Command debug Description
toolbar

In order to actually set a breakpoint, select the
point of the PLC code where to insert the relative
Set/Remove breakpoint [ ] breakpoint and then select this voice or use the
shortcut pressing F12.

Do the same to remove the breakpoint.

One a breakpoint is hit, the program execution

> will be stopped and its state will become HALTED;
in order to resume the normal program execution

select this voice.

Once a breakpoint is hit, the program execution
> will be stopped and its state will become HALTED;

select this voice to execute only the next
instruction.

Selecting this voice will cause all the existing
breakpoints to be removed simultaneously.

) Select this voice to open a dialog listing all the
existing breakpoints.

Run

Step

Remove all breakpoints (8]

Breakpoint list

If you have set several breakpoint, you may want to keep control over them using the
Breakpoints list window. Selecting the Breakpoints list voice the following window will be
opened:

(O 0]
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Breakpoint list X
Module Line Open
INIT 1
Remove
LOOPS 5
LOOPS 3 Remove all
oK

In this window you can see the list of all active breakpoints, the program name and the
relative code line where they are set is shown in the column Module and Line respectively.

Once selected a breakpoint from the list, you can:

- press the Open button: the relative program will be opened and the line with the select-
ed breakpoint will be highlighted; this feature allows you to fast navigate to the desired
breakpoint. You can obtain the same result by double clicking the breakpoint instead of
selecting it and then pressing the Open button

- press Remove button: this will actually remove the selected breakpoint.
- press Remove all button: this will remove all breakpoints in every program.

9.7.3 WORKING WITH BREAKPOINTS

9.7.3.1 USE BREAKPOINTS WITH IL AND ST LANGUAGES

Breakpoints work the same way in both IL and ST languages; in order to set a new break-
point, move to the code line where you want to halt the program execution, then choose
® Debug>Set/Remove breakpoint

At the far left side of the code line, left to the line number, a red circle will appear, mean-
ing that there’s a breakpoint on that line.

] loopsValue = 0]
for 1 := 0 to 15 do
bit = (v + 0.9} » (0.125 = TO_REEATL(i)):

1f bit then
loopsValue = loopsValuse or FotateBit(i):
end_if;
end_for:

Note that you cannot set breakpoints on every instruction, for example you cannot set a
breakpoint on an end_if statement and similar.

When a breakpoint is hit (which means that the code execution has reached the line
where the breakpoint is set), the whole line is highlighted and a yellow arrow appears
inside the red circle, to indicate that the program is waiting to execute that instruction.

Also the program execution state will change, in the far bottom-right corner, it will change
from running to halted.
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9.7.3

Ll
o =
loopsWalue = 0:
for 1 := 0 to 15 do
bit = (v + 0.9) » (0.125 = TO_REAL{1)):
if bit then o
Tnmm=Valur = Innm=Walne nr EntateRitid0 -
£ >

[El Loops [E] Init ™3 PidControl "'} Ladderlogic EPidModeSelector E—ﬁdebugTest W= {5 Counters_and_timers [T3]Com 4 b = X

HALTED | SOURCEOK |  CONNECTED

Note that when a breakpoint is hit, the program execution is halted before that instruc-
tion took place.

In the following image you can see that if we halt the program execution on an addition
instruction, the addition hans not yet took place.

A | |Watch
B e R ¢ t 4 @
© Symbol Value Type Location
— CNT 10 UINT @SLOW:LOOPS

Selecting » Debug > Run the program execution will be resumed until another break-
point is hit, or the same breakpoint will be hit again after an entire cicle has took place.

Selecting ¢ Debug > Step the code line where the program execution has halted, will
be executed, but the program will halt on the very next instruction. In other words, the
result is the same as setting a new virtual breakpoint to the next instruction and then
resume the execution.

.2 USE BREAKPOINTS WITH LD AND FBD LANGUAGES

Breakpoints work the same way in both LD and FBD languages; in order to set a new
breakpoint, move to the line where you want to halt the program execution, then choose
® Debug > Set/remove breakpoint .

On the header of the line, the gray raised button with the line number on it, will now ap-

pera a red circle, meaning that there’s a breakpoint on that line.
|

LowPassFilter

i out

When a breakpoint is hit (which means that the code execution has reached the line
where the breakpoint is set), the header is highlighted to indicate that the program is
waiting to execute that instruction.

Also the program execution state will change, in the far bottom-right corner, it will change
from running to halted.

(O 0]
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LowPassFilter
in out e |
[o= 1| 1
0003
MuL L
%
1023
L]
< 1} >

lesources [Z] Loops [E] Init ™8 PidContrel "'} LadderLogic II—xl_,F’ic."'\-“lu:deSeIectr:lr T—ﬁdebugTest Mol Counters_and_timer 4 b =

HALTED | SOURCEOK |  CONNECTED

Note that, as shown with the textual languages, when a breakpoint is hit, the program
execution is halted before that instruction took place.

Selecting » Debug > Run the program execution will be resumed until another break-
point is hit, or the same breakpoint will be hit again after an entire cicle has took place.

Selecting ¢ Debug > Step the line where the program execution has halted, will be ex-
ecuted, but the program will halt on the very next instruction. In other words, the result
is the same as setting a new virtual breakpoint to the next instruction and then resume
the execution.

9.7.4 REMOVING BREAKPOINTS

0.0
PLC

To remove a breakpoint you can either select it from the breakpoints list window and
press the Remove button, or you can move to the line where the breakpoint is and se-
lect ® Debug > Set/remove breakpoint .

If you have done using breakpoints and you wish to remove them all with a single com-
mand, you can either open the breakpoints list window and press the Remove all but-
ton, or you can select the o Debug > Remove all breakpoints .
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10. PLC IDE REFERENCE

10.1 MENUS REFERENCE
In the following tables you can see the list of all PLC IDE’s commands. However, since

PLC IDE has a multi-document interface (MDI), you may find some disabled commands or
even some unavailable menus, depending on what kind of document is currently active.

10.1.1 FILE MENU

Command |Icon| Key | Description
New project k| Creates a new PLC IDE project.
Open project r Opens an existing PLC IDE project.
Import project from Imports sources project from target device.
target
OVII:i;%project (read Opens an existing PLC IDE project in read-only mode.
Save project -] Saves the current open project.
Save project As i)?g/eenssitcl;l:. current open project specifying new name, location and
Close project Closes the open project.
New text file Opens a blank new generic text file.
Opens an existing file, whatever its extension. The file is displayed
Open file Ctrl+0 ' in the text editor. Anyway, if you open a project file, you actually
open the PLC IDE project it refers to.
Save Ctrl+S Saves the document of the currently active window.
Close Closes the document of the currently active window.
Options Opens the PLC IDE options dialog box.
Print =] Ctrl+P Prints the document of the currently active window.
Print preview 0 rCer:g»t/e:Oabzrsi\‘/iir:atzdc?f the document of the currently active window,
Print project Prints all the documents making up the project.
Printer setup Opens the Printer setup dialog box.
..recent.. Lists a set of project file recently opened.
Exit Closes PLC IDE.

10.1.2 EDIT MENU

Command

| Icon | Key

Description

Undo Ctrl+Z Cancels last action made in the document.

)
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Command | Icon | Key | Description
Redo Q Ctrl+Y Restores the last action cancelled by Undo.
Cut " Ctri+X Removes the_ selected items from the active document and
ok stores them in a system buffer.
Copy W Ctrl+C Copies the selected items to a system buffer.
Paste & Ctri+V fPearstes in the active document the contents of the system buf-
Delete Del Deletes the selected item.
Delete line Ctrl+E Deletes the whole source code line.
2 Shift
Go to symbol ] YF12 Allows you to move through the results of a symbol search
Find in project Ctri+ Opens the Find in project dialog box
s Shift+F )
Bookmarks...
Add/Toggle Ctri+F2 Adc_Is a bookmark _to mark lines. If a bookmark is already
defined, removes it.
Next F2 Goes to next defined bookmark
Prev Shift+F2 Goes to previous defined bookmark
Remove all Removes all defined bookmarks
. Allows you to quickly move to a specific line in the source
Go to line Ctrl+G code editor.
Asks you to type a string and searches for its first instance
Find P Ctrl+F within the active document from the current location of the
cursor.
Find next -};. F3 Itgrates between the results of the research, found by the
Find command.
Replace Ctri+H AIIovys you to automatlcglly replace one or all the instances of
a string with another string.
Toggle between those two editing modes, used to insert or
Insert/Move mode [ Spacebar move blocks. You can switch from Insert/Move to Connection
mode with the spacebar
Editing mode which allows you to draw logical wires to con-
Connection mode " Spacebar nect pins. You can switch from Insert/Move to Connection
mode with the spacebar
Watch mode Q Eghtmg mode which allows you to add variables to any debug-
ging tool.
_ Ctrl +
Zoom in I mouse Increase zoom level inside the active POU.
wheel
_ Ctrl +
Zoom out =] mouse Decrease zoom level inside the active POU.
wheel
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Command | Icon | Key | Description
Toolbar
Main Shows or hides the Main toolbar.
Project Ctrl+J Shows or hides the Project toolbar.
Debug Ctrl+B Shows or hides the Debug toolbar.
FBD bar Ctrl+D Shows or hides the FBD toolbar.
LD bar Ctrl+A Shows or hides the LD toolbar.
SFC bar Ctrl+Q Shows or hides the SFC toolbar.
Network Ctrl+N Shows or hides the Network toolbar.
Tool windows
Local variables Shows or hides the local variables window for the active POU.
Project 2 Ctri+w Shows or hides the Workspace window (also called Workspace
window).
Watch Esl  Ctrl+T Shows or hides the Watch window.
Properties window @ Shows or hide the properties window.
Oscilloscope (A Ctrl+K Shows or hides the Oscilloscope window.
PLC run-time 1 Shows or hides the PLC run-time window.
status
Library Tree 1T Shows or hides the Libraries window.
Output B Ctrl+R Shows or hides the Output window.
Cross Reference oy Shows or hides the cross reference window.
Symbols browser Shows or hides the symbols browser window.
Resources Add or remove the resources panel from the workspace.
Catalog Shows or hides the catalog window.
Full screen B Ctri+U Expands the currer_1t|y actlvg document window to fill entire
screen. (Esc to exit from this mode).
Grid Shows or hides a dotted grid in the background of graphical

Show comments for
objects

10.1.4 PROJECT MENU

source code editors.

Enable/disable tooltip informations on objects

Command

| Icon |

Key Description

New object
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Command | Icon | Key | Description
Y Creates a new program. A dialog is prompted in order to
ew program . ,
specify the new program properties.
New function Creates a new function block. A dialog is prompted in order
block to specify the new function block properties.
. Creates a new function block. A dialog is prompted in order
New function . : .
to specify the new function properties.
New variable
4 . Creates a new automatic variable. A dialog is prompted in
utomatic - . .
order to specify the new variable properties.
Mapped Ctrl + Creates a new mapped variable. A dialog is prompted in
variable Shift + M order to specify the new variable properties.
Creates a new constant. A dialog is prompted in order to
Constant . .
specify the new constant properties.
. Creates a new retain variable. A dialog is prompted in order
Retain . } :
to specify the new variable properties.
New definition
Enumeration Creates a new user defined type, of type enumeration.
Interface Creates a new user defined type, of type interface.
Macro Creates a new user defined type, of type macro.
Structure Creates a new user defined type, of type structure.
Subrange Creates a new user defined type, of type subrange.
TypeDef Creates a new user defined type, of type typedef.
Copy object Copies the object currently selected in the Workspace.
Paste object Pastes the previously copied object.
. . Duplicates the object currently selected in the Workspace,
Duplicate object and asks you to type the name of the copy.
Delete object Del Deletes the currently selected object.
View PLC object Alt+Enter Shows properties and description of the currently selected
properties object.
Object browser = Opens the QbJect browser, which lets you navigate
between objects.
Compile |'_f;| F7 Launches the PLC IDE compiler.
Recompile all AC7ttr+7F+7 Recompiles the project.
Generate
redistributable Generates an RSM file.
source module
Import objects Lets you import a PLC IDE object from a library.
E)fport object to Lets you export a PLC IDE object to a library.
library
Library manager [ Opens the Library manager.
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Command | Icon | Key Description
gi;’:?;g alt 1i- ﬂﬂ Reloads all libraries linked to the project.
Select target... Lets you to select a new target for the project.
Refresh current Lets you update the target file for the same version of the
target target.
Options... Opens the project options dialog.

10.1.5 ONLINE MENU

Command |Icon| Key | Description

i?gn[m communtcas Lets you set the properties of the connection to the target.

Connect ¥ PLC IDE tries to establish a connection to the target.

PLC IDE checks if any changes have been applied since last
Download code %8 F5 compilation, if so compiles the project and then downloads the
source code to the target.

Lets you set the properties of the source code downloaded to

Download options the target.

Force target 7mage If the target device is connected, lets you upload the img file.

upload
Force debug symbols If the target device is connected, lets you upload the debug
upload symbols file.
Halt L] Stops the PLC execution.

Restarts the PLC execution and both retain and non-retain
Cold restart @ . -

variables will be reset.

Restarts the PLC execution and non-retain variables will be
Warm restart @

reset.
Hot restart @ Restarts the PLC execution without any reset on variables.
Reboot target % Reboots the target.
Read all logs again Reloads all remote logs from target.

10.1.6 DEBUG MENU

Command | Icon | Key Description

Simulation mode ﬂﬁl Open/close the integrated simulation environment.

Simulation mode
(workspace selec-
tion)

Open/close the integrated simulation environment allowing

the user to create and choose different workspace.
.
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| Command | Icon | Key | Description
Start/Stop watch B Starts or stops (toggle) the evaluation of the symbols
value added in the watch window.

Add symbol to watch F8 Adds a symbol to the Watch window.

Add symbol to a de-

bug window F10 Adds a symbol to a debug window.

Insert new item

. . Shift+F10 Inserts a new item into a debug window.
into a debug window

Opens a new window which allows you to se the current

Quick watch symbol Shift+F8 value of the selected symbol (not refreshing) and to force a
new value.

Live debug mode FEE If debug mode is running, starts or stops (toggle) the live
debug mode.

Add/ remove text .

trigger ﬂ F9 Adds/removes a text trigger.

Add/ remove . s

graphic trigger S Shift+F9 Adds/removes a graphic trigger.

Remove all Ctri+ . .

triggers [-2:] Shift+F9 Removes all the active triggers.

Trigger 1ist 2 Ctri+I %Lists all the active triggers.

Run 2 Restarts program after a breakpoint is hit.

Ste .['P Restarts program executing only one instruction, after a

P breakpoint is hit.

Add/ Remove .

breakpoint & Fi2 Adds or removes a breakpoint.

Remove all . .

breakpoints @] Removes all the active breakpoints.

Breakpoint list @’ Lists all the active breakpoints.

10.1.7 SCHEME MENU FOR FBD

Command | Icon | Key | Description
Network
New
Top (=] Adds a blank network at the top of the active document.
Bottom i=| Adds a blank network at the bottom of the active document.
— Adds a blank network before the selected network in the active
Before L= document.
After =] Adds a blank network after the selected network in the active
= document.
Label Assigns a label to the selected network, so that it can be

indicated as the target of a jump instruction.
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Command | Icon | Key Description
Object
New
Function Opens the object browser in order to choose a function to be
added to the current active document.
Function Opens the object browser in order to choose a function block to
block be added to the current active document.
. . Opens the object browser in order to choose a variable to be
Variable L Shift+V added to the current active document.
. Opens the object browser in order to choose a constant to be
Constant & ShITLHK added to the current active document.
Return L F: shift+R Adds a return statement into the selected network.
i:ggfo b L J shift+J Adds a jump statement into the selected network.
Operator Opens the object browser in order to choose an operator to be
p added to the current active document.
Comment = shift+M Adds a comment into the selected network.

Instance name

Open source

Auto connect

Delete invalid
connection

Increment pins

Decrement pins

Enable EN/ENO
pins

Object proper-
ties

i

En

Ctrl+M

+HH  ctri++

-1 ctri+ -

Opens the object browser in order to choose an operator to be
added to the current active document.

Opens the editor by which the selected object was created, and
displays the relevant source code:

- if the object is a program, or a function, or a function block,
this command opens its source code;

- if the object is a variable or a parameter, this command opens
the corresponding variable editor;

- if the object is a standard function or an operator, this
command has no functionality.

Toggle auto-connection mode, in order to connect automatically
two blocks when they are close enough.

Removes all invalid connections, represented by a red line in the
active scheme.

Adds additional pins to the selected block in order to increase
standard ones.

Removes pins added by the Increment pins command.

Adds the enable in/enabie out pins to the selected block.
The code implementing the selected block will be executed
only when the enable in signal is true. The enable out signal
simply repeats the value of enable in, allowing you either to
enable or to disable a set of blocks in cascade.

Shows some properties of the selected block.
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10.1.8 SCHEME MENU FOR LD

Command | Icon | Key | Description
Network
New
To ' Adds a blank network at the top of the active
p H document.
Bottom = Adds a blank network at the bottom of the active
g document.
Before = Adds a blank network before the selected network in
— the active document.
After = Adds a blank network after the selected network in the
= active document.
Label Assigns a label to the selected network in order to be
used as target of a jump instruction.
Object
New
Parallel contact Adds a parallel contact before the selected one.
before
5‘;;2;767 contact o Shift+P Adds a parallel contact after the selected one.

Serie contact

Adds a contact in series and before the selected one.
before

Serie contact after 1_F Shift+C Adds a contact in series and after the selected one.

Coil {} shift+0 Adds a Coil into the selected network.
. Opens the object browser in order to choose which
Block ¥ Shift+B block should be added to the current active document.
! . Opens the object browser in order to choose a constant
Constant ShITE+K to be added to the current active document.
Return o Shift+R Adds a Return statement into the selected network.
Jump L Shift+J Adds a jump statement into the selected network.

. . Opens the object browser in order to choose a variable
Variabie & Shift+y to be added to the current active document.
Expression LE ] Shift+£ Adds an expression into the selected network.

Branch B Creates new branch after the current position.
Comment = Shift+M Adds a comment into the selected network.

Lets you assigh a hame to an instance of the selected

Instance name function block.
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Command | Icon | Key

Description

Opens the editor by which the selected object was
created, and displays the relevant source code:

- if the object is a program, or a function, or a function
block, this command opens its source code;

Open source = ) o ] )
- if the object is a variable or a parameter, this
command opens the corresponding variable editor;
- if the object is a standard function or an operator,
this command has no functionality.
Open object i 0 Ch_anges the selected object into an open contact
object.
Negated object 7] c Ch_anges the selected object into a negated contact
object.
Positive object 7] p Chgnges the selected object into a positive contact
object.
Negative object W] N Ch:anges the selected object into a negative contact
object.
Set coil (=] S Changes the selected coil into a set coil.
Reset coil (k] R Changes the selected coil into a reset coil.
Increment pins +  cirieoe Adds additional pins to the selected block in order to
increase standard ones.
Decrement pins -4 ctri+- Removes pins added by the Increment pins
command.
Adds the enable in/enable out pins to the selected
block. The code implementing the selected block will be
. £ executed only when the enable in signal is true. The
Enable EN/ENO pins o £ enable out signal simply repeats the value of enablie
in, allowing you either to enable or to disable a set of
blocks in cascade.
Set output Tine = Set selected pin as the output line of the block.
Object properties Shows some properties of the selected block.
10.1.9 SCHEME SFC MENU
Command | Icon | Key | Description
Object
New
Step J Adds new step into the selected network.
Transition s Adds new transition into the selected network.
Jump Le Adds new jump into the selected network.
Modify

Add pin to divergent
transition

Adds a divergent pin to the selected transition.
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Command | Icon | Key | Description
Remove pin from divergent ﬁ Removes a divergent pin to the selected
transition transition.

Add pin to convergent

transition

Remove pin from convergent

transition

Add pin to simultaneous
divergent transition

Remove pin from
simultaneous divergent

transition

Add pin to simultaneous
convergent transition

Remove pin from
simultaneous convergent

transition

Add space before rightmost

pin

Remove space before
rightmost pin

Code Object

New Action

New Transition code

Auto connect

Delete invalid connection Ctri+M

R

Adds a convergent pin to the selected transition.

Removes a convergent pin to the selected
transition.

=

Adds a simultaneous divergent pin to the
selected transition.

1

Removes a simultaneous divergent pin to the
selected transition.

i

Adds a simultaneous convergent pin to the
selected transition.

S

Removes a simultaneous convergent pin to the
selected transition.

TT

] Adds a space before the rightmost pin.
4 Removes a space before the rightmost pin.
I_,ifl Adds an action in the active document.

Adds a transition in the active document.

&

) Toggle auto-connection mode, in order to
E~‘L connect automatically two blocks when they are
close enough.

Removes all invalid connections, represented by
a red line in the active scheme.

10.1.10 VARIABLES MENU

Command | Icon | Key | Description
L1 1] Ctr7+ - - . .
Insert amn Shift+ins Adds a new row to the grid in the currently active editor.
Deletes the variable in the selected row of the currently
Delete ﬁ Del active table.

Create multiple

Lets you to create a set of multiple variables.
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10.1.11 WINDOW MENU

Command |Icon| Key | Description

Displaces all open documents in cascade, so that they

Cascade completely overlap except for the caption.

The PLC editors area is split into frames having the same
dimensions, depending on the number of currently open
documents. Each frame is automatically assigned to one of
such documents.

Tile

Displaces the icons of the minimized documents in the bottom

Arrange Icons left-hand corner of the PLC editors area.
Close all Closes all open documents.

Shows the list of active open windows, allowing you to close or
Windows. .. ATt+W bring to focus specific window. Useful when you have a lot of
open window.

10.1.12 TOOLS MENU

Command | Icon | Key | Description

Customn tools Allows to see and execute previously loaded custom

tools.
10.1.13 HELP MENU
Command | Icon | Key | Description
Index Lists all the Help keywords and opens the related topic.
Context I Cor_1text-_sen5|t|ve help. Opens the topic related to the currently
active window.
About. .. Credits and version information.

10.2 TOOLBARS REFERENCE

In the following tables you can see the list of all PLC IDE’s toolbars. The buttons making
up each toolbar are always the same, whatever the currently active document. However,
some of them may produce no effect, if there is no logical relation to the active document.

10.2.1 MAIN TOOLBAR

alE 2C¢XX0a Ary wEld BRmAERREDE O

10.2.2 FBD TOOLBAR

RS e B OODH IR @S
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10.2.3 LD TOOLBAR
T mr THAF A} A M EEF T
10.2.4 SFC TOOLBAR
O g8 MW BEEEE S ufef B9
10.2.5 PROJECT TOOLBAR
o F e @@ F BPNEME BE 600
10.2.6 NETWORK TOOLBAR
BE=SS ElER

10.2.7 DEBUG TOOLBAR

0.0
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11. LANGUAGE REFERENCE

All PLC IDE languages are IEC 61131-3 standard-compliant.
- Common elements

Instruction list (IL)

Function block diagram (FBD)

Ladder diagram (LD)

Structured text (ST)

Sequential Function Chart (SFC).

Moreover, PLC IDE implements some extensions:

- Pointers
- Macros.
- Object Oriented programming.

11.1 COMMON ELEMENTS

By common elements are intended those elements which are common to all programming
languages of the IEC 61131-3 standard.

Note: definition and editing of most of the common elements (variables, structured elements,
fur:jctiot?I blocks definitions etc.) are managed by PLC IDE through specific editors, forms
and tables.

The following paragraphs are meant to be a language specification. To correctly manage
common elements refer to the PLC IDE user guide.

11.1.1 BASIC ELEMENTS
11.1.1.1 CHARACTER SET

Textual documents and textual elements of graphic languages are written by using the
standard ASCII character set.

11.1.1.2 COMMENTS

User comments are delimited at the beginning and at the end by special character com-
binations. For the textual languages (IL and ST) are allowed this format of comments:

- (* multi-lines comment *) (%
- // single line comment Ilru_lltil:'le
1ne
- /* multi-line comment */ Conmen t
*)
Same format comments cannot be S =zingle line comment
nested.
S
Different format comments can be nultiple
nested but it is a strongly not line
recommended practice. e COMIEN

For graphic languages, comments are inserted using dedicated commands; they are then
translated, into the project file, using the first comment format (* comment *).

Comments are permitted anywhere in the program, and they have no syntactic or seman-
tic significance in any of the languages defined in this standard.
.
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11.1.2 ELEMENTARY DATA TYPES

A number of elementary (i.e. pre-defined) data types is made available by PLC IDE, all
compliant with IEC 61131-3 standard.

Elementary data types, keyword for each data type, number of bits per data element, and
range of values for each elementary data type are described in the following table.

(©.C)
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Keyword Description Bits Range / Notes
0 to 1 - size of the BOOL
See dtata t pde depends on the
arget device processor.
BOOL Boolean note e.gg. itis 1 biliJ long for
devices that have a bit-
addressable area.
SINT Short integer 8 -128 to 127
USINT Unsigned short integer 8 0 to 255
INT Integer 16 -32768 to 32767
UINT Unsigned integer 16 0 to 65535
—2147483648
DINT Double integer 32 to
2147483647
UDINT Unsigned Double integer 32 0 to 4294967295
—9223372036854775808
LINT Long integer 64 to
9223372036854775807
. . 0 to
ULINT Unsigned Long integer 64 18446744073709551615
BYTE Bit string of length 8 8 —
WORD Bit string of length 16 16 —
DWORD Bit string of length 32 32 —
LWORD Bit stirng of length 64 64 —

REAL Real number 32 -3.40E+38 to +3.40E+38
LREAL Long Real Number 64 -1.7E+308 to +1.7E+308
STRING String of characters N Characters are delimited by

encoded with UTF-8 single quotes ( ‘abc’)
String of characters i Characters are delimited by
WSTRING encoded with UTF-16 double quotes ( “abc”)
Date expressed in DATE#1970-01-01
L b W o
with forma -
MM-DD DATE#2038-01-19
:?]aﬁzrfgfgcejﬁjg LDATE#1970-01-01
LDATE represented wit’h format 64 to
LDATE£YYYY-MM-DD LDATE#2262-04-11
. . TIME#-24d_20h_31m_
Time expressed in
. 23s_648ms
milliseconds represented
TIME with format TIME#dd_hh 32 to
mm ss ms - - TIME#24d_20h_31m_
- = 23s_647ms
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Keyword Description Bits Range / Notes
Time expressed in LTIME#-106751d_23h_47m_
P 16s_854ms_775us_808ns
LTIME nanoseconds represented 64 to
;‘gt%‘:’rfj‘;atngd—hh—mm— LTTME4106751d_23h_47m_1
- T = 6s_854ms_775us_807ns
E:ggnfj’;prreessriie'gte ] DT#1970-01-01-00:00:00
DATE_AND_TIME ; ! 32 to
— - with format DT#YYYY-MM- .
DD-hh:mm:ss DT#2038-01-19-03:14:07
Date expressed 1DT#1970-01-01-00:00:00
in nanoseconds, to
LDATE_AND_TIME | represented with format 64 A4
LDT#YYYY-MM-DD- LDZT;*_%%GOQS?
hh:mm:ss.us o
Time of the day
expressed in T0D#00:00:00
TIME_OF_DAY milliseconds, represented 32 to
with format hh:mm:ss. TOD#23:59:59.999
ms
Time of the day
expressed in 1.TOD#00:00:00
LTIME_OF_DAY nanoseconds, 64 to
represented with format LTOD#23:59:59.999999999
hh:mm:ss.ns
Referece to a variable of See 11.1.2.1 for further
VAN
ANY_TYPE any type (IEC standard) 32/64 information
Pointer to a variable
@ANY_TYPE | of any type (NOT IEC 32/64|  S¢€ }ﬁfgmzq ;‘t’iglf]“ther
standard)
Pointer to a generic
variable, without type See 11.7.2 for further
PVOID specified (NOT IEC 32/64 information
standard)

11.1.2.1 REFERENCES

References are a standard IEC type that act as a pointer to another variable (the refer-
enced variable). Reference type works like the pointer type (see paragraph 11.7.2), but
the pointer type is not a standard IEC type and has several less restricion, which make the
pointer type more flexible but also more dangerous than the reference type.

The value of the reference is the address of the referenced variable; in order to access the
data stored at the referenced address, a reference can be dereferenced.

Reference declaration requires the same syntax used in variable declaration, where the
type name is the type name of the referenced variable with ~ sign after:
VAR
<reference_var_name> : <referenced_var_type>";
END_VAR

For example, the declaration of a reference to an INT shall be as follows:
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VAR
rint : INTA;
END_VAR

Reference can be assigned with another reference or with an address; the special operator REF is
available to retrieve the reference address of a variable.

rx :=ry; (* where rx and ry are reference of the same type *)
rx := REF(x); (* where rx is a reference to the same type of x *)

Accessing to the reference variable followed by the ~ sign, will dereference the variable:

rx := REF(x); (* rx i a reference to x *)

rx” 1= 10; (* x vaule is now 10 *)

XN i=rx™ +1; (* x value now is 11 *)

y 1= rx"; (* y value now is 11, y is of the same type of x *)

For further information about references, please refer to IEC standard reference.

11.1.3 DERIVED DATA TYPES

Derived data types can be declared using the TYPE...END TYPE construct. They can be
used in variable declarations, in addition to the elementary data types.

Both single-element variables and elements of a multi-element variable, which are de-
clared to be of derived data types, can be used anywhere where a variable of its parent
type can be used.

11.1.3.1 TYPEDEFS

The purpose of typedefs is to assign alternative names to existing types. There are not
any differences between a typedef and its parent type, except the name.

Typedefs can be declared using the following syntax:
TYPE
<enumerated data type name> : <parent type name>;
END TYPE

For example, consider the following declaration, mapping the name LONGWORD to the IEC
61131-3 standard type DWORD:

TYPE
longword : DWORD;
END TYPE

11.1.3.2 ENUMERATED DATA TYPES

(©.C)
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An enumerated data type declaration specifies that the value of any data element of that
type can only be one of the values given in the associated list of identifiers. The enumera-
tion list defines an ordered set of enumerated values, starting with the first identifier of
the list, and ending with the last.

Enumerated data types can be declared using the following syntax:
TYPE
<enumerated data type name> : ( <enumeration list> );
END TYPE

For example, consider the following declaration of two enumerated data types. Note that,
when no explicit value is given to an identifier in the enumeration list, its value equals the
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value assigned to the previous identifier augmented by one.

TYPE
enuml: (
vall, (* the value of vall is 0 *)
valz, (* the value of val2 is 1 *)
val3 (* the value of val3 is 2 *)
)
enum2: (
k := -11,
i := 0,
3, (* the value of j is (i + 1) =1 *)
1l :=5
)
END TYPE

Different enumerated data types may use the same identifiers for enumerated values. In
order to be uniquely identified when used in a particular context, enumerated literals may
be qualified by a prefix consisting of their associated data type name and the # sign.

11.1.3.3 SUBRANGES

A subrange declaration specifies that the value of any data element of that type is re-
stricted between and including the specified upper and lower limits.

Subranges can be declared using the following syntax:
TYPE

<subrange name> : <parent type name> ( <lower limit>..<upper limit>
);
END TYPE
For a concrete example consider the following declaration:
TYPE
int 0 to 100 : INT (0..100);
END TYPE

11.1.3.4 STRUCTURES

A sTRUCT declaration specifies that data elements of that type shall contain sub-elements
of specified types which can be accessed by the specified names.

Structures can be declared using the following syntax:
TYPE
<structured type name> : STRUCT
<declaration of structurestructure elements>
END STRUCT;
END TYPE
For example, consider the following declaration:
TYPE
structurel : STRUCT
eleml : USINT;
elem2 : USINT;
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elem3 : INT;
elem3 : REAL;
END STRUCT;
END TYPE

11.1.4 LITERALS

11.1.4.1 NUMERIC LITERALS

External representation of data in the various programmable controller programming lan-
guages consists of numeric literals.

There are two classes of numeric literals: integer literals and real literals. A numeric literal
is defined as a decimal number or a based number.

Decimal literals are represented in conventional decimal notation. Real literals are dis-
tinguished by the presence of a decimal point. An exponent indicates the integer power
of ten by which the preceding number needs to be multiplied to obtain the represented
value. Decimal literals and their exponents can contain a preceding sign (+ or -).

Integer literals can also be represented in base 2, 8 or 16. The base is in decimal notation.
For base 16, an extended set of digits consisting of letters A through F is used, with the
conventional significance of decimal 10 through 15, respectively. Based numbers do not
contain any leading sign (+ or -).

Boolean data are represented by the keywords FALSE or TRUE.
Numerical literal features and examples are shown in the table below.

Feature description Examples
Integer literals -12 0 123 +986
Real literals -12.0 0.0 0.4560
-1.34E-12 or -1.34e-12
Real literals with exponents 1.0E+6 or 1.0e+6

1.234E6 or 1.234e6

2#11111111 (256 decimal)
2#11100000 (240 decimal)

8#377 (256 decimal)
8#340 (240 decimal)

16#FF or 164#ff (256 decimal)
16#E0 or 16#e0 (240 decimal)

Boolean FALSE and TRUE FALSE TRUE

Base 2 literals

Base 8 literals

Base 16 literals

11.1.4.2 STRING CHARACTER LITERALS
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A string character literal is a sequence of zero or more characters prefixed and terminated

by the single quote character (‘).

The three-character combination of the dollar sign ($) followed by two hexadecimal digits
shall be interpreted as the hexadecimal representation of the eight-bit character code.

Example Explanation
v Empty string (length zero)
'A! String of length one containing the single character A
v String of length one containing the space character

188 Arduino PLC IDE user manual



ARDUINO PLC IDE

Example Explanation
R String of length one containing the singile quote character
v String of length one containing the doubile quote character
'SRSL! String of length two containing CR and LF characters
"SOA" String of length one containing the LF character

Two-character combinations beginning with the dollar sign shall be interpreted as shown
in the following table when they occur in character strings.

Combination Interpretation when printed

$9 Dollar sign
$! Single quote

SL or $1 Line feed

SN or $n Newline

SP or Sp Form feed (page)

SR OF $r Carriage return

ST Or St Tab

11.1.4.3 WIDE STRING CHARACTER LITERALS

A wide string character literal is a sequence of zero or more characters prefixed and ter-
minated by the double quote character ().

The three-character combination of the dollar sign ($) followed by two hexadecimal digits
shall be interpreted as the hexadecimal representation of the eight-bit character code.

Example

Explanation

ANINY

Empty wide string (length zero)

wp

Wide string of length one containing the single character A

ASWRRNY

Wide string of length one containing the space character

N

Wide string of length one containing the single quote character

l$lll

Wide string of length one containing the double quote character

A\ $R$L//

Wide string of length two containing CR and LF characters

AN} $ OA”

Wide string of length one containing the LF character

Two-character combinations beginning with the dollar sign shall be interpreted as shown
in the following table when they occur in wide character strings.

Combination Interpretation when printed

$S Dollar sign
$” Double quote

$L or $1 Line feed

SN or $n Newline

$P or Sp Form feed (page)

SR Or $r Carriage return

ST or $t Tab
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11.1.4.4 DATE AND TIME LITERALS

Date and time literals are defined by specifing the type name, the sharp character and
the desired value; the value format depends on the specific data type, as shown in the

table below:
Type Example Explanation
32 bits value.
DATE DATE#1980-01-05
YYYY-MM-DD
64-bit value.
LDATE LDATE#1980-01-05
YYYY-MM-DD
32 bits value.
DATE AND TIME#1980-01-05-00:05:10 |YYYY-MM-DD-hh:mm:ss.ms
DATE AND TIME or Milliseconds are optional, so a
- = valid declaration can stops to
DT#1980-01-05-00:05:10.123 seconds.
YYYY-MM-DD-hh:mm:ss
64 bits value.
YYYY-MM-DD-hh:mm:ss.ns
LDATE AND TIME#1980-01-05- Milli d . d
00:05:10.123456 illiseconds, microseconds
LDATE AND TIME and nanoseconds are
- or optional, so a valid
LDT#2080-01-05-20:05:10.123 456 789 | declaration can stops to
seconds.
YYYY-MM-DD-hh:mm:ss
TIME TIME#20d5h4m7s20ms 32 bits value.
LTIME LTIME#105d5h4m7s20ms50us30ns 64 bits value.
32 bits value.
hh:mm:ss.ms
TIME OF DAY TOD#13:40:55.123 Milliseconds are optional, so a
- valid declaration can stops to
seconds.
hh:mm:ss
64 bits value.
hh:mm:ss.ns
Milliseconds, microseconds
LTIME OF DAY LTOD#13:40:55.123456789 and nanoseconds are
-~ optional, so a valid
declaration can stops to
seconds.
hh:mm:ss

11.1.5 VARIABLES
11.1.5.1 FOREWORD

Variables provide a means of identifying data objects whose contents may change, e.g.,
data associated with the inputs, outputs, or memory of the programmable controller. A
variable must be declared to be one of the elementary types. Variables can be represent-
ed symbolically, or alternatively in a manner which directly represents the association of
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the data element with physical or logical locations in the programmable controller’s input,
output, or memory structure.

Each program organization unit (POU) (i.e., each program, function, or function block)
contains at its beginning at least one declaration part, consisting of one or more structur-
ing elements, which specify the types (and, if necessary, the physical or logical location)
of the variables used in the organization unit. This declaration part has the textual form of
one of the keywords VAR, VAR INPUT, or VAR OUTPUT as defined in the keywords section,
followed in the case of VAR by zero or one occurrence of the qualifiers RETAIN, NON RE-
TAIN or the qualifier CONSTANT, and in the case of VAR INPUT or VAR OUTPUT by zero or
one occurrence of the qualifier RETAIN or NON RETAIN, followed by one or more decla-
rations separated by semicolons and terminated by the keyword END VAR. A declaration
may also specify an initialization for the declared variable, when a programmable control-
ler supports the declaration by the user of initial values for variables.

11.1.5.2 STRUCTURING ELEMENT

The declaration of a variable must be performed within the following program structuring
element:

KEYWORD [RETAIN] [CONSTANT]
Declaration 1

Declaration 2

Declaration N

END VAR

11.1.5.3 KEYWORDS AND SCOPE

Keyword Variable usage
VAR Internal to organization unit.
VAR INPUT Externally supplied.

Supplied by organization unit to external
entities.

Supplied by external entities, can be
modified within organization unit.

Supplied by configuration via VAR GLOBAL,
can be modified within organization unit.

VAR GLOBAL [ Global variable declaration.

VAR OUTPUT

VAR _IN OUT

VAR EXTERNAL

The scope (range of validity) of the declarations contained in structuring elements is local
to the program organization unit (POU) in which the declaration part is contained. That
is, the declared variables are accessible to other program organization units except by
explicit argument passing via variables which have been declared as inputs or outputs of
those units. The one exception to this rule is the case of variables which have been de-
clared to be global.

Such variables are accessible to programs in any case, or via a VAR EXTERNAL declaration
to function blocks and functions. The type of a variable declared in a VAR EXTERNAL must
agree with the type declared in the vAR GLOBAL block.

To give access to this variables to all type of POU, without using any keyword, you must
enable this option in the code generation tab of the project options (see Paragraph 4.6.2).

There is an error if:
- any program organization unit attempts to modify the value of a variable that has been
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declared with the consTanT qualifier;

- a variable declared as VAR _GLOBAL CONSTANT in a configuration element or program or-
ganization unit (the “containing element”) is used in a VAR EXTERNAL declaration (with-
out the consTANT qualifier) of any element contained within the containing element.

11.1.5.4 QUALIFIERS

Qualifier

Description

CONST

The attribute coNsT indicates that the variables within
the structuring elements are constants, i.e. they have
a constant value, which cannot be modified once the
PLC project has been compiled.

RETAIN

The attribute RETAIN indicates that the variables
within the structuring elements are retentive, i.e. they
keep their value even after the target device is reset
or switched off.

11.1.5.5 SINGLE-ELEMENT VARIABLES AND ARRAYS

A single-element variable represents a single data element of either one of the elemen-
tary types or one of the derived data types.

An array is a collection of data elements of the same data type; in order to access a single
element of the array, a subscript (or index) enclosed in square brackets has to be used.
Subscripts can be either integer literals or single-element variables.

To easily represent data matrices, arrays can be multi-dimensional; in this case, a com-
posite subscript is required, one index per dimension, separated by commas. The maxi-
mum number of dimensions allowed in the definition of an array is three.

11.1.5.6 DECLARATION SYNTAX

Variables must be declared within structuring elements, using the following syntax:

VarNamel

VarName?2 AT Location2

Typenamel

[ := Initialvall ];

: Typename2 [ := Initialval2 ];

VarName3 : ARRAY [ 0..N ] OF Typename3;
where:

Keyword Description
Variable identifier, consisting of a string of

VarNameX alphanumeric characters, of length 1 or more. It is
used for symbolic representation of variables.
Data type of the variable, selected from elementary

TypenameX
data types.

TnitialvalX The value the variable assumes after reset of the

target.

LocationX See the next paragraph.

N Index of the last element, the array having length
N + 1.
.
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11.1.5.7 LOCATION

Variables can be represented symbolically, i.e. accessed through their identifier, or alter-
natively in a manner which directly represents the association of the data element with
physical or logical locations in the programmable controller’s input, output, or memory
structure.

Direct representation of a single-element variable is provided by a special symbol formed
by the concatenation of the percent sign “%” , a location prefix and a size prefix, and one
or two unsigned integers, separated by periods (.).

%location size index.subindex
1) location
The location prefix may be one of the following:

Location prefix Description
I Input location
Q Output location
M Memory location

2) size
The size prefix may be one of the following:

Size prefix Description
Single bit size
Byte (8 bits) size
Word (16 bits) size
Double word (32 bits) size
Long word (64 bits) size
Real (32 bits) size
Lorg real (64 bits) size

O|W|leH|lo|l=|w

3) index.index

This sequence of unsigned integers, separated by dots, specifies the actual position
of the variable in the area specified by the location prefix.

Example:

Direct representation Description

Word starting from the first byte of the 7t
element of memory datablock 4.

First bit of the first byte of the 5™ element
of input set 0.

SMW4 . 6

$IX0.4

Note that the absolute position depends on the size of the datablock elements, not on the
size prefix. As a matter of fact, sMw4.6 and sMD4.6 begin from the same byte in memory,
but the former points to an area which is 16 bits shorter than the latter.

For advanced users only: if the index consists of one integer only (no dots), then it loses
any reference to data blocks, and it points directly to the byte in memory having the index
value as its absolute address.
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Direct representation Description
Word starting from the first byte of the 7t

SMW4 . 6 .
element of datablock 4 in memory.
SMW4 Word starting from byte 4 of memory.
Example

VAR [RETAIN] [CONSTANT]

XQuote : DINT; Enabling : BOOL := FALSE;

TorqueCurrent AT $MW4.32 : INT;

Counters : ARRAY [ O .. 9 ] OF UINT;
Limits: ARRAY [0..3, 0..9]
END_ VAR

Variable xQuote is 32 bits long, and it is automatically allocated by the PLC IDE compiler.
Variable Enabling is initialized to FALSE after target reset.

Variable TorqueCurrent is allocated in the memory area of the target device, and it
takes 16 bits starting from the first byte of the 33 element of datablock 4.

Variable counters is an array of 10 independent variables of type unsigned integer.

11.1.5.8 DECLARING VARIABLES IN PLC IDE

11.1.

Whatever the PLC language you are using, PLC IDE allows you to disregard the syntax
above, as it supplies the Local variables editor, the Global variables editor, and the Param-
eters editor, which provide a friendly interface to declare all kinds of variables.

6 PROGRAM ORGANIZATION UNITS

Program organization units are functions, function blocks, and programs. Program Organ-
ization Units can be delivered by the manufacturer, or programmed by the user through
the means defined in this part of the standard

Program organization units are not recursive; that is, the invocation of a program organi-
zation unit cannot cause the invocation of another program organization unit of the same

type.

11.1.6.1 FUNCTIONS
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Introduction

For the purposes of programmable controller programming languages, a function is de-
fined as a program organization unit (POU) which, when executed, yields exactly one data
element, which is considered to be the function result.

Functions contain no internal state information, i.e., invocation of a function with the
same arguments (input variables VAR INPUT and in-out variables VAR IN ouUT) always
yields the same values (output variables VAR OUTPUT, in-out variables vAR IN ouT and
function result).
Declaration syntax
The declaration of a function must be performed as follows:
FUNCTION FunctionName : RetDataType
VAR INPUT
declaration of input variables (see the relevant section)
END VAR
VAR EXTERNAL
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declaration of external variables

END VAR
VAR _IN OUT

declaration of in out variables
END VAR
VAR
declaration of local variables (see the relevant section)
END VAR
Function body
END FUNCTION

Keyword Description

FunctionName Name of the function being declared.

RetDataType Data type of the value to be returned by the function.

A function can access global variables only if they are
VAR _EXTERNAL .. [listed in @ VAR EXTERNAL structuring element. Variables

END VAR passed to the FB via a VAR EXTERNAL construct can be
modified from within the FB.

Specifies the operations to be performed upon the
input variables in order to assign values dependent on
the function’s semantics to a variable with the same
name as the function, which represents the function
result. It can be written in any of the languages
supported by PLC IDE.

Function body

Declaring functions in PLC IDE

Whatever the PLC language you are using, PLC IDE allows you to disregard the syntax
above, as it supplies a friendly interface for using functions.

Special cases when using VAR_IN_OUT

- VAR_IN_OUT variables always have the precedence against INPUT variables. So if you
have both VAR_IN_OUT and VAR_INPUT as input parameters of a function, you have to
assign first all the VAR_IN_OUT and then the VAR_INPUT.

- When assinging variables to input parameters, you have to respect the order defined by
the function prototype (first all the VAR_IN_OUT in their correct order, then the VAR_IN-
PUT in their correct order).

- Differently from VAR_INPUT, the VAR_IN_OUT doesn’t have a default value. So all the
VAR_IN_OUT declared by the function prototype, must be correctly assigned in order to
make a valid function call.

- VAR_IN_OUT are always assigned by reference; so they cannot be assigned to constant.
Furthermore the VAR _IN_OUT by reference option, selectable in Project/option/code
generation panel (see chapter 4.6.2), is not valid for functions (only function blocks).

11.1.6.2 FUNCTION BLOCKS

Introduction

For the purposes of programmable controller programming languages, a function block is
a program organization unit which, when executed, yields one or more values. Multiple,
named instances (copies) of a function block can be created. Each instance has an associ-
ated identifier (the instance name), and a data structure containing its input, output and
internal variables. All the values of the output variables and the necessary internal vari-
ables of this data structure persist from one execution of the function block to the next;
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therefore, invocation of a function block with the same arguments (input variables) does

not always yield the same output values.

Only the input and output variables are accessible outside of an instance of a function
block, i.e., the function block’s internal variables are hidden from the user of the function
block.

In order to execute its operations, a function block needs to be invoked by another POU.

Invocation depends on the specific language of the module calling the function block.

The scope of an instance of a function block is local to the program organization unit in

which it is instantiated.

Declaration syntax
The declaration of a function must be performed as follows:
FUNCTION BLOCK FunctionBlockName

VAR INPUT

declaration of input variables (see the relevant section)

END VAR
VAR _OUTPUT

declaration of output variables

END VAR
VAR _EXTERNAL

declaration of external variables

END VAR
VAR _IN OUT

declaration of in out variables

END VAR
VAR

declaration of local variables

END VAR

Function block body

END FUNCTION BLOCK

Keyword

Description

FunctionBlockName

Name of the function block being declared (note:
name of the template, not of its instances).

VAR EXTERNAL .. END VAR

A function block can access global variables only

if they are listed in a VAR EXTERNAL structuring
element. Variables passed to the FB via a VAR
EXTERNAL construct can be modified from within the
FB.

Function block body

Specifies the operations to be performed upon the
input variables in order to assign values to the
output variables - dependent on the function block’s
semantics and on the value of the internal variables.
It can be written in any of the languages supported
by PLC IDE.

Declaring function blocks in PLC IDE
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Whatever the PLC language you are using, PLC IDE allows you to disregard the syntax
above, as it supplies a friendly interface for using function blocks.

11.1.6.3 PROGRAMS

Introduction
A program is defined in IEC 61131-1 as a “logical assembly of all the programming lan-
guage elements and constructs necessary for the intended signal processing required for
the control of a machine or process by a programmable controller system”.
Declaration syntax
The declaration of a program must be performed as follows:
PROGRAM < program name>
Declaration of variables (see the relevant section)
Program body
END_PROGRAM

Keyword Description
Program Name Name of the program being declared.
Specifies the operations to be performed to get the
Program body intended signal processing. It can be written in any of
the languages supported by PLC IDE.

Writing programs in PLC IDE

Whatever the PLC language you are using, PLC IDE allows you to disregard the syntax
above, as it supplies a friendly interface for writing programs.

11.1.7 OBJECT ORIENTED REFERENCE

Object Oriented feature is achieved by enhancing the function block POU, there is not a
specific element of type “class”.

This way a function block can have methods, which are handled like functions except that
they can see the relative function block context.

A function block can extends another function block (only one) in a father-child hierarchy;
and can implements any nhumber of interfaces.

Interfaces are handled like new type definitions and allow the user to specify a list of
method prototypes composed of name and expected input variables; also interfaces can
extends other interfaces (max one) in a father-child hierarchy.

If a function block implements one or more interfaces, it must correctly implements all of
their methods in order to succesfully complete a project compilation.

PLC IDE can handle polimorphysm on both function blocks and interfaces.

11.1.8 IEC 61131-3 STANDARD FUNCTIONS

This paragraph is a reference of all IEC 61131-3 standard functions available in PLC IDE,
along with a few others, which may be considered as PLC IDE’s extensions to the stand-
ard.

These functions are common to the whole set of programming languages and can there-
fore be used in any Programmable Organization Unit (POU).

A function specified in this paragraph to be extensible (Ext.) is allowed to have a variable

number of inputs.
.
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Type conversion functions

According to the IEC 61131-3 standard, type conversion functions shall have the form *
TO **, where “*" is the type of the input variable, and “**" the type of the output variable
(for example, INT TO REAL). PLC IDE provides a more convenient set of overloaded type
conversion functions, relieving the developer to specify the input variable type.

TO_BOOL
Description Conversion to BOOL (boolean)
Number of operands | 1
Input data type Any numerical type
Output data type BOOL
out := TO_BOOL( O ); (* out = FALSE ¥*)
Examples out := TO BOOL( 1 ); (* out = TRUE ¥*)
out := TO BOOL( 1000 ); (* out = TRUE *)
TO_BYTE
Description Conversion to BYTE (8-bit string)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type BYTE
out := TO BYTE( -1 ); (* out = 16#FF *)
Examples -
out := TO BYTE( 16#100 ); (* out = 16#00 *)
TO_DATE
Description Conversion to DATE (32-bit signed integer)
Number of operands | 1
Input data type DATE_AND_TIME, LDATE_AND_TIME, LDATE
Output data type DATE
Examples
TO_DATE_AND_TIME
Description Conversion to DATE_AND_TIME (32-bit signed integer)
Number of operands | 1
Input data type LDATE_AND_TIME
Output data type DATE_AND_TIME
Examples
TO_DINT
Description Conversion to DINT (32-bit signed integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type DINT
out := TO DINT( 10.0 ); (* out = 10 *)
Examples -
out := TO DINT( 16#FFFFFFFF ); (* out = -1 *)
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TO_DWORD

Description Conversion to DWORD (32-bit string)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type DWORD

out := TO DWORD( 10.0 ); (* out = 16#0000000A *)
Examples -

out := TO DWORD( -1 ); (* out = 16#FFFFFFFF *)

TO_INT

Description Conversion to INT (16-bit signed integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type INT

out := TO INT( -1000.0 ); (* out = -1000 *)
Examples -

out := TO INT( 16#8000 ); (* out = -32768 *)

TO_LDATE

Description Conversion to LDATE (64-bit signed integer)
Number of operands | 1
Input data type DATE_AND_TIME, LDATE_AND_TIME, DATE
Output data type LDATE

Examples

TO_LDATE_AND_TIME

Description

Conversion to LDATE_AND_TIME (64-bit signed integer)

Number of operands

1

Input data type

DATE_AND_TIME

Output data type

LDATE_AND_TIME

Examples

TO_LINT
Description Conversion to LINT (64-bit signed integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type LINT
out := TO LINT( -1 ); (* out = -1 *)
Examples -
out := TO LINT(l6#FFFFFFFFFFFFFFFF); (* out = -1 *)
TO_LREAL
Description Conversion to LREAL (64-bit floating point)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type LREAL
PLC
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TO_LREAL
out := TO LREAL( -1000 ); (* out = -1000.0 ¥*)
Examples -
out := TO_LREAL( 16#8000 ); (* out = -32768.0 ¥*)
TO_LTIME
Description Conversion to LTIME (64-bit signed integer)
Number of operands | 1
Input data type TIME
Output data type LTIME
Examples
TO_LTIME_OF_DAY
Description Conversion to LTIME_OF_DAY (64-bit signed integer)
Number of operands | 1
Input data type TIME_OF_DAY, DATE_AND_TIME, LDATE_AND_TIME
Output data type LTIME_OF_DAY
Examples
TO_LWORD
Description Conversion to LWORD (64-bit unsigned integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type LWORD
out := TO LWORD( 10.0 ); (* out =
16#000000000000000A *)
Examples
out := TO LWORD( -1 ); (* out = 16#FFFFFFFFFFFFFFFF
*)
TO_POINTER
Description Conversion to pointer
Number of operands | 1
Input data type Any numerical type
Output data type UNDEFINED
Examples out := TO POINTER( example var );
TO_REAL
Description Conversion to REAL (32-bit floating point)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type REAL
out := TO REAL( -1000 ); (* out = -1000.0 *)
Examples -
out := TO REAL( 16#8000 ); (* out = -32768.0 *)
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TO_SINT

Description Conversion to SINT (8-bit signed integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type SINT

out := TO SINT( -1 ); (* out = -1 *)
Examples -

out := TO SINT( 16#100 ); (* out = 0 *)

TO_STRING

Description Conversion to STRING
Number of operands | 1
Input data type Any numerical type
Output data type STRIN

str := TO STRING( 10.0 ); (* str = ‘10,0’ ¥*)
Examples -

str := TO _STRING( -1 ); (* str = ‘-1' *)

TO_TIME

Description Conversion to LTIME (32-bit signed integer)
Number of operands | 1
Input data type LTIME
Output data type TIME

Examples

TO_TIME_OF_DAY

Description

Conversion to TIME_OF_DAY (32-bit signed integer)

Number of operands

1

Input data type

LTIME_OF_DAY, DATE_AND_TIME, LDATE_AND_TIME

Output data type

TIME_OF_DAY

Examples

TO_UDINT
Description Conversion to UDINT (32-bit unsigned integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type UDINT
out := TO UDINT( 10.0 ); (* out = 10 *)
Examples out := TO UDINT( 16#FFFFFFFF ); (* out = 4294967295
*)
TO_UINT
Description Conversion to UINT (16-bit unsigned integer)
Number of operands | 1

Input data type

Any numerical type or STRING
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TO_UINT
Output data type UINT
out := TO UINT( 1000.0 ); (* out = 1000 *)
Examples -
out := TO UINT( 16#8000 ); (* out = 32768 *)
TO_ULINT
Description Conversion to ULINT (64-bit unsigned integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type ULINT
out := TO ULINT( 10.0 ); (* out = 10 *)
Examples out := TO_ULINT( l16#FFFFFFFFFFFFFFFF ); (* out =
18446744073709551615 *)

TO_USINT

Description Conversion to USINT (8-bit unsigned integer)
Number of operands | 1
Input data type Any numerical type or STRING
Output data type USINT

out := TO USINT( -1 ); (* out = 255 *)
Examples -

out := TO USINT( 16#100 ); (* out = 0 *)

TO_WORD

Description Conversion to WORD (16-bit string)
Number of operands |1
Input data type Any numerical type or STRING
Output data type WORD

out := TO WORD( 1000.0 ); (* out = 16#03E8 *)
Examples -

out := TO WORD( -32768 ); (* out = 16#8000 *)

TO_WSTRING

Description Conversion to WSTRING
Number of operands | 1
Input data type Any numerical type
Output data type WSTRING

wstr := TO STRING( 10.0 ); (* wstr = “10,0” *)
Examples -

wstr := TO STRING( -1 ); (* wstr = “-1" *)

Numerical functions

The availability of the following functions depends on the target device. Please refer to
your hardware supplier for details.

ABS
Description Absolute value. Computes the absolute value of the input
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ABS

Number of operands

1

Input data type

Any numerical type

Output data type

Same as input

OUT := ABS( -5 ); (* OUT = 5 *)
Examples OUT := ABS( -1.618 ); (* OUT = 1.618 *)
OUT := ABS( 3.141592 ); (* OUT = 3.141592 *)
ACOS

Description

Arc cosine. Computes the principal arc cosine of input #0;
result is expressed in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := ACOS( 1.0 ); (* OoUT = 0.0 *)

OUT := ACOS( -1.0 ); (* OUT = PI *)

ADD

Description

Arithmetic addition. Computes the sum of the two inputs.

Number of operands

2

Input data type

Any numerical type, Any numerical type

Output data type

Same as Inputs

Examples

OUT := ADD( 20, 40 ); (* OUT = 60 ¥*)

ASIN

Description

Arc sine. Computes the principal arc sine of input #0; result
is expressed in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

OUT := ASIN( 0.0 ); (* OUT = 0.0 *)
Examples
OUT := ASIN( 1.0 ); (* OUT = PI / 2 *)
ATAN

Description

Arc tangent. Computes the principal arc tangent of input
#0; result is expressed in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := ATAN( 0.0 ); (* OUT = 0.0 ¥*)

OUT := ATAN( 1.0 ); (* OUT = PI / 4 *)

(O 0]
PLC

Arduino PLC IDE user manual 203



ARDUINO PLC IDE

ATAN2*

Description

Arc tangent (with 2 parameters). Computes the principal arc
tangent of Y/X; result is expressed in radians

Number of operands

2

Input data type

LREAL where available, REAL otherwise;
LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

OUT := ATAN2( 0.0, 1.0 ); (* oUT = 0.0 *)
OUT := ATAN2( 1.0, 1.0 ); (* OUT = PI / 4 *)
Examples OUT := ATAN2( -1.0, -1.0 ); (* OUT = ( -3/4 ) * PI
*)
OUT := ATAN2( 1.0, 0.0 ); (* OUT = PI / 2 *)
CEIL*

Description

Rounding up to integer. Returns the smallest integer that is
greater than or equal to input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

OUT := CEIL( 1.95 ); (* OUT = 2.0 *)
Examples
OUT := CEIL( -1.27 ); (* OUT = -1.0 *)
(o0 1

Description

Cosine. Computes the cosine function of input #0 expressed
in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := COS( 0.0 ); OUuT 1.0 *)
OouT COS( -3.141592 ); (* OUT ~ -1.0 ¥*)

(*

COSH*

Description

Hyperbolic cosine. Computes the hyperbolic cosine function
of input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := COSH( 0.0 ); (* OUT = 1.0 ¥*)

DIV

Description

Arithmetic division. Divides input #0 by input #1

Number of operands

2

Input data type

Any numerical type, Any numerical type

Output data type

Same as Inputs
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DIV

Examples

OUT := DIV( 20, 2 ); (* OUT = 10 ¥*)

EXP

Description

Natural exponential. Computes the exponential function of
input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := EXP( 1.0 ); (* OUT ~ 2.718281 ¥*)

FLOOR*

Description

Rounding down to integer. Returns the largest integer that is
less than or equal to input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := FLOOR( 1.95 ); (* OUT = 1.0 *)
OUT := FLOOR( -1.27 ); (* OUT = -2.0 ¥*)

LN

Description

Natural logarithm. Computes the logarithm with base e of
input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := LN( 2.718281 ); (* OUT = 1.0 *)

LOG

Description

Common logarithm. Computes the logarithm with base 10 of
input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples OUT := LOG( 100.0 ); (* OUT = 2.0 *)
MOD

Description Module. Computes input #0 module input #1

Number of operands |2

Input data type

Integer type, integer type

Output data type

Same as Inputs

Examples

OUT := MOD( 10, 3 ); (* OUT = 1 ¥*)
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MUL
Description Arithmetic multiplication. Multiplies the two inputs.
Number of operands | 2
Input data type Any numerical type, Any numerical type
Output data type Same as Inputs
Examples OUT := MUL( 10, 10 ); (* OUT = 100 *)
POW
Description Exponentiation. Raises Base to the power Expo

Number of operands | 2

LREAL where available, REAL otherwise;

Input data type ) .
LREAL where available, REAL otherwise

Output data type LREAL where available, REAL otherwise

OUT := POW( 2.0, 3.0 ); (* OUT = 8.0 *)
Examples

QUT := POW( -1.0, 5.0 ); (* OUT = -1.0 *)

SIN

Description f;g?a.n(éomputes the sine function of input #0 expressed in
Number of operands | 1
Input data type LREAL where available, REAL otherwise
Output data type LREAL where available, REAL otherwise

QUT := SIN( 0.0 ); (* OUT = 0.0 *)
Examples

OUT := SIN( 2.5 * 3.141592 ); (* OUT ~ 1.0 ¥*)

SINH*
Description :—rl]y;ﬁrzcc))lic sine. Computes the hyperbolic sine function of
Number of operands | 1
Input data type LREAL where available, REAL otherwise
Output data type LREAL where available, REAL otherwise
Examples OUT := SINH( 0.0 ); (* OUT = 0.0 ¥*)
SQRT
Description Square root. Computes the square root of input #0
Number of operands | 1
Input data type LREAL where available, REAL otherwise
Output data type LREAL where available, REAL otherwise
Examples OUT := SQRT( 4.0 ); (* OUT = 2.0 ¥*)
SUB

Description Arithmetic subtraction. Subtracts input #1 from input #0

Number of operands |2

(©.C)
PLC

206 Arduino PLC IDE user manual



ARDUINO PLC IDE

SUB

Input data type

Any numerical type, Any numerical type

Output data type

Same as Inputs

Examples

OUT := SUB( 10, 3 ); (* oUT = 7

*)

TAN

Description

Tangent. Computes the tangent function of input #0
expressed in radians

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := TAN( 0.0 ); (* OUT = 0.0 *)

OUT := TAN( 3.141592 / 4.0 ); (* OUT ~ 1.0 *)

TANH*

Description

Hyperbolic tangent. Computes the hyperbolic tangent
function of input #0

Number of operands

1

Input data type

LREAL where available, REAL otherwise

Output data type

LREAL where available, REAL otherwise

Examples

OUT := TANH( 0.0 ); (* OUT = 0.0 *)

*: function provided as extension to the IEC 61131-3 standard.

Bit string functions

AND

Description

Logical AND if both Input #0 and Input #1 are BOOL,
otherwise bitwise AND.

Number of operands

2

Input data type

Any but STRING, Any but STRING

Output data type

Same as Inputs

Examples

OUT := TRUE AND FALSE;
OUT := 16#1234 AND 16#5678;

(*

OouT =
(* OUT =

FALSE *)
16#1230 *)

NOT

Description

Logical NOT if Input is BOOL, otherwise bitwise NOT.

Number of operands

1

Input data type

Any but STRING

Output data type

Same as Inputs

Examples

OUT := NOT FALSE; (* OUT =
OUT := NOT 16#1234; (* OUT =

TRUE *)
16#EDCB *)
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OR

Logical OR if both Input #0 and Input #1 are BOOL,

e B otherwise bitwise OR.

Number of operands | 2

Input data type Any but STRING, Any but STRING
Output data type Same as Inputs
OUT := TRUE OR FALSE; (* OUT = FALSE *)
Examples
OUT := 16#1234 OR 16#5678; (* OUT = 16#567C *)
R
Description Reset operator: reset input to 0
Number of operands | 1
Input data type BOOL
Output data type Same as Input #0
Examples
ROL
Description Input #0 left-shifted of Input #1 bits, circular.
Number of operands |2
Input data type Any numerical type, Any numerical type
Output data type Same as Input #0
OUT := ROL( IN := 16#1000CAFE, 4 );
Examples
(* OUT = 16#000CAFELl *)
ROR
Description Input #0 right-shifted of Input #1 bits, circular.
Number of operands |2
Input data type Any numerical type, Any numerical type
Output data type Same as Input #0
OUT := ROR( IN := 16#1000CAFE, 16 );
Examples
(* OUT = 16#CAFE1000 *)
S
Description Set operator: set input to 1
Number of operands | 1
Input data type BOOL
Output data type Same as Input #0
Examples
SHL
Description Input#0 left-shifted of Input #1 bits, zero filled on the right.
Number of operands | 2
Input data type Any numerical type, Any numerical type
Output data type Same as Input #0
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SHL
OUT := SHL( IN := 16#1000CAFE, 16 );

(* OUT = 16#CAFE0000 ¥*)

Examples

SHR
D s - Input #0 right-shifted of Input #1 bits, zero filled on the
escription left

Number of operands | 2
Input data type Any numerical type, Any numerical type
Output data type Same as Input #0

OUT := SHR( IN := 16#1000CAFE, 24 );
Examples

(* OUT = 16#00000010 *)

XOR

Logical XOR if both Input #0 and Input #1 are BOOL,
otherwise bitwise XOR.

Number of operands |2

Description

Input data type Any but STRING, Any but STRING
Output data type Same as Inputs
OUT := TRUE OR FALSE; (* OUT = TRUE *)

Examples
16#1234 OR 16#5678; (* OUT = 16#444C *)

ouT :

Selection functions

LIMIT
. Limits Input #0 to be equal or more than Input#1, and
=R equal or less than Input #2.
Number of operands | 3
Input data type Any numerical type, Any numerical type, Any numerical type
Output data type Same as Inputs
OUT := LIMIT( IN := 4, MN := 0, MX := 5 ); (* OUT =
4 x)
OUT := LIMIT( IN := 88, MN := 0, MX := 5 ); (* OUT =
Examples 5 *)
OUT := LIMIT( IN := -1, MN := 0, MX := 5 ); (* OUT =
0 *)
MAX
Description Maximum value selection

Number of operands | 2, extensible
Any numerical type, Any numerical type, .., Any numerical

Input data type

type
Output data type Same as max Input
Examples OUT := MAX( -8, 120, -1000 ); (* OUT = 120 ¥*)
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MIN

Description

Minimum value selection

Number of operands

2, extensible

Input data type

Any numerical type, Any numerical type, .., Any numerical
type

Output data type

Same as min Input

Examples

ouT := MIN( -8, 120, -1000 ); (* OUT = -1000 ¥*)

MUX

Description

Multiplexer. Selects one of N inputs depending on input K

Number of operands

3, extensible

Input data type

Any numerical type, Any numerical type, ..., Any numerical
type

Output data type

Same as selected Input

Examples OUT := MUX( O, A, B, C ); (* OUT = A ¥*)
SEL

Description Binary selection
Number of operands | 3
Input data type BOOL, Any, Any
Output data type Same as selected Input

OUT := SEL( G := FALSE, INO := X, INl := 5 );
Examples

(* OUT = X *)

Comparison functions

Comparison functions can be also used to compare strings if this feature is supported by

target device.

EQ

Description

Equal to. Returns TRUE if Input #0 = Input #1, otherwise
FALSE.

Number of operands |2
Input data type Any, Any
Output data type BOOL
OUT := EQ( TRUE, FALSE ); (* OUT = FALSE *)
Examples
OUT := EQ( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
GE

Description

Greater than or equal to. Returns TRUE if Input #0 >=
Input #1, otherwise FALSE.

Number of operands |2
Input data type Any but BOOL, Any but BOOL
Output data type BOOL
OUT := GE( 20, 20 ); (* OUT = TRUE *)
Examples
OUT := GE( “‘AZ’, “ABC’ ); (* OUT = FALSE *)
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GT

Greater than. Returns TRUE if Input #0 > Input #1,
otherwise FALSE.

Number of operands |2

Description

Input data type Any but BOOL, Any but BOOL
Output data type BOOL
OUT := GT( 0, 20 ); (* OUT = FALSE *)
Examples
OUT := GT( ‘Az’, “‘ABC’ ); (* OUT = TRUE ¥*)
LE

Less than or equal to. Returns TRUE if Input #0 <= Input
#1, otherwise FALSE.

Number of operands |2

Description

Input data type Any but BOOL, Any but BOOL
Output data type BOOL
OUT := LE( 20, 20 ); (* OUT = TRUE *)
Examples
OUT := LE( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
LT
i - Less than. Returns TRUE if Input #0 < Input #1, otherwise
Description
FALSE.
Number of operands | 2
Input data type Any but BOOL, Any but BOOL
Output data type BOOL
OUT := LT( 0, 20 ); (* OUT = TRUE *)
Examples
OUT := LT( ‘AZ’, ‘ABC’ ); (* OUT = FALSE *)
NE

Not equal to. Returns TRUE if Input #0 != Input #1,
otherwise FALSE.

Number of operands |2

Description

Input data type Any, Any
Output data type BOOL

OUT := NE( TRUE, FALSE ); (* OUT = TRUE %)
Examples

OUT := NE( ‘Az’, “‘ABC’ ); (* OUT = TRUE ¥*)

String functions

The availability of the following functions depends on the target device. Please refer to
your hardware supplier for details.

CONCAT
Description Character string concatenation
Number of operands |2
Input data type STRING, STRING
Output data type STRING
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CONCAT

Examples

OUT := CONCAT( ‘AB’, ‘CD’ ); (* OUT = ‘ABCD’ ¥*)

DELETE

Description

Delete L characters of IN, beginning at the P-th character
position

Number of operands | 3
Input data type STRING, UINT, UINT
Output data type STRING
OUT := DELETE( IN := ‘ABXYC’, L :=2, P := 3 );
Examples
(* OUT = ‘ABC’' *)
FIND

Description

Find the character position of the beginning of the first
occurrence of IN2 in IN1. If no occurrence of IN2 is found,
then OUT := 0.

Number of operands |2
Input data type STRING, STRING
Output data type UINT
Fenles Sug *)= FIND( IN1 := ‘ABCBC’, IN2 := ‘BC’ ); (* OUT
INSERT
Description Insert IN2 into IN1 after the P-th character position
Number of operands | 3
Input data type STRING, STRING, UINT
Output data type STRING
OUT := INSERT( IN1 := ‘ABC’, IN2 := ‘XY', P := 2 );
Examples
(* OUT = ‘ABXYC’ *)
LEFT
Description Leftmost L characters of IN
Number of operands |2
Input data type STRING, UINT
Output data type STRING
e SI)JT := LEFT( IN := ‘ASTR’, L := 3 ); (* OUT = ‘AST’
LEN
Description Return the length of a string
Number of operands | 1
Input data type STRING
Output data type UINT
Examples OUT := LEN( ‘ASTRING’ ); (* OUT = 7 *)
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MID

Description L characters of IN, beginning at the P-th
Number of operands | 3
Input data type STRING, UINT, UINT
Output data type STRING

OUT := MID( IN := ‘ASTR’, L := 2, P := 2 );
Examples

(* OUT = ‘ST’ ¥*)

REPLACE

Description

Replace L characters of IN1 by IN2, starting at the P-th
character position

Number of operands | 4
Input data type STRING, STRING, UINT, UINT
Output data type STRING
S OUT_:= REPLACE ( II:Il 1= ‘Z’-\BCDE’ , IN2 := ‘X', L := 2,
P := 3 ); (* OUT = ‘ABXE’ ¥*)
RIGHT
Description Rightmost L characters of IN
Number of operands | 2
Input data type STRING, UINT
Output data type STRING
Examples OUT := RIGHT( IN := ‘ASTR’, L := 3 ); (* OUT =
VSTR’ %)
TO_STRINGFORMAT
Description Conversion to STRING, with format specifier
Number of operands |2
Input data type Any numerical type, STRING
Output data type STRING
Examples i‘)cr := TO STRINGFORMAT (10, ‘'%04d’); (* str = ‘0010’
TO_WSTRINGFORMAT
Description Conversion to WSTRING, with format specifier
Number of operands | 2
Input data type Any numerical type, WSTRING
Output data type WSTRING
Examples y;gjlro,:,=*T07WSTRINGFORMAT (10, '%04d’); (* wstr =
)
Standard operators
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ADR
Description Return the address of a variable
Number of operands | 1
Input data type Any
Output data type DWORD
Examples
IMOVE

Description

Valorize an interface using another interface and executing

a query interface; checking if the class that implement

the source interface is also implementing the destination

interface

Number of operands

1

Input data type

Interface instance

Output data type

NULL if error, any if ok

Examples
JMP

Description Jump to a specific label
Number of operands | 1
Input data type STRING
Output data type
Examples

MOVE

Description

Assign a value to a variable, equivalent of LD and ST

Number of operands

2

Input data type Any, Any
Output data type
Examples
REF
Description Return the reference to a variable
Number of operands | 1
Input data type Any

Output data type

Reference to the input variable

Examples

RET
Description Return
Number of operands |0

Input data type

Output data type

Examples
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SIZEOF
Description Return the size of a variable
Number of operands | 1
Input data type Any
Output data type UDINT

Examples

Date functions

CONCAT_DATE

Description

Create a valid DATE value given its single components (year,
month and day).

Number of operands | 3

Input data type INT, INT, INT

Output data type DATE

Examples i?t*;: CONCAT DATE (2020, 6, 17); (* out = 2020-06-

CONCAT_DATE_LTOD

Description

Concatenate a DATE and a LTIME_OF_DAY into a LDATE_
AND_TIME

Number of operands

2

Input data type

DATE, LTIME_OF_DAY

Output data type

LDATE_AND_TIME

Examples

out := CONCAT DATE LTOD(2020-06-17,
13:40:55.123456789); (* out = 2020-06-17-

13:40:55.123456789 *)

CONCAT_DATE_TOD

Description

Concatenate a DATE and a TIME_OF_DAY into a DATE_AND_
TIME

Number of operands

2

Input data type

DATE, TIME_OF_DAY

Output data type

DATE_AND_TIME

Examples

out := 13:40:55.123) ;

(* out =

CONCAT DATE TOD(2020-06-17,
2020-06-17-13:40:55.123 *)

CONCAT_DT

Description

Create a valid DATE_AND_TIME value given its single
components (year, month, day, hours, minutes, seconds).

Number of operands

2

Input data type

INT, INT, INT, INT, INT, INT

Output data type

DATE_AND_TIME

Examples

out := CONCAT DT (2020, 6,
2020-06-17-13:40:55 *)

17, 13, 40, 55); (* out =
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CONCAT_LDATE

Create a valid LDATE value given its single components

P (year, month and day).

Number of operands | 3

Input data type INT, INT, INT
Output data type LDATE
out := CONCAT LDATE (2020, 6, 17); (* out = 2020-06-
Examples 17 *) -
CONCAT_LDT
Create a valid LDATE_AND_TIME value given its single
Description components (year, month, day, hours, minutes, seconds,

milliseconds, microseconds, nanoseconds).

Number of operands |9

Input data type INT, INT, INT, INT, INT, INT, INT, INT, INT
Output data type LDATE_AND_TIME

out := CONCAT LDATE AND TIME (2020, 6, 17, 13, 40,
Examples 55, 123, 456, 789);

(* out = 2020-06-17-13:40:55.123456789 *)

CONCAT_LTOD

Create a valid LTIME_OF_DAY value given its single
Description components (hours, minutes, seconds, milliseconds,
microseconds and nanoseconds).

Number of operands | 6

Input data type INT, INT, INT, INT, INT, INT
Output data type LTIME_OF_DAY

out := CONCAT LTOD(13, 40, 55, 123, 456, 789); (*
Examples =

out = 13:40:55.123456789 ¥*)

CONCAT_TOD

Create a valid TIME_OF_DAY value given its single

D ription . -
escriptio components (hours, minutes, seconds, milliseconds).

Number of operands | 4

Input data type INT, INT, INT, INT
Output data type TIME_OF_DAY

out := CONCAT TOD(13, 40, 55, 123); (* out =
Examples "

13:40:55.123 *)

DAY_OF_WEEK

Get the day of week.
Description It returns the day of the week represented in a range from 0
(Sunday) to 6 (Saturday).

Number of operands | 1

Input data type LDATE
Output data type SINT
Examples out := DAY OF WEEK (2020-06-17); (* out = 3 *)
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SPLIT_DATE

Description

Split a LDATE into year, month and day integer pointer
vabiables. The function returns TRUE in case of no errors.

Number of operands

4

Input data type

DATE/LDATE, @INT, @INT, @INT

Output data type

BOOL

Examples

SPLIT_DT

Description

Split a DATE_AND_TIME into year, month, day, hours,
minutes and seconds integer pointer vabiables. The function
returns TRUE in case of no errors.

Number of operands

7

Input data type

DATE_AND_TIME, @INT, @INT, @INT, @INT, @INT, @INT

Output data type

BOOL

Examples

SPLIT_LDT

Description

Split a LDATE_AND_TIME into year, month, day, hours,
minutes, seconds, milliseconds, microseconds and
nanosecods integer pointer vabiables. The function returns
TRUE in case of no errors.

Number of operands

10

Input data type

DATE_AND_TIME, @INT, @INT, @INT, @INT, @INT, @INT, @
INT, @INT, @INT

Output data type

BOOL

Examples

SPLIT_LTOD

Description

Split a LTIME_OF_DAY into hours, minutes, seconds,
milliseconds, microseconds and nanoseconds integer pointer
vabiables. The function returns TRUE in case of no errors.

Number of operands

7

Input data type

LTIME_OF_DAY, @INT, @INT, @INT, @INT, @INT, @INT

Output data type

BOOL

Examples

SPLIT_TOD

Description

Split a TIME_OF_DAY into hours, minutes, seconds,
milliseconds integer pointer vabiables. The function returns
TRUE in case of no errors.

Number of operands |5
Input data type TIME_OF_DAY, @INT, @INT, @INT, @INT
Output data type BOOL

Examples
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11.2 INSTRUCTION LIST (IL)

This section defines the semantics of the IL (Instruction List) language.

11.2.1 SYNTAX AND SEMANTICS
11.2.1.1 SYNTAX OF IL INSTRUCTIONS

(©.C)
PLC

IL code is composed of a sequence of instructions. Each instruction begins on a new line
and contains an operator with optional modifiers, and, if necessary for the particular op-
eration, one or more operands separated by commas. Operands can be any of the data
representations for literals and for variables.

The instruction can be preceded by an identifying label followed by a colon (:). Empty
lines can be inserted between instructions.
Example
Let us parse a small piece of code:
START:
LD $IX1 (* Push button *)
ANDN $MX5.4 (* Not inhibited *)
ST $QX2 (* Fan out ¥*)
The elements making up each instruction are classified as follows:

Label [ +or2|‘:‘:itfci’err] Operand Comment

START: LD $IX1 (* Push button *)
ANDN $MX5. 4 (* Not inhibited *)
ST QX2 (* Fan out *)

Semantics of IL instructions
- Accumulator

By accumulator a register is meant containing the value of the currently evaluated re-
sult.

- Operators
Unless otherwise specified, the semantics of the operators is
accumulator := accumulator OP operand

That is, the value of the accumulator is replaced by the result yielded by operation OP
applied to the current value of the accumulator itself, with respect to the operand. For
instance, the instruction “AND %$1X1"” is interpreted as

accumulator := accumulator AND $%IX1

and the instruction “cT %1w10” will have the Boolean result TRUE if the current value
of the accumulator is greater than the value of input word 10, and the Boolean result
FALSE otherwise:

accumulator := accumulator GT $IW1O0
- Maodifiers
The modifier "N” indicates bitwise negation of the operand.

The left parenthesis modifier “(” indicates that evaluation of the operator must be de-
ferred until a right parenthesis operator “)” is encountered. The form of a parenthesized
sequence of instructions is shown below, referred to the instruction

accumulator := accumulator AND (%$MX1.3 OR $MX1.4)
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The modifier “c” indicates that the associated instruction can be performed only if the
value of the currently evaluated result is Boolean 1 (or Boolean 0 if the operator is com-
bined with the “N"” modifier).

11.2.2 STANDARD OPERATORS

Standard operators with their allowed modifiers and operands are as listed below.

Supported operand

Operator | Modifiers types: Acc_type, Semantics
Op_type
D N Any, Any Sets the accumulator equal to
operand.
ST N Any, Any Stores the accumul_ator into
operand location.
Sets operand to TRUE if
S BOOL, BOOL accumulator is TRUE.
Sets operand to FALSE if
R BOOL, BOOL accumulator is TRUE.
Any but REAL, Any but ; o
AND N, ( REAL Logical or bitwise AND
Any but REAL, Any but . o
OR N, ( REAL Logical or bitwise OR
Any but REAL, Any but . N
XOR N, | REAL Logical or bitwise x0OR
NOT Any but REAL Logical or bitwise NOT
ADD ( Any but BOOL Addition
SUB ( Any but BOOL Subtraction
MUL ( Any but BOOL Multiplication
DIV ( Any but BOOL Division
MOD ( Any but BOOL Modulo-division
GT ( Any but BOOL Comparison:
GE ( Any but BOOL Comparison: =
EQ ( Any but BOOL Comparison: =
NE ( Any but BOOL Comparison:
LE ( Any but BOOL Comparison:
LT ( Any but BOOL Comparison:
JMP , N Label Jumps to label
CAL , N FB instance name Calls function block
RET c, N Returns from called program,

function, or function block.

Evaluates deferred operation.
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11.2.3 CALLING FUNCTIONS AND FUNCTION BLOCKS
11.2.3.1 CALLING FUNCTIONS

Functions (as defined in the relevant section) are invoked by placing the function name in
the operator field. This invocation takes the following form:

LD 1
MUX 5, wvar0O, -6.5, 3.14
ST vRES

Note that the first argument is not contained in the input list, but the accumulator is used
as the first argument of the function. Additional arguments (starting with the 2), if re-
quired, are given in the operand field, separated by commas, in the order of their decla-
ration. For example, operator MUX in the table above takes 5 operands, the first of which
is loaded into the accumulator, whereas the remaining 4 arguments are orderly reported
after the function name.

The following rules apply to function invocation.

1) Assignments to vAR INPUT arguments may be empty, constants, or variables.

2) Execution of a function ends upon reaching a RET instruction or the physical end of
the function. When this happens, the output variable of the function is copied into the
accumulator.

Calling Function Blocks

Function blocks (as defined in the relevant section) can be invoked conditionally and un-
conditionally via the caL operator. This invocation takes the following form:

LD A

ADD 5

ST INSTS5.IN1
LD 3.141592
ST INSTS5.IN2
CAL INSTS

LD INST5.0UT1
ST vRES

LD INST5.0UT2
ST vVALID

This method of invocation is equivalent to a caL with an argument list, which contains only
one variable with the name of the FB instance.

Input arguments are passed to / output arguments are read from the FB instance through
ST / LD operations performed on operands taking the following form:

FBInstanceName.IO var

where
Keyword Description
FBInstanceName |Name of the instance to be invoked.
I0 var Input or output variable to be written / read.

11.3 FUNCTION BLOCK DIAGRAM (FBD)

This section defines the semantics of the FBD (Function Block Diagram) language.
.
PLC
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11.3.1 REPRESENTATION OF LINES AND BLOCKS

The graphic language elements are drawn using graphic or semi graphic elements, as
shown in the table below.

No storage of data or association with data elements can be associated with the use of
connectors; hence, to avoid ambiguity, connectors cannot be given any identifier.

Feature Example

Lines —L

Line crossing with connection

LinearProfileGen
Blocks with connecting lines ERIE T
and unconnected pins 3‘”“ actfos
targPos actSpeed

nomSpeed actéce

11.3.2 DIRECTION OF FLOW IN NETWORKS

A network is defined as a maximal set of interconnected graphic elements. A network
label delimited on the right by a colon (:) can be associated with each network or group
of networks. The scope of a network and its label is local to the program organization unit
(POU) where the network is located.

Graphic languages are used to represent the flow of a conceptual quantity through one
or more networks representing a control plan. Namely, in the case of function block dia-
grams (FBD), the “Signal flow"” is typically used, analogous to the flow of signals between
elements of a signal processing system. Signal flow in the FBD language is from the out-
put (right-hand) side of a function or function block to the input (left-hand) side of the
function or function block(s) so connected.

11.3.3 EVALUATION OF NETWORKS
11.3.3.1 ORDER OF EVALUATION OF NETWORKS

The order in which networks and their elements are evaluated is not necessarily the same
as the order in which they are labeled or displayed. When the body of a program organiza-
tion unit (POU) consists of one or more networks, the results of network evaluation within
the aforesaid body are functionally equivalent to the observance of the following rules:

1) No element of a network is evaluated until the states of all of its inputs have been
evaluated.

2) The evaluation of a network element is not complete until the states of all of its out-
puts have been evaluated.

3) As stated when describing the FBD editor, a network number is automatically as-
signed to every network. Within a program organization unit (POU), networks are
evaluated according to the sequence of their number: network N is evaluated before
network N+1, unless otherwise specified by means of the execution control elements.
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11.3.3.2 COMBINATION OF ELEMENTS

Elements of the FBD language must be interconnected by signal flow lines.

Outputs of blocks shall not be connected together. In particular, the “wired-0R" construct
of the LD language is not allowed, as an explicit Boolean “or” block is required.
Feedback

A feedback path is said to exist in a network when the output of a function or function
block is used as the input to a function or function block which precedes it in the network;
the associated variable is called a feedback variable.

Feedback paths can be utilized subject to the following rules:

1) Feedback variables must be initialized, and the initial value is used during the first
evaluation of the network. Look at the Global variables editor, the Local variables
editor, or the Parameters editor to know how to initialize the respective item.

2) Once the element with a feedback variable as output has been evaluated, the new
value of the feedback variable is used until the next evaluation of the element.

For instance, the Boolean variable rRUN is the feedback variable in the example shown

below.
Explicit loop
AND
oR &
|
Implicit loop

AND
or &
|

11.3.4 EXECUTION CONTROL ELEMENTS
11.3.4.1 EN/ENO SIGNALS

Additional Boolean N (Enable) input and ExO (Enable Out) characterize PLC IDE blocks,
according to the declarations

(©.C)
PLC

222 Arduino PLC IDE user manual



ARDUINO PLC IDE

EN ENO
VAR INPUT VAR OUTPUT
EN: BOOL := 1; ENO: BOOL;
END VAR END VAR

See the Modifying properties of blocks section to know how to add these pins to a block.

TON
IM ]
PT ET

When these variables are used, the execution of the operations defined by the block are
controlled according to the following rules:

1) If the value of EN is FALSE when the block is invoked, the operations defined by the
function body are not executed and the value of ENO is reset to FALSE by the program-
mable controller system.

2) Otherwise, the value of ENO is set to TRUE by the programmable controller system,
and the operations defined by the block body are executed.

11.3.4.2 JUMPS

Jumps are represented by a Boolean signal line terminated in a double arrowhead. The
signal line for a jump condition originates at a Boolean variable, or at a Boolean output of
a function or function block. A transfer of program control to the designated network label
occurs when the Boolean value of the signal line is TRUE; thus, the unconditional jump is
a special case of the conditional jump.

The target of a jump is a network label within the program organization unit within which
the jump occurs.

Symbol / Example Explanation
Unconditional Jump
E »Labeld Conditional Jump

Example: Jump Condition
Network
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11.3.4.3 CONDITIONAL RETURNS

- Conditional returns from functions and function blocks are implemented using a RETURN
construction as shown in the table below. Program execution is transferred back to the
invoking entity when the Boolean input is TRUE, and continues in the normal fashion
when the Boolean input is FALSE.

- Unconditional returns are provided by the physical end of the function or function block.

Symbol / Example Explanation

ED; RET Conditional Return

ES,
o > Example: Return Condition
Network

11.4 LADDER DIAGRAM (LD)

This section defines the semantics of the LD (Ladder Diagram) language.

11.4.1 POWER RAILS

The LD network is delimited on the left side by a vertical line known as the left power rail,
and on the right side by a vertical line known as the right power rail. The right power rail
may be explicit in the PLC IDE implementation and it is always shown.

The two power rails are always connected with an horizontal line named signal link. All LD
elements should be placed and connected to the signal link.

Description Symbol

Left power rail (with attached
horizontal link)

Right power rail (with attached
horizontal link)

Power rails connected by the | |
signal link ‘ ‘
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11.4.2 LINK ELEMENTS AND STATES

Link elements may be horizontal or vertical. The state of the link elements shall be de-
noted “oN” or “OFr”, corresponding to the literal Boolean values 1 or 0, respectively. The
term link state shall be synonymous with the term power flow.

The following properties apply to the link elements:

- The state of the left rail shall be considered onN at all times. No state is defined for the
right rail.

- A horizontal link element is indicated by a horizontal line. A horizontal link element
transmits the state of the element on its immediate left to the element on its immedi-
ate right.

- The vertical link element consists of a vertical line intersecting with one or more hori-
zontal link elements on each side. The state of the vertical link represents the inclusive
OR of the oN states of the horizontal links on its left side, that is, the state of the verti-
cal link is:

OFF if the states of all the attached horizontal links to its left are oFF;
ON if the state of one or more of the attached horizontal links to its left is ON.
- The state of the vertical link is copied to all of the attached horizontal links on its right.

- The state of the vertical link is not copied to any of the attached horizontal links on its
left.

Description Symbol

Vertical link with attached 1+
horizontal links

— +

11.4.3 CONTACTS

A contact is an element which imparts a state to the horizontal link on its right side which
is equal to the Boolean AND of the state of the horizontal link at its left side with an ap-
propriate function of an associated Boolean input, output, or memory variable.

A contact does not modify the value of the associated Boolean variable. Standard contact
symbols are given in the following table.

Name Description Symbol

The state of the left link is copied
to the right link if the state of the

Norz?)?]lgcc;pen associated Boolean variable is ON. _| |_
Otherwise, the state of the right
link is OFF.

The state of the left link is copied
to the right link if the state of the

Norn;g!%/acéltosed associated Boolean variable is OFF. 1
Otherwise, the state of the right
link is OFF.
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Name

Description

Symbol

Positive transition-
sensing contact

The state of the right link is

ON from one evaluation of

this element to the next when

a transition of the associated
variable from OFF to ON is sensed
at the same time that the state of
the left link is ON. The state of the
right link shall be OFF at all other
times.

Negative transition-
sensing contact

The state of the right link is

ON from one evaluation of

this element to the next when

a transition of the associated
variable from ON to OFF is sensed
at the same time that the state of
the left link is ON. The state of the
right link shall be OFF at all other
times.

Nt

11.4.4 COILS

A coil copies the state of the link on its left side to the link on its right side without modi-
fication, and stores an appropriate function of the state or transition of the left link into
the associated Boolean variable.

Standard coil symbols are shown in the following table.

Name

Description

Symbol

Coil

The state of the left link is
copied to the associated
Boolean variable.

{ ¥

Negated coil

The inverse of the state of

the left link is copied to the
associated Boolean variable,
that is, if the state of the left
link is OFF, then the state of the
associated variable is ON, and
vice versa.

{/F

SET (latch) coil

The associated Boolean variable
is set to the ON state when the
left link is in the ON state, and
remains set until reset by a
RESET coil.

RESET (unlatch) coil

The associated Boolean variable
is reset to the OFF state when
the left link is in the ON state,
and remains reset until set by a
SET coil.

Positive transition-
sensing coil

The state of the associated
Boolean variable is ON from
one evaluation of this element
to the next when a transition of
the left link from OFF to ON is
sensed.

Py
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Name Description Symbol

The state of the associated
Boolean variable is ON from

Negative transition- one evaluation of this element —{N]I—
sensing coil to the next when a transition of

the left link from ON to OFF is

sensed.

11.4.5 OPERATORS, FUNCTIONS AND FUNCTION BLOCKS

The representation of functions and function blocks in the LD language is similar to the
one used for FBD. At least one Boolean input and one Boolean output shall be shown on
each block to allow for power flow through the block as shown in the following figure.

timeExe1

sysDI sysD02
s

.

sysDIZ

11.5 STRUCTURED TEXT (ST)

This section defines the semantics of the ST (Structured Text) language.

11.5.1 EXPRESSIONS

An expression is a construct which, when evaluated, yields a value corresponding to one
of the data types listed in the elementary data types table. PLC IDE does not set any con-
straint on the maximum length of expressions.

Expressions are composed of operators and operands.

11.5.1.1 OPERANDS

An operand can be a literal, a variable, a function invocation, or another expression.

11.5.1.2 OPERATORS

Open the table of operators to see the list of all the operators supported by ST. The evalu-
ation of an expression consists of applying the operators to the operands in a sequence
defined by the operator precedence rules.

11.5.1.3 OPERATOR PRECEDENCE RULES

Operators have different levels of precedence, as specified in the table of operators. The
operator with highest precedence in an expression is applied first, followed by the opera-
tor of next lower precedence, etc., until evaluation is complete. Operators of equal prec-
edence are applied as written in the expression from left to right.

For example if A, B, C, and D are of type INT with values 1, 2, 3, and 4, respectively, then:
A+B-C*ABS (D)

yields -9, and:
(A+B-C) *ABS (D)
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yields 0.

When an operator has two operands, the leftmost operand is evaluated first. For example,
in the expression

SIN (A) *COS (B)

the expression sIN(a) is evaluated first, followed by cos (B), followed by evaluation of
the product.

Functions are invoked as elements of expressions consisting of the function name fol-
lowed by a parenthesized list of arguments, as defined in the relevant section.

11.5.1.4 OPERATORS OF THE ST LANGUAGE

Operation Symbol Precedence
Parenthesizing (<expression>) HIGHEST
Function evaluation <fname> (<arglist>)

Negation Complement
NOT

Exponentiation *x

Multiply Divide Modulo |/

MOD
+

Add Subtract

Comparison <, >, <=, >=

Equality Inequality -
Boolean AND AND
Boolean Exclusive or | XOR
Boolean Or OR LOWEST

11.5.2 STATEMENTS IN ST

All statements comply with the following rules:
- they are terminated by semicolons;

- unlike IL, a carriage return or new line character is treated the same as a space char-
acter;

- PLC IDE does not set any constraint on the maximum length of statements.
ST statements can be divided into classes, according to their semantics.

11.5.2.1 ASSIGNMENTS

Semantics

The assignment statement replaces the current value of a single or multi-element variable
by the result of evaluating an expression.

The assignment statement is also used to assign the value to be returned by a function,
by placing the function name to the left of an assignment operator in the body of the
function declaration. The value returned by the function is the result of the most recent
evaluation of such an assignment.
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Syntax
An assignment statement consists of a variable reference on the left-hand side, followed
by the assignment operator “:=", followed by the expression to be evaluated. For in-
stance, the statement

A =B ;

would be used to replace the single data value of variable A by the current value of vari-
able B if both were of type INT.
Examples
a :=Db ;
assignment
pCV := pCV + 1 ;
assignment
c := SIN( x );
assignment with function invocation
FUNCTION SIMPLE FUN : REAL

variables declaration

function body

SIMPLE FUN := a * b - ¢ ;
END FUNCTION
assigning the output value to a function

11.5.2.2 FUNCTION AND FUNCTION BLOCK STATEMENTS

Semantics

- Functions are invoked as elements of expressions consisting of the function name fol-
lowed by a parenthesized list of arguments. Each argument can be a literal, a variable,
or an arbitrarily complex expression.

- Function blocks are invoked by a statement consisting of the name of the function block
instance followed by a parenthesized list of arguments. Both invocation with formal ar-
gument list and with assignment of arguments are supported.

- RETURN: function and function block control statements consist of the mechanisms for
invoking function blocks and for returning control to the invoking entity before the phys-
ical end of a function or function block. The RETURN statement provides early exit from
a function or a function block (e.g., as the result of the evaluation of an IF statement).

Syntax

1) Function:

dst var := function name( argl, arg2 , ... , argN );

2) Function block with formal argument list:

instance name ( var_inl := argl ,
var _in2 := arg2 ,
4
var_inN := argN );

3) Function block with assignment of arguments:

instance name.var inl := argl;

instance name.var inN := argN;
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instance name () ;

4) Function and function block control statement:

RETURN;
Examples
CMD TMR( IN := %IX5,

PT:= 300 ) ;

FB invocation with formal argument list:

IN := %IX5 ;
PT:= 300 ;
CMD_TMR () ;

FB invocation with assignment of arguments:

a := CMD _TMR.Q;

FB output usage:

RETURN ;

early exit from function or function block.

11.5.2.3 SELECTION STATEMENTS

(©.C)
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Semantics

Selection statements include the IF and CASE statements. A selection statement selects
one (or a group) of its component statements for execution based on a specified condi-
tion.

IF: the 1F statement specifies that a group of statements is to be executed only if the
associated Boolean expression evaluates to the value TRUE. If the condition is false,
then either no statement is to be executed, or the statement group following the ELSE
keyword (or the ELSIF keyword if its associated Boolean condition is true) is executed.

CASE: the case statement consists of an expression which evaluates to a variable of
type DINT (the “selector”), and a list of statement groups, each group being labeled by
one or more integer or ranges of integer values, as applicable. It specifies that the first
group of statements, one of whose ranges contains the computed value of the selector,
is to be executed. If the value of the selector does not occur in a range of any case, the
statement sequence following the keyword ELSE (if it occurs in the CASE statement) is
executed. Otherwise, none of the statement sequences is executed.

PLC IDE does not set any constraint on the maximum allowed number of selections in
CASE statements.

Syntax

Note that square brackets include optional code, while braces include repeatable portions
of code.

1) IF:

IF expressionl THEN
stat list
[ { ELSIF expression?2 THEN
stat list } ]

ELSE
stat list
END IF ;
2) CASE:
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CASE expressionl OF
intv [ {, intv } ]
stat list
{ intv [ {, intv } ]
stat list }
[ ELSE
stat list ]
END CASE ;

intv being either a constant or an interval: a or a..b

Examples
1F statement:
IF d 0.0 THEN
nRoots := 0 ;

ELSIF d = 0.0 THEN

nRoots := 1 ;
xl := -b / (2.0 * a) ;
ELSE
nRoots := 2 ;
x1 := (-b + SQRT(d)) / (2.0 * a) ;
X2 := (b - SQRT(d)) / (2.0 * a) ;
END IF ;

CASE statement:

CASE tw OF
1, 5:
display := oven temp ;
2:
display := motor speed ;
3:
display := gross_tare;
4, 6..10:
display := status(tw - 4) ;
ELSE
display := 0;
tw error := 1;
END CASE ;

11.5.2.4 ITERATION STATEMENTS

Semantics

Iteration statements specify that the group of associated statements are executed repeat-
edly. The For statement is used if the number of iterations can be determined in advance;
otherwise, the WHILE or REPEAT constructs are used.

- FOR: the rOR statement indicates that a statement sequence is repeatedly executed,
up to the END FOR keyword, while a progression of values is assigned to the FoRr loop
control variable. The control variable, initial value, and final value are expressions of
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the same integer type (e.g., SINT, INT, or DINT) and cannot be altered by any of the
repeated statements. The FOR statement increments the control variable up or down
from an initial value to a final value in increments determined by the value of an ex-
pression; this value defaults to 1. The test for the termination condition is made at the
beginning of each iteration, so that the statement sequence is not executed if the initial
value exceeds the final value.

WHILE: the wHILE statement causes the sequence of statements up to the END WHILE
keyword to be executed repeatedly until the associated Boolean expression is false. If
the expression is initially false, then the group of statements is not executed at all.

REPEAT: the REPEAT statement causes the sequence of statements up to the UNTIL
keyword to be executed repeatedly (and at least once) until the associated Boolean
condition is true.

EXIT: the EXIT statement is used to terminate iterations before the termination condi-
tion is satisfied. When the Ex1T statement is located within nested iterative constructs,
exit is from the innermost loop in which the EXIT is located, that is, control passes to
the next statement after the first loop terminator (END FOR, END WHILE, or END RE-
pEAT) following the Ex1T statement.

Note: the wHILE and REPEAT statements cannot be used to achieve interprocess synchronization,
for example as a “wait loop” with an externally determined termination condition. The SFC
elements defined must be used for this purpose.

Syntax
Note that square brackets include optional code, while braces include repeatable portions
of code.
1) FOR:
FOR control var := init val TO end val [ BY increm val ]
stat list
END FOR ;
2) WHILE:
WHILE expression DO
stat list
END WHILE ;
3) REPEAT:
REPEAT

stat list
UNTIL expression

END REPEAT ;

Examples
FOR statement:

j = 101 ;
FOR i := 1 TO 100 BY 2 DO
IF arrvals([i] = 57 THEN
J o= 17
EXIT ;
END IF ;
END FOR ;

WHILE statement:

=1
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WHILE j <=100 AND arrvals[i] <> 57 DO
joi=3+ 2
END_WHILE ;

REPEAT statement:
J =1
REPEAT
joi=3+ 2
UNTIL j = 101 AND arrvals([i]

57
END REPEAT ;

11.6 SEQUENTIAL FUNCTION CHART (SFC)

This section defines Sequential Function Chart (SFC) elements to structure the internal
organization of a PLC program organization unit (POU), written in one of the languages
defined in this standard, for the purpose of performing sequential control functions. The
definitions in this section are derived from IEC 848, with the necessary changes to convert
the representations from a standard documentation to a set of execution control elements
for a PLC program organization unit.

Since SFC elements require storage of state information, the only program organization
units which can be structured using these elements are function blocks and programs.

If any part of a program organization unit is partitioned into SFC elements, the entire
program organization unit is so partitioned. If no SFC partitioning is given for a program
organization unit, the entire program organization unit is considered to be a single action
which executes under the control of the invoking entity.

SFC elements

The SFC elements provide a means of partitioning a PLC program organization unit into a
set of steps and transitions interconnected by directed links. Associated with each step is
a set of actions, and with each transition is associated a transition condition.

11.6.1 STEPS
11.6.1.1 DEFINITION

A step represents a situation where the behavior of a program organization unit (POU)
with respect to its inputs and outputs follows a set of rules defined by the associated ac-
tions of the step. A step is either active or inactive. At any given moment, the state of
the program organization unit is defined by the set of active steps and the values of its
internal and output variables.

A step is represented graphically by a block containing a step name in the form of an iden-
tifier. The directed link(s) into the step can be represented graphically by a vertical line
attached to the top of the step. The directed link(s) out of the step can be represented by
a vertical line attached to the bottom of the step.

Representation Description
1
StepMName Step
(graphical representation with
. direct links)

PLC IDE does not set any constraint on the maximum number of steps per SFC.
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Step flag

The step flag (active or inactive state of a step) can be represented by the logic value of a
Boolean variable *** x, where *** is the step name. This Boolean variable has the value
TRUE when the corresponding step is active, and FALSE when it is inactive. The scope of
step names and step flags is local to the program organization unit where the steps ap-
pear.

Representation Description
Step flag
Step Name x = TRUE When Step Name x is active
= FALSE otherwise

11.6.1.2 INITIAL STEP

The initial state of the program organization unit is represented by the initial values of
its internal and output variables, and by its set of initial steps, i.e., the steps which are
initially active. Each SFC network, or its textual equivalent, has exactly one initial step.
An initial step can be drawn graphically with double lines for the borders, as shown below.
For system initialization, the default initial state is FALSE for ordinary steps and TRUE for
initial steps.

PLC IDE cannot compile an SFC network not containing exactly one initial step.

Representation Description

‘ Init ‘

Initial step
(graphical representation with
direct links)

11.6.1.3 ACTIONS

An action can be:

- a collection of instructions in the IL language;

- a collection of networks in the FBD language;

- a collection of rungs in the LD language;

- a collection of statements in the ST language;

- a sequential function chart (SFC) organized as defined in this section.

Zero or more actions can be associated with each step. Actions are declared via one of the
textual structuring elements listed in the following table.

Structuring element Description

STEP StepName :
(* Step body *) Step (textual form)

END STEP
INITIAL STEP StepName :

(* Step body *) Initial step (textual form)
END STEP

Such a structuring element exists in the Tsc file for every step having at least one associ-
ated action.
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11.6.1.4 ACTION QUALIFIERS

The time when an action associated to a step is executed depends on its action qualifier.
PLC IDE implements the following action qualifiers.

Qualifier Description Meaning
N Non-stored (null qualifier). The action is executed as long as
the step remains active.
The action is executed only once per
p Pulse step activation, regardless of the

number of cycles the step remains
active.

If a step has zero associated actions, then it is considered as having a WAIT function, that
is, waiting for a successor transition condition to become true.

11.6.1.5 JUMPS

Direct links flow only downwards. Therefore, if you want to return to a upper step from a
lower one, you cannot draw a logical wire from the latter to the former. A special type of
block exists, called Jump, which lets you implement such a transition.

A Jump block is logically equivalent to a step, as they have to always be separated by a
transition. The only effect of a Jump is to activate the step flag of the preceding step and
to activate the flag of the step it points to.

Representation Description

Jump
(logical link to the destination step)

11.6.2 TRANSITIONS
11.6.2.1 DEFINITION

A transition represents the condition whereby control passes from one or more steps
preceding the transition to one or more successor steps along the corresponding directed
link. The transition is represented by a small grey square across the vertical directed link.

The direction of evolution following the directed links is from the bottom of the predeces-
sor step(s) to the top of the successor step(s).

11.6.2.2 TRANSITION CONDITION

Each transition has an associated transition condition which is the result of the evaluation
of a single Boolean expression. A transition condition which is always true is represented
by the keyword TRUE, whereas a transition condition always false is symbolized by the
keyword FALSE.

A transition condition can be associated with a transition by one of the following means:

Representation Description
TRUE By placing the appropriate Boolean constant {TRUE,
FALSE} adjacent to the vertical directed link.
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11.6.
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Representation Description
varllame By decl_aring a Boolean variable, whqs_e va_llue
determines whether or not the transition is cleared.

supported by PLC IDE, except for SFC. The result
of the evaluation of such a code determines the

By writing a piece of code, in any of the languages
I:lij Proghame
transition condition.

The scope of a transition name is local to the program organization unit (POU) where the
transition is located.

3 RULES OF EVOLUTION

Introduction

The initial situation of a SFC network is characterized by the initial step which is in the
active state upon initialization of the program or function block containing the network.

Evolutions of the active states of steps take place along the directed links when caused by
the clearing of one or more transitions.

A transition is enabled when all the preceding steps, connected to the corresponding tran-
sition symbol by directed links, are active. The clearing of a transition occurs when the
transition is enabled and when the associated transition condition is true.

The clearing of a transition causes the deactivation (or “resetting”) of all the immediately
preceding steps connected to the corresponding transition symbol by directed links, fol-
lowed by the activation of all the immediately following steps.

The alternation Step/Transition and Transition/Step is always maintained in SFC element
connections, that is:

- two steps are never directly linked; they are always separated by a transition;
- two transitions are never directly linked; they are always separated by a step.

When the clearing of a transition leads to the activation of several steps at the same time,
the sequences which these steps belong to are called simultaneous sequences. After their
simultaneous activation, the evolution of each of these sequences becomes independent.
In order to emphasize the special nature of such constructs, the divergence and conver-
gence of simultaneous sequences is indicated by a double horizontal line.

The clearing time of a transition may theoretically be considered as short as one may
wish, but it can never be zero. In practice, the clearing time will be imposed by the PLC
implementation: several transitions which can be cleared simultaneously will be cleared
simultaneously, within the timing constraints of the particular PLC implementation and
the priority constraints defined in the sequence evolution table. For the same reason, the
duration of a step activity can never be considered to be zero. Testing of the successor
transition condition(s) of an active step shall not be performed until the effects of the step
activation have propagated throughout the program organization unit where the step is
declared.

Sequence evolution table

This table defines the syntax and semantics of the allowed combinations of steps and
transitions.
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Example Rule

Normal transition

An evolution from step s3 to step s4
takes place if and only if step s3 is
in the active state and the transition
condition c is TRUE.

Divergent transition

An evolution takes place from s5 to
s6 if and only if s5 is active and the
transition condition e is TRUE, or from
S5 to s8 only if 5 is active and £ is
TRUE and e is FALSE.

57 59
Convergent transition
An evolution takes place from s7

ég h é’:‘j to s10 only if s7 is active and the
transition condition h is TRUE, or from

510 s9 to s10 only if s9 is active and 7 is
TRUE.

-

511 Simultaneous divergent transition

An evolution takes place from s11 to

S12, s14,... only if s11 is active and
[E b the transition condition b associated
i ' to the common transition is TRUE.
512 514 After the simultaneous activation of
s12, s14, etc., the evolution of each

; * sequence proceeds independently.

513 515 . ip
Simultaneous convergent transition

An evolution takes place from s13,
! | S15,... to s16 only if all steps above
EE ’ and connected to the double horizontal
line are active and the transition
condition d associated to the common
transition is TRUE.

Examples
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Invalid scheme Equivalent allowed scheme Note

S30

a - d Expected behavior: an
evolution takes place
from s30 to s33 if a is
éﬁ FALSE and d is TRUE.

b

‘ s34 ‘

3

The scheme in the

s leftmost column

is invalid because
conditions d and TRUE
are directly linked.

TRUE . [ TRUE

Expected behavior: an
evolution takes place
from s32 to s31 ifcis
FALSE and d is TRUE.

The scheme in the
A %.} leftmost column

is invalid because
- direct links flow only
downwards. Upward
transitions can be
performed via jump
blocks.

533

|

i
]

11.6.4 SFC CONTROL FLAGS

PLC IDE provides some control flags for SFC program or function blocks.

To enable this feature, please refer to paragraph 4.6.2.

Those flags are:

- <POU name> HOLD SFC (type BOOL);

- <POU name> RESET SFC (type BOOL) .

Where <POU name> means the name of the SFC POU (program or function block).

For example, if the SFC POU is named Main, the control flags will be named Main HOLD
SFC and Main RESET SFC.

Another couple of actions is available for every SFC action, which also are contained in a
SFC POU.

For example, if the above program Main contains a SFC action named Execute, the con-
trol flags of this action will be Main Execute HOLD SFC and Main Execute RESET SFC.

These flags functionalities are described in details on next paragraphs.

11.6.4.1 HOLD FLAG

(©.C)
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Following the main characteristics of the <POU name> HOLD SrcC flag:
- default value is FALSE;
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- when set to TRUE, the SFC block, which is referred to ( the one with the same name as
<POU name>), it is kept in the current status (hold) and no code is executed;

- when the flag is set back to FaLSE, the SFC block execution is recovered from exactly
the same point in which was set to hold, trough <POU name> HOLD SFC := TRUE.

11.6.4.2 RESET FLAG

Following the main characteristics of the <POU name> RESET src flag:
- default value is FALSE;

- when set to TRUE, the SFC block, which is referred to (the one with the same name as
<POU name>), it is brought back to the initial state, that is the execution state of the init
action.

- this is an auto-reset flag, which means that if it is set to TRUE his own state becomes
FALSE after his reset action has been executed. It is therefore not necessary to bring
the <POU name> RESET SFC value back to FALSE.

11.6.4.3 FLAGS VISIBILITY

The <POU name> HOLD SFC and <POU name> RESET SFC flags are automatically gener-
ated from the code compiler and they belongs to the local variables of the POU which are
referred to.

PLC IDE does not show this flags in the variables list of the POU; they are hidden but in
any case they can be used everywhere within the code.

11.6.5 CHECK A SFC POU FROM OTHER PROGRAMS

To allow the managing of a SFC POU from other programs PLC IDE provides the following
functionalities:

- The compiler automatically generates the <POU name> RESET SFC and <POU name>
HOLD_sFc flags.

- If the SFC POU is a function block, the user has the possibility to declare, as VAR INPUT
and type BoOL, both flags having the name of the SFC POU control flags.

- If the SFC POU is a program, the user has the possibility to declare, as vAR GLOBAL and
type BOOL, both flags having the name of the SFC POU control flags.

- In both cases above, PLC IDE compiler will use the variables declared among the VAR
INPUT Oor VAR GLOBAL ones and not those automatically generated (therefore they will
be not generated).

Using these techniques, user then can manage the working state of the SFC POU from
other POU using the INPUT variables of the SFC POU.

Example
FUNCTION BLOCK test
VAR INPUT

test RESET SFC : BOOL; (* Control flag explicitly declared *)
END VAR

END FUNCTION BLOCK
PROGRAM Main
VAR

(O 0]
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block : test; (* SFC block instance *)
END VAR

(* Reset SFC block state *)
block.test RESET SFC := TRUE;

END PROGRAM

11.6.5.1 SFC MACRO LIBRARY

PLC IDE makes available to user a library, called SFCControl.pl], to allow the manage of
the SFC states trough commands instead of variable settings.

This library is composed by macros usable only in ST language.

11.6.5.2 USAGE EXAMPLE OF THE CONTROL FLAGS

Following are some example of control flags usage, assuming the SFC POU is named Main:
Hold (freeze):
Main HOLD SFC := TRUE;

Restart from hold state:

Main HOLD SFC := FALSE;
- Restart form initial state of a SFC block in hold state:
Main RESET SFC := TRUE;
Main HOLD SFC := FALSE;
- Reset to initial state and instant restart of SFC block:
Main RESET SFC := TRUE; (* automatic reset from compiler *).

11.7 PLC IDE LANGUAGE EXTENSIONS

PLC IDE features a few extensions to the IEC 61131-3 standard, in order to further enrich
the language and to adapt to different coding styles.

11.7.1 MACROS

PLC IDE implements macros in the same way a C programming language pre-processor
does.

Macros can be defined using the following syntax:
MACRO <macro name>
PAR MACRO
<parameter list>
END PAR
<macro body>
END MACRO

Note that the parameter list may eventually be empty, thus distinguishing between ob-
ject-like macros, which do not take parameters, and function-like macros, which do take
parameters.

A concrete example of macro definition is the following, which takes two bytes and com-
poses a 16-bit word:

(©.C)
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MACRO MAKEWORD

PAR_MACRO

lobyte;

hibyte;

END PAR

{ CODE:ST }

lobyte + SHL( TO UINT( hibyte ), 8 )
END MACRO

Whenever the macro name appears in the source code, it is replaced (along with the ac-
tual parameter list, in case of function-like macros) with the macro body. For example,
given the definition of the macro MAKEWORD and the following Structured Text code frag-

ment:
w := MAKEWORD( bl, b2 );
the macro pre-processor expands it to
w := bl + SHL( TO UINT( b2 ), 8 );

11.7.2 POINTERS

Pointers are a special kind of variables which act as a reference to another variable (the
pointed variable). The value of a pointer is, in fact, the address of the pointed variable; in
order to access the data stored at the address pointed to, pointers can be dereferenced.

Pointer declaration requires the same syntax used in variable declaration, where the type
name is the type name of the pointed variable preceded by a @ sign:

VAR
<pointer name> : (@<pointed variable type name>;
END VAR
For example, the declaration of a pointer to a REAL variable shall be as follows:

VAR
px : QREAL;
END VAR

A pointer can be assigned with another pointer or with an address. A special operator, ADR,
is available to retrieve the address of a variable.

px = py; (* px and py are pointers to REAL (that is, vari-
ables of type @REAL) *)
px := ADR( x ) (* x is a variable of type REAL ¥*)
px := ?Xx (* ? 1s an alternative notation for ADR *)
The @ operator is used to dereference a pointer, hence to access the pointed variable.
px := ADR( x );
@px := 3.141592; (* the approximate value of pi is assigned to x *)
pn := ADR( n );
n := @pn + 1; (* n is incremented by 1 *)

Beware that careless use of pointers is potentially dangerous: indeed, pointers can point
to any arbitrary location, which can cause undesirable effects.

Using of PVOID type

Beware that the pointer type and the pointed variable type must be of the same type; else
an error message is raised when compiling. To avoid type mismatching you can use PVOID

type as pointer type, this way the pointed type will be always accepted.
.
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11.7.3 WAITING STATEMENT

PLC IDE implements a WAITING statement that can be used in ST code as following ex-
ample:

WAITING <condition> DO
<code to be executed waiting for condition becomes true>

END WAITING;

Until the condition is not verified, the code will be executed (not as in a loop cycle but
returning to caller in every execution).

The WAITING statement can be used only if the associated project option is enabled (see
paragraph 4.6.2 for more details).

(©.C)
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12.1 COMPILE TIME ERROR MESSAGES

ECR:SER SHORT DESCRIPTION EXPLANATION
A4097 Object not found The object indicated (variable or function block) has not

been defined in the application.

The size (in bits) requested by the indicated data type

A4098 Unsupported data type isn't supported by the target system.
A4099 Auto vars space exhausted The total allocation space requested by all local variables
exceeds the space available on the target system.
The total allocation space requested by all local retentive
A4100 Retentive vars space exhausted variables exceeds the space available on the target
system.
The total allocation space requested by all local bit
A4101 Bit vars space exhausted (boolean) variables exceeds the space available on the
target system.
A4102 Invalid index in data block The var_|able |_nd|cated |s.assouated with an index that is
not available in the relative data block.
The variable indicated is associated with a data block
A4103 Data block not found that doesn't exist (isn't defined) in the target system.
The total size of code used for POU (programs, functions
A4104 Code space exhausted and function blocks) exceed the space available on the
target system.
A4105 Invalid bit offset The var|al?le |nd.|cated is a;soaated with a bit index that
is not available in the relative data block.
A4106 Image variable requested Error code superseded.
A4107 Target function not found The function indicated isn't available on the target
system.
A4108 Base object not found The_ mf:llcated mst_ance refers to a function block
definition non defined.
. . The indicated variable is associated with a data type
A4109 Invalid base object type (including function block definition) that isn't defined.
A4110 Invalid data type l’)l‘(liztdata type used in the variable definition doesn't
A4111 Invalid operand type The operand type is not allowed for the current operator.
The indicated function block is called by more than one
A4112 Function block shares global data | task but uses global variables with process image. For
and is used by more tasks this reason the compiler isn't able to refer to the proper
image variable for each instance of the function block.
A4113 Temporary variables allocation Internal compiler error.
error
Embedded functions do not
A4114 - .
support arrays as input variables
Too many parameters input to
A4115 embedded function
Incremental build failed, perform
A4116 | 5 full build command
A4117 Less then 10% of free data
A4118 Less then 10% of free retain data
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E(I;{(;{SER SHORT DESCRIPTION EXPLANATION
A4119 Less then 10% of free bit data
A4120 Variable exceeds data block space
A4121 Element not found
A4122 Invalid bit mapped type Bit mapped variables must be of type BOOL
A4123 Invalid access to private member
Ad124 El:;lggti:lngatablock type for bit
A4126 Invalid label specification
A4127 Not a function Invalid function specification
A4128 Invalid bit mapping index
A4129 Not a structured type
A4130 Not a function block instance
A4131 Incompatible external declaration
A4132 Label not found
A4133 Not a variable
A4134 Index exceeds array size Index value is out of the array range
A4135 Invalid index data type
A4136 Missing index(es)
A4137 Function block instance required
A4138 Simple variable required
A4139 Too many indexes
A4140 Not a structure instance
A4141 Not an array
A4142 Invalid symbol specification
A4143 Not a pointer
Ad144 aDI(ID;\AI::leed pointer indirection not
A4145 To be implemented
A4146 Bit datatype not allowed
A4147 Unable to calculate variable offset
A4148 gl?onggézﬁn\:zgzbles cannot have
Cannot use directly represented
A4149 variables with process image in
function blocks (not implemented)
A4150 ;ﬁg\f\;c;%n block instance not
A4151 Structure not allowed
aisz | 16D varables must be algned
A4153 | b boundary
Temporary string variable
A4154 allocation error. Instruction shall

be split.
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ECR:SER SHORT DESCRIPTION EXPLANATION
A4155 Ext/aux auto vars space
exhausted
Ambiguous enum value,
A4156 <enum># prefix required
A4157 Invalid init element
A4158 Invalid target function table entry
A4159 Invalid bit access syntax
L . Bit access allowed only on bit string data types (BYTE,
A4160 Invalid bit string type WORD, DWORD)
A4161 Invalid bit index
A4162 Object is not a method
A4163 Method not found
A4164 Invalid usage of THIS/SUPER
A4165 Parent function block not found
A4166 Variable name already used into a
parent
A4167 Erroneus method override Return value or input variables mismatch
A4168 Erroneus local method override _Overr|de of a _parent method belonging to a locally
implemented interface
A4169 Not an interface instance
A4170 Not a reference
A4171 Error dereferencing interfaces Int.erfaces can not be dereferenced from references/
pointers
A4172 Relocation table generation failure
A4173 Bit mapped variables can’t be
arrays
A4174 64-bit variables must be aligned On some architecture is required that 64-bit variables
to a 64-bit boundary are mapped on memory address alinged to 64-bit
A4175 Enum base type must be DINT
C0001 Parser not initialized Internal compiler error.
C0002 Invalid token Invalid word for the current language syntax
C0003 Invalid file specification Internal compiler error.
C0004 Can't open file The indicated ﬁ_Ie can t be opt_aned due to a file system
error or to a missing source file.
C0005 Parser table error Internal compiler error.
C0006 Parser non specified Internal compiler error.
) The indicated file is truncated or the syntax is
C0007 Unexpected end of file incomplete.
The indicated word can't be used for declaration
C0009 Reserved keyword purposes because is a keyword of the language.
C0010 Invalid element The indicated word isn't a valid one for the language
syntax.
Co011 Aborted by user
C0032 Too many parameters in macro

call
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Eg(;{SER SHORT DESCRIPTION EXPLANATION
C0033 Invalid number of parameters in
macro call
C0034 Too many macro calls nested
C0035 IFDEF directives are not enabled
C0036 Syntax error in IFDEF condition
C0037 Recursive IFDEF condition
C4097 Invalid variable type The data type indicated isn't allowed.
C4098 Invalid location prefix :I;;ule a(_jdr.ess string of the indicated variable isn't correct,
o' missing.
. . e The address string of the indicated variable isn't correct,
C4099 Invalid location specification the data access type indication isn't 'I', 'Q' or 'M'.
. . The address string of the indicated variable isn't correct,
€4100 Invalid location type the data type indication isn't 'X', 'B', 'W', 'D', 'R' or 'L".
c4101 Invalid location index specification The_addre;s Istrmg of the indicated variable isn't correct,
the index isn't correct.
C4102 Duplicate variable name The name of the |nd|catgd varla)ble has already been
used for some other project object.
C4103 Only 0 admitted here The compiler uses only arrays zero-index based
The dimension of the array isn't indicated in the correct
C4104 Invalid array dimension way (e.g.: contains invalid characters, negative numbers
etc.).
C4105 Constant not initialized Every constant need to have an initial value.
C4106 Invalid string size
C4107 Initialization exceeding string size
C4108 Invalid repetition in initialization
C4109 Invalid data type for initialization
C4110 Invalid binary file for initialization
C4112 Duplicate type name
. The indicated label has already been defined in the
€4353 Duplicate |abel current POU (program, function or function block).
C4354 Constant not admitted The .operatlon |nd|catgd doesn t.aIIow to use constants
(typically store or assign operations).
Address of explicit constant not
€4355 defined
Maximum number of subscripts
C4356 exceeded
C4358 Invalid array base
C4359 Invalid operand
C4609 Invalid binary constant A_ c_onstant value with 2# prefix must contain only binary
digits (0 or 1).
C4610 Invalid octal constant A_ c_onstant value with 8# prefix must contain only octal
digits (between 0 and 7).
A constant value with 16# prefix must contain only
C4611 Invalid hexadecimal constant hexadecimal digits (between 0 and 9 and between A and
F).
A decimal constant must contain only digits between 0
C4612 Invalid decimal constant and 9, a leading sign + or -, a decimal separator '.' Or a

exponent indicator 'e' or 'E'.
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ECR:SER SHORT DESCRIPTION EXPLANATION
A constant value with t# prefix must contain a time
C4613 Invalid time constant indication in decimal notation and a time unit between

‘ms, 's' or 'm'.

C4614 Invalid constant string
C4618 Invalid constant wstring
C4619 Tlme; constant exceedes
maximum value
C4620 LTim_e constant exceedes
maximum value
C4621 A non—mqst significant time unit
exceede its range
C4622 A non—lea;t significant time unit
has a decimal part
C4623 Invalid date constant
Invalid Date and Time typed
Ca624 constant
C4626 Invalid Time of Day typed
constant
C4864 Duplicate function name The |nd|cateq furlct|on name has already been used for
another application object.
C4865 Invalid function type The data type returned by the indicated function is not
correct.
C5120 Duplicate program name The |nd|cateq program name has already been used for
another application object.
C5376 Duplicate function block name The indicated functloq blqck name has already been
used for another application object.
C5632 Invalid pragma
C5633 Invalid pragma value
C5889 Duplicate macro name
C5890 Duplicate macro parameter name
Invalid resource definition: two or
cé144 more tasks have the same ID
C16385 | Invalid init value
C16386 | Empty init value
C16387 [ Invalid structure init value Invalid element name in structure init value
C16388 [ Unexpected token
C16389 | Syntax error
C16390 |Invalid function declaration Function declaration must begin at line one
C16391 | Invalid variable init value Initial value must begin on the same line as the variable
name
C16392 | Invalid description Description exceeded 1024 characters
C16393 [ Invalid POU name declaration Declared POU name does not match actual POU name
C16394 | Missing POU header Missing POU header (e.g.: PROGRAM main)
The indicated FBD or LD network contains a connection
F1025 Invalid network error (the errors are normally indicated by red

connections).
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Eg(;{SER SHORT DESCRIPTION EXPLANATION
F1026 Unconnected pin The indicated block (o.perator, function, contact or coil)
has an unconnected pin.
F1027 Invalid connection (incomplete, Internal compiler error.
more than a source etc.)
F1028 More than one network per block The netyvork indicated contains more networks of blocks
and variables not connected between them.
. . The compiler is not able to find an univocal way to
F1029 Ambiguous network evaluation establish the order of blocks execution.
F1030 Temporary variables allocation Internal compiler error.
error
F1031 Inconsistent network The_ network indicated doesn't have input or output
variables.
F1032 In_valid object connected to power
rail
Invalid use of pin negation (ADR
F1033 operator does not allow negated
input)
Invalid use of pin negation
F1034 (SIZEOF operator does not allow
negated input)
F1035 Undefined function block
F1036 Missing VAR_IN_OUT assignment
F1037 Unknown function
F1038 Unav_a|lable default value for
function parameter
F1039 Invalid pin
Only variables with physical
F1040 storage can be assigned to VAR_
IN_OUT
G0001 Invalid operand number The numl_:)er _of c_)perands is not correct for the operand or
the function indicated.
G0002 Variable not defined The variable has not been defined in the local or global
context.
) The label indicated for the JMP operand isn't defined in
G0003 Label not defined the current POU (program, function or function block).
G0004 Function block not defined The_ |nd|;ated instance rgfers to a function block not
defined in the whole project.
G0005 Reference to object not defined The indicated _mstance refers to an object not defined in
the whole project.
G0006 Constant not admitted The _operatlon |nd|cate_:d doesn t_aIIow to use constants
(typically store or assign operations).
The total size of code used for POU (programs, functions
G0007 Code buffer overflow and function blocks) exceed the space available on the
target system.
The access made to the indicated variable is not allowed.
G0008 Invalid access to variable An attempt to write a read-only variable or to read a
write-only variable has been made.
G0009 Program not found The indicated program doesn't exist in the current

project.
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ECR:SER SHORT DESCRIPTION EXPLANATION
G0010 Program already assigned to a The indicated program has been assigned to more than

task

one task of the target system.

There isn't enough memory on the PC to create the

G0011 Can't allocate code buffer image of the code of the target system.
G0012 Function not defined The_ indicated function doesn't exist in the current
project.
Cyclic declaration of function The indicated function block call itself directly or by
G0013 .
blocks means of other functions.
The external variable declaration of the current function
. . block or function, doesn't match with the global variable
G0014 Incompatible external declaration definition it refers to (the one with the same name).
Typically is the case of a type mismatch.
G0015 Accumulator extension
The external variable doesn't refer to any of the global
G0016 External variable not found variables of the project (e.g.: there isn't a global variable
with the same name).
G0017 Program is not assigned to a task The indicated program hasn't been assigned to a task in
the target system.
G0018 Task not found in resources The indicated task isn't defined in the target system.
There aren't task definitions for the target system. The
G0019 No task defined for the application | target definition file (*.TAR) is missing or incomplete.
Contact the target system vendor.
Far data allowed only for load;/ Huge memory access isn't allowed for function blocks,
G0020 store operations in PyROGRAMs only for programs (error code valid only for some target
P system with NEAR/FAR data access).
. The processor indicated into the target definition file
G0021 Invalid processor type (*.TAR) isn't correct or isn't supported by the compiler.
Function block with process image
G0022 variables can't be used in event
tasks
Process image variables can't be
G0023 used in event tasks
G0024 Accumulator undefined
G0025 Invalid index
G0026 Only constant index allowed
G0027 IIIega_I reference to the address of
a register
G0028 Less then 10% of free code
G0029 Index exceeds array size
Access to array as scalar -
G0030 assuming index 0
Number of indexes not matching
G0031 the var size
Multidimensional variables not
G0032 supported
G0033 Invalid data type
G0034 Invalid operand type
G0035 Assembler error
G0036 Aborted by user
G0037 Element not defined
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E(I;‘(;{SER SHORT DESCRIPTION EXPLANATION
G0038 Cyclic declaration of structures
G0039 Cyclic declaration of typedefs
G0040 Unresolved definition of typedef
G0041 Exceeding dimensions in typedef
G0042 _Unable to allocate compiler
internal data
CODE GENERATOR INTERNAL
G0043 ERROR
G0044 Real data not supported
G0045 Long real data not supported
G0046 Long data not supported
G0047 Operation not implemented
G0048 Invalid operator
G0049 Invalid operator value
G0050 Unbalanced parentheses
G0051 Data conversion
G0052 To be implemented
G0053 Invalid index data type
G0054 Negation without condition
G0055 Operation not allowed on boolean
GO056 Negation of a non-boolean
operand
G0057 Boolean operand required
G0058 Floating point parameter not
allowed
G0059 Operand extension
G0060 Division by zero
G0061 Comparison between different
types
G0062 !:unctiqn block must be
instantiated
G0063 String operand not allowed
G0064 Operation not allowed on pointers
G0065 Destination may be too small to
store current result
Cannot use a function block
G0066 contalnlr)g exte_rnal variables with
process image in more than one
task
G0067 Canqut load the address of an
explicit constant
G0068 ertlng a rgal value into an
integer variable
Cannot use complex variables in
G0069 functions. Not implemented
G0070 Signed/unsigned mismatch
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ECR(;{SER SHORT DESCRIPTION EXPLANATION
G0071 Conversion data types mismatch,

possible loss of data

Implicit type conversion of

60072 boolean to integer

G0073 Implicit type conversion of
boolean to real

G0074 Implicit type conversion of integer
to boolean

G0075 Implicit type conversion of integer
to real

G0076 Implicit type conversion of real to
boolean

G0077 _Implicit type conversion of real to
integer

G0078 Arithm_etic operations require
numerical operands

G0079 B_itwis_e Io_gical operations require
bitstring/integer operands
Comparison operations require

G0080 elementary (i.e., not user-
defined) operands

G0081 Car)not take the address of a bit
variable

G0082 Writ_ing a sigr_1ed value into an
unsigned variable

G0083 Writing an_unsigned value into a
signed variable

G0084 Implicit conye_rsion from single to
double precision

G0085 Il_'nplicit cor_w_ersion from double to
single precision

G0086 Function parameter extension
Casting to the same type has no

G0087 effects
Function parameters wrong

G0088 number
Embedded target function not

G0083 found

G0090 Recursive type declaration

G0091 Wro_ng |n|t|a_l value. Signed/
unsigned mismatch
Wrong initial value. Conversion

G0092 data types mismatch, possible
loss of data

G0093 String will be truncated

G009%4 Init value type mismatch

G0095 Improper init value

G0096 Init value object not found

G0097 Invalid assignment to pointer

G0098 Unsupported data type
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Eg(;{SER SHORT DESCRIPTION EXPLANATION

G0099 Variable bit access not supported

G0100 Symbolic initialization of constants
not supported

G0101 Type mismatch in assignment

G0102 Arrz_ay size mismatch in
assignment

G0103 Copy of array or structures not
supported

G0104 Data size mismatch in assignment

G0105 Copy of data having a large size
(see threshold in project options)
Object oriented features not

G0106 supported

G0107 Recursive usage of function

G0108 Recursive usage of method

G0109 Recursive usage of function block
Parent function block not found

GO110 | (ith EXTENDS)
Recursive inheritance (with

G0111 EXTENDS)
Object oriented programming not

G0112
supported by target system
Undefined interface (with

G0113 IMPLEMENTS)
Incomplete interface

G0114 implementation (with
IMPLEMENTS)

G0115 !Vlethod protc_)type differs from
interface definition

G0116 _Redundant ir_lterface
implementation

G0117 Function bIo_ck does not
implements interface

G0118 Copy between different interfaces

GO0119 Parent interface not found
Recursive interface hierarchy

G0120 | ExTENDS)

G0121 Method redefinition in interface
hierarchy (EXTENDS)

G0122 _Invalid operands for query
interface operator ?=

G0123 Invalid assignment to reference

G0124 Car) not load reference/address of
an interface

G0125 Invalid operation on reference

G0126 Improper as_signment to a
reference, different type

G0127 Usage of deprecated pointer

initialization, use NULL instead
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ECR(;{SER SHORT DESCRIPTION EXPLANATION
G0128 Comparison between pointer and

non-pointer

Comparison between reference

G0129
and non-reference

G0130 Operatl_on between pointer and
non-pointer

G0131 Check for division by zero
unsupported for LREAL type

G0132 Mismatch in ENUM data types

G0133 Opera_tion between ENUM and
generic constant

G0134 Operation requires explicit type
cast

G0135 Operation required an implicit
type cast

G0136 Type cast is not allowed
Initialization of constants with

G0137 addresses is not allowed

G0138 Illegal conversion to pointer

G0139 Array dimension constant not
found

G0140 Invalid constant for array size

G0141 Invalid_ pointer arithmetic
operation

G0142 VAR_IN_OUT can’t be a reference
VAR_IN_OUT can be assigned to

G0143 other VAR_IN_OUT only
Only variables can be assigned to

GO144 1 yAR_IN_OUT

G0145 Invalid MOVE operation
Found invalid instruction in patch

G0146 code, could not set breakpoint/
trigger

G0147 yariable bit access with variable
index not supported

G0148 Invalid array size indication

G0149 Invalid operand on function call

G0150 Argur_nent types mismatch on
function call

GO151 Oper;_:md_types rplsmatch on
function invocation

G0152 Time parameter not allowed

G0153 Converting a time into a number

G0154 Converting a time into a string

G0155 Converting a time into a bool

G0156 Converting a number into a time

G0157 Converting a string into a time

G0158 Implicit conversion of Time to

LTime
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G0159 C_annc?t co_nyert an LTime into a
Time implicitly
G0160 Invalid operation with a time
typed operand
Go161 Operation not allowed on Time
operand
G0162 D_estlnat|on type not supported for
Time type
G0163 De_stlnatlon type not supported for
LTime type
Implicit conversion of DATE to
G0164 LDATE
Destination type not supported for
G0165 DATE type
Destination type not supported for
G0166 LDATE type
Cannot convert an LDATE into a
G0167 DATE implicitly
G0168 Converting a date into a humber
G0169 Converting a date into a string
G0170 Converting a date into a bool
G0171 Converting a number into a date
type
G0172 Operation not allowed on date
operand
Operation between a date type
G0173 operand and a non date type
operand is not allowed
Operation between different date
G0174 type operands (Date and LDate) is
not allowed
Operation not allowed on TIME or
GO175 | (TimE
Operation not allowed on DATE or
GO176 | pATE
Cannot convert a DATE_AND_
GO177 | TIME into a DATE implicitly
G0178 Cannot convert a DATE_AND_
TIME into an LDATE implicitly
G0179 Cannot convert an LDATE_AND_
TIME into a DATE implicitly
G0180 Cannot convert an LDATE_AND_
TIME into an LDATE implicitly
G0181 Implicit conversion of DATE_AND_
TIME to LDATE_AND_TIME
Cannot convert an LDATE_AND_
G0182 TIME into a DATE_AND_TIME
implicitly
Operation between a date and
G0183 time type operand and a non date

and time type is not allowed
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Operation between different date

G0184 and time type operands (DT and
LDT) is not allowed

GO185 C_)perann not allowed on date and
time type operand

G0186 Operation not allowed on DATE_
AND_TIME or LDATE_AND_TIME

G0187 _Convertm_g a date and time type
into a string
Converting a DATE into a DATE_

G0188 AND_TIME
Converting a LDATE into a DATE_

G0189 AND_TIME
Converting a DATE into a LDATE_

G010 AND_TIME
Converting a LDATE into a LDATE_

G0191 AND_TIME

G0192 Destination type not supported for
DATE_AND_TIME type

G0193 Destination type not supported for
LDATE_AND_TIME type

G0194 Date typed parameter not allowed

G0195 Date and time typed parameter
not allowed

G0196 C;onverting a floating point into a
time

G0197 Converting a bool into a time type
Converting a bool into a date and

G0198 time type

G0199 Cpnvertmg a bool into a date and
time type

G0200 Convgrtlng a string into a date
and time type

G0201 Convgrtlng a number into a date
and time type

G0202 Converting a date type into a time
type

G0203 _Conver’Flng a date and time type
into a time type

G0204 Converting a floating point into a
date type

G0205 Converting a string into a date
type

G0206 Converting a bool into a date type

G0207 Converting a time type into a date
type

G0208 Convgrtlng a time type into a date
and time type

G0209 Converting a date type into a

floating point
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G0210 _Converting_a datg and time type
into a floating point
G0211 _Converting a date and time type
into a number
G0212 _Converting a date and time type
into a bool
G0213 Converting a String into WString
G0214 Converting a WString into String
G0215 Converting a string into a bool
G0216 Operation not allowed on TIME_
OF_DAY or LTIME_OF_DAY
Cannot convert an DATE_AND_
G0217 TIME into a TIME_OF_DAY
implicitly
Cannot convert an DATE_AND_
G0218 TIME into an LTIME_OF_DAY
implicitly
Cannot convert an LDATE_AND_
G0219 TIME into an TIME_OF_DAY
implicitly
Cannot convert an LDATE_AND_
G0220 TIME into an LTIME_OF_DAY
implicitly
Implicit conversion of TIME_OF_
G0221 DAY to LTIME_OF_DAY
Destination type not supported for
G0222 TIME_OF_DAY type
Destination type not supported for
G0223 LTIME_OF_DAY type
G0224 Cannot convert an LTIME_OF_DAY
into a TIME_OF_DAY implicitly
Operation between a time of day
G0225 operand and a non time of day
operand is not allowed
Operation between different time
G0226 of day type operands (TOD and
LTOD) is not allowed
G0227 Operation not allowed on time of
day type operand
G0228 Time of day typed parameter not
allowed
G0229 Converting a time of day type into
a bool
G0230 Convel_*tmg a time of day type into
a floating point
G0231 Converting a time of day type into
a number
G0232 Conv_erting a time of day type into
a string
G0233 Converting a time of day type into

a time type
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G0234 Converting a time of day type into
a date type

G0235 Converting a time of day type into
a date and time type

G0236 Converting a bool into a time of
day type

G0237 Converting a number into a time
of day type

G0238 C_onverting a floating point into a
time of day type

G0239 Converting a string into a time of
day type

G0240 Converting a time type into a time
of day type

G0241 Converting a date type into a time
of day type

G0242 Zero length string not allowed

Operation not allowed on

G0243
references

G0244 Different array/string size

G0245 Complex parameter not supported

Does not support bool

G0246
accumulator

G0247 Does not support float
accumulator

G0248 Time typed accumulator not
supported

G0249 Date typed accumulator not
supported

G0250 Date and time typed accumulator
not supported

G0251 Time of day typed accumulator
not supported

G0252 String typed accumulator not

supported

G0253 Converting a number into a String

G0254 Converting a String into a number

Operation between floating point

G0255 and integer

Operation between signed and

G0256 unsigned variables

G0257 Converting %s to REAL

G0258 Converting %s to LREAL

Converting a number into a

60259 WString
G0260 Converting a WString into a
number

G0261 Converting a WString into a bool

Does not support a non boolean

G0262 condition
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Operation between a string type
G0263 and a non string type is not
allowed
Operation between different time
G0264 typed operands (TIME and LTIME)
is not allowed
G0265 Branch higher of 1 MB
G0266 Branch higher of 16 MB
G0267 Branch higher of 32 MB
Converting %s to the type of the
G0268 second operand
Converting %s to the type of the
G0269 first operand
Operation between boolean and
60270 integer
Invalid operation on different
G0271 pointed types
G0272 Operation on different pointed
types
G0273 Implicit conversion of type \'%s\’
to type \'%s\’ is not admitted
Invalid conversion of type \'%s\’
G0274 to type \'%s\’
G0275 Loss qf precision while converting
a %s into %s
Invalid operation on operands
G0276 with different granularity
G0277 Invalid pointer operation
G0278 Invalid string length indication
G0279 String length constant not found
G0280 Invalid constant for string length
G0281 Operation.between array and
scalar variables
Extended Unicode characters are
G0282 not enabled
Invalid number of inout
G0283 parameters
G0284 A variable can’t be assigned to a
VAR_IN_OUT with a different type
G0285 All inputs shall be of the same
type
VAR_IN_OUT on functions not
G0286 implemented
G8193 Type definition of unknown data
type
G8194 Type deﬁnitio_n has exceeding
array dimensions
G8195 Cyclic definition of data type
G8196 Double pointers are not supported
G8197 No enumerative elements
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G8199 Invalid or undefined initialization

constant

Global variable and ENUM field

G8200 with the same name

G10241 | Too many initializers for variable

G10242 | Too less initializers for variable

G10243 | Constant without init values

L1153 Unconnected pin

L1154 Jump to non existing label

L1155 Invalid operand

L1156 Undefined contact

L1157 Undefined variable

L1158 Undefined constant

L1159 Undefined coil

L1160 Undefined jump destination

L1161 Undefined expression

Assighment not admitted in

L1162 .
expressions

Comments not admitted in

L1163 .
expressions

L1164 Undefined function block

VAR_IN_OUT must be assigned in

L1165 function block invocation

L1166 Unknown function

Unavailable default value for

L1167 ;
function parameter

L1168 VAR_IN_OUT parameters must be
assigned

L1169 Only variables can be assigned to

VAR_IN_OUT parameters

P2048 PostBuild error

P2049 Symbol table file not created

P2051 Can’t create directory

P2052 Can’t open source project

P2053 Save project error

P2054 Generic file error

P2055 Can't copy file

P2056 Can’t save file

P2057 Object already exist in project

P2058 Can’t open library file

P2059 Listing file not created

Cannot create PLC application

P2060 binary file

P2061 Can’t open template project

(O 0]
PLC

Arduino PLC IDE user manual 259



ARDUINO PLC IDE

FRROr| SHORT DESCRIPTION EXPLANATION
P2062 Support for processor isn't

available

P2063 Less than 10% of free code

P2064 Less than 10% of free data

P2065 Less than 10% of free retain data

P2066 Less than 10% of free bit data

P2067 Task not found in resources

P2068 No task defined for the application

Project is in the old PPJ] format.
P2069 It will be saved in the actual PPJX
format

P2070 Can’t open auxiliary source file

P2071 Can't read file

Application name is longer than
10 characters: only the first 10

P2072 characters will be downloaded into
the target
P2073 Downloadable source code file is
not password-protected
Downloadable PLC application
P2074 binary file not created
Less than 10% of free ext/aux
P2075 data
Project private copy of this
P2076 library was missing and has been

replaced with a new copy of the
library (from the original path)

Cannot load library! Project
private copy of this library was
P2077 missing and the original path to
the library is invalid: library has
been dropped

Debug symbols package (for
P2079 following download to the target
device) not created

Source code package (for
P2080 following download to the target
device) not created

P2081 Invalid task definition

P2083 Invalid or incoherent task period

P2084 Broken library link

P2085 Missing external aux source

Object is already defined in the

P2086 project and will be unloaded

S1281 Generic ST error

51282 Too many expressions nested

S1283 No iteration to exit from

51284 Missing END_IF
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S1285 Invalid ST statement

S1286 Invalid assignment

$1287 Missing “;"”

51288 Invalid expression

S1289 Invalid expression or missing DO

S1290 Missing END_WHILE

51291 Missing END_FOR

51292 Missing END_REPEAT

Invalid expression or missing

51293 THEN

S$1294 Invalid expression or missing TO

S$1295 Invalid expression or missing BY

Invalid statement or missing

S1296 | jnTIL

S1297 Invalid assighment, := expected

S1298 Invalid address expression

S1299 Invalid size expression

S1300 Function return value ignored

S$1301 Invalid parameter passing

S1302 Function parameter not defined

S1303 Useless expression

S1304 Unbalanced parentheses

S1305 Unknown function

Invalid function parameter(s)

51306 specification

S1307 Function parameter doesn't exist

Multiple assignment not allowed

S1308 | iy accordance with IEC 61131-3)

S1309 ST preprocessor buffer overflow

Function block invocation of a

51310 non-function block instance

S1311 Missing END_WAITING

S1312 Syntax error

S1313 Invalid range in CASE definition

S1314 Value overlap in CASE definition

S1315 Exceeding number of parameters

Wrong number of function

S1316
parameters

S1317 Duplicated function parameter

S1318 Improper use of THIS/SUPER

Improper usage of query interface

S1319 operator ?=

S1320 Invalid reference to expression

Missing IL block end marker

S1321 (£IL})
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$1322 Fupction in/out variable doesn’t
exist
VAR_IN_OUT must be assigned in
S1323 ; . ;
function block invocation
$1324 Complex type parameters can't
have default value
51325 Invocation of an unexisting

function block

S1326 Missing inout parameter

S1537 Generic SFC error

S1538 Initial step missing

S1539 Output connection missing

The output pin must be connected

51540 to a transition

Every output pin of a transition
S1541 must be connected to a step/jump
block

S1542 Transition expected

S1543 Step or jump expected

Could not find the associate

S1544
program code

S1545 Could not find the condition code

S1546 Unknown-type transition

S1547 Invalid jump destination

Duplicates action. Same SFC
S1548 action cannot be used in more
than one step

S1549 Unconnected block in SFC schema

The communication with the target system failed
because there is no answer from the system itself.
More common causes of this problem are wrong cable
connection, invalid target address in communication
settings, invalid settings of communication parameters
(such as baud rate), target system failure.

T8193 Communication timeout

T8194 Incompatible target version Error code not used.

The target system image file (with IMG extension)
is invalid or corrupted. Try to upload and create new
version of the image file using the "Communication
Upload image file" menu option.

T8195 Invalid code file

The image file (with IMG extension) contains a data
block that has an index greater than the largest index
supported by the target system. Try to upload and create
new version of the image file using the "Communication
Upload image file" menu option. If the problem persist,
contact the target system vendor.

T8196 Invalid data block index

T8197 Invalid target information address | Internal compiler error.

The target system was not able to complete the flash
T8198 Flash erase failure erasure procedure. Contact the target system vendor for

details.
.
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The target system was not able to complete the flash
T8199 Code write failure programming procedure. Contact the target system
vendor for details.

The compiler tried to communicate with the target
system but the communication channel is not available.
T8200 Communication device unavailable | If the problem persist and there are other applications
that communicate with the target system, deactivate the
communication on the other applications and try again.

T8201 Invalid function index Internal compiler error.
The address of the parameter's database memory area
Invalid database information of the target system isn't correct or valid. Try to upload
T8202 . i . ,
address and create new version of the image file using the

"Communication Upload image file" menu option.

T8203 Invalid target information

T8204 Rebuild required

T8205 Invalid task

Application-level communication
protocol error: PLC run-time
was not able to understand the
received command

T8206

T8207 Not implemented

No room for source file on the

T8209 target

18210 Error while uplo_ading source code
from target device

T8211 No room for debug symbols on

the target

T8212 Memory read error

T8213 Memory write error

Not enough space available on
T8214 the target device for the PLC
application binary

T8215 Generic communication failure

X4097 Recursive POU

X4098 Recursive data type
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